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Key Concepts

Protect Your ComputerLESSON

When you begin using a personal computer in a public environment, such as in 

the workplace, one of your fi rst tasks should be to make sure that access to your 

information is as controlled as possible. Becoming profi cient in Windows Vista 

will allow you to manage security features and confi gure user and privacy settings 

to control your information better, both as a student, and in your career. 

Avoid Ambiguity “I think Mark is visiting Mario. Drive to his house and bring 

him back here.” Whom should you pick up? Mark or Mario? A word or phrase that 

has two or more possible meanings is called an ambiguity. While you should 

always try to avoid ambiguity when communicating with others, you will 

inevitably have to deal with ambiguous situations. When faced with confusion, do 

not be afraid to ask people to help clarify the situation. For example, you can 

repeat the instructions back to the speaker: “You are asking me to drive to Mario’s 

house to bring Mark back here. Is this correct?” What is another example of an 

ambiguity that you can think of? 

 Confi gure the Windows fi rewall 
and Defender

 Confi gure Windows Update

 Set simple privacy and user 
settings

 Create and disable standard 
user accounts

 Confi gure Internet Explorer 
settings

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in the 
Student Edition for a descrip-
tion of the standards listed 
here.

ISTE Standards Correlation

NETS•S

1a, 2a, 3b, 3c, 4b, 5a, 5b, 6a, 
6b, 6c, 6d

Microsoft Certified 
Application Specialist 
Standards

Vista

1.1, 1.2, 1.3, 1.4, 
1.5, 1.6 
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Reading GuideLESSON

Make Connections Before starting a lesson, survey the content by reading the exercise titles, bold 
words, and fi gure captions. Look for relationships between ideas as you read. Relating an unfamiliar idea 
with something you already know will increase your understanding.

Read to Learn

• Improve productivity by confi guring update, 
security, and Internet Explorer settings.

• Collaborate by creating and managing standard 
local user accounts.

• Learn to increase your computer’s security. 

Main Idea

Setting up and confi guring simple security and 
privacy settings is essential in Vista.

Vocabulary

Key Terms

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

quarantine
resources

Quick Write Activity 

Describe On a separate sheet of paper, write down 
three things you think might help keep a computer 
user’s account secure.

Study Skills

Ask Questions If you do not understand 
something, ask a question. Asking a question does 
not make you look foolish. In fact, some of your 
classmates probably have the same question.

Academic Standards

English Language Arts
NCTE 4 Adjust use of language to communicate effectively with a variety of audiences.
NCTE 5 Use different writing process elements to communicate effectively.

Math
NCTM (Measurement) Understand measurable attributes of objects and the units, systems, and processes 
of measurement. 

administrator
code
confi gure
cookie
Defender
fi rewall
malicious software
password
Phishing Filter

pop-up window
privacy settings
screen saver
security settings
standard account
update
virus
Web site

Before You Read

Vista 2Lesson 1: Reading Guide



Step-By-Step EXERCISE 1-1
Manage Windows Firewall
The Vista screen offers many different features on the desktop and in the Start menu. 

You can place commonly used program icons on the desktop or access them through 

the Start menu. The Control Panel allows you to manage many different settings and 

security features. One of the fi rst steps in maintaining the security of your computer 

is to have a functioning fi rewall, which is hardware of software that keeps others from 

accessing the resources, or features, of your system. 

 On the Taskbar, click the 

Start  button.

 On the Start menu, 

click Control Panel (see 

Figure 1.1). 

 In the Control Panel 

dialog box, click Security.

Your screen 

should look like Figure 1.2.

 Click Windows Firewall.

 In the Windows Firewall 

window, under Windows 

Firewall is helping to 

protect your computer, 

verify that the Windows 

Firewall is on. 

Continued on the next page. 

FIGURE 1.1 Vista Start menu

FIGURE 1.2 Security window

Desktop icon

Control 
Panel

Start menu

Windows Firewall

Start button

Always ask your teacher 
before adjusting any 
settings on your school 
computer! 

Taskbar

A fi rewall checks 
information coming from 
outside computer users 
(via the Internet or a 
network), and either blocks 
it or allows it to access 
your computer.
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Step-By-Step EXERCISE 1-1 (Continued)

Manage Windows Firewall
 Your screen 

should look like Figure 1.3. 

 Click Change Settings. If 

a User Account Control 

dialog box opens, click 

Continue.

 In the Windows Firewall 

Settings dialog box, click 

the Exceptions tab (see 

Figure 1.4). Read the 

available options.

 Click the Advanced tab. 

Read the available options.

 Click the General tab. 

Read the available options. 

 Your screen 

should look like Figure 1.4. 

 Click Cancel. Click Close 

. 

Continue to the next exercise. 

FIGURE 1.3 Windows Firewall window

FIGURE 1.4 Windows Firewall Settings dialog box

Change settings

Firewall is on

Exceptions

Cancel

Vista automatically 
activates the Windows 
Firewall for you, but you 
can turn it on or off or 
adapt it to suit your needs.

 You can set the fi rewall to 
allow specifi c programs to 
pass information back and 
forth from your computer 
without being blocked.

Vista 4Lesson 1: Exercise 1-1



Step-By-Step EXERCISE 1-2
Confi gure Windows Firewall 
Specifi cally for Programs
A fi rewall acts as a barrier to prevent unwanted access to your computer. However, your 

settings should allow useful programs that use the Internet to send and receive data 

through your computer’s fi rewall.

FIGURE 1.5 Windows Firewall Settings dialog box

FIGURE 1.6 Security window

Security Center

 Click Start >Control 

Panel>Security> 

Windows Firewall. 

 In the left pane, click Allow 

a program through 

Windows Firewall. (If a 

User Account Control 

dialog box opens, click 

Continue.)

 In the Windows Firewall 

Settings dialog box, on 

the Exceptions tab, click 

Add program.

 In the Add a Program 

dialog box, scroll down and 

select Internet Explorer. 

 Your screen 

should look like Figure 1.5. 

Click OK.

 In the Windows Firewall 

Settings box, click OK.

 In the Windows Firewall 

window, click Close .

Your screen 

should look like Figure 1.6.

 In the Control Panel, click 

Close .

Continue to the next exercise.

Internet Explorer 
is now checked

Add program
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Step-By-Step EXERCISE 1-3
Use Windows Defender
Windows Defender is a program that provides another level of protection for your 

computer. Defender helps you to keep malicious software, or software that is 

intentionally designed to damage, disrupt, or steal information, from being installed 

on your computer. Defender can constantly protect your computer from these 

programs, or you can scan your computer to make sure no unauthorized programs 

have been put on your machine. Defender will quarantine, or separate, suspicious 

software until you determine whether you want to restore or remove the program.

FIGURE 1.8 Windows Defender Software Explorer

Disable

Tools

Sidebar selected

 Click Start >Control 

Panel>Security. 

 In the Security window, 

click Security Center.

 Your screen 

should look like Figure 1.7. 

 Verify that Windows 

Defender is on. Click 

Close .

 In the Security window, 

click Windows Defender.

 At the top of the Windows 

Defender window, click 

Tools .

 Under Tools, click 

Software Explorer.

 In the left pane, scroll down 

and select Microsoft 

Windows Sidebar (see 

Figure 1.8).

 Under the Microsoft

Windows Sidebar 

description, click Disable. 

In the Windows Defender 

warning box, click Yes.

 Scroll back to the Sidebar

listing in the pane on the 

left. The program is now 

classifi ed as Disabled.

Continued on the next page.

FIGURE 1.7 Windows Security Center
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Step-By-Step EXERCISE 1-3 (Continued)

Use Windows Defender

FIGURE 1.9 Windows Defender Quarantined items

FIGURE 1.10 Windows Defender Allowed items

 Click the Microsoft 

Windows Sidebar listing 

and click Enable. Click 

Yes.

 Click Tools  and select 

Quarantined items.

 Your screen 

should look like Figure 1.9. 

On this screen, you can 

restore or remove programs 

quarantined by Windows 

Defender.

 Click Back .

 Click Allowed items.

 Your screen 

should look like Figure 1.10. 

On this screen, you can set 

Windows Defender to 

resume monitoring  

excepted programs.

 Click Home . Click 

Close .

Continue to the next exercise.

Back button

Home button

If you do not want 
Windows Defender to 
monitor specifi c programs, 
click on the Action menu 
in the Alert dialog box. 
Then, click Always Allow.

Vista 7Lesson 1: Exercise 1-3



Step-By-Step EXERCISE 1-4
Confi gure Windows Update
Windows Update is a tool that allows you to keep your version of Windows Vista up 

to date with the latest additions issued by Microsoft. You can update your computer 

manually by loading the most recent changes to the Windows operating software 

directly from Microsoft. You can also confi gure, or change the settings of Windows 

update to download and install new updates automatically.

 Click Start >Control 

Panel>Security. In the 

Security window, click 

Windows Update.

 Your screen 

should look similar to 

Figure 1.11.

 In the left pane, click 

Change settings.

 Under Install updates 

automatically 

(recommended), click the 

Install new updates 

drop-down arrow and 

select Every Sunday.

 Your screen 

should look like Figure 1.12. 

Click OK.

 In the User Account 

Control dialog box, click 

Continue.

 In the Windows Update 

window, in the left pane, 

click View update history.

 In the list of updates, right-

click the fi fth update in the 

list and select View 

Details.

 Note the Windows update 

information. Click Close.

 Click OK.

Continue to the next exercise.

FIGURE 1.11 Windows Update window

FIGURE 1.12 Windows Update settings

Change settings

Set updates schedule
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Step-By-Step EXERCISE 1-5
Update Windows Vista
It is important to know how to update Windows Vista manually because there might 

be a time when an update is so critical to your computer’s operation that you cannot 

wait for the automatic update. For example, you should manually install an update 

patch to stop a new virus, or a program that is designed to damage your computer’s 

software or hardware. From the Windows Update folder, you can also view a list of 

the updates already installed on your computer.

 Under Windows is up to 

date, click View 

Available updates.

 Follow your teacher’s 

instructions for the update 

you should select in the 

available updates box. 

Select the update and click 

Install.

 In the User Account 

Control dialog box, click 

Continue.

 Your screen 

should look like Figure 1.13.

 In the Windows Update 

window, in the left pane, 

click View update history 

to view a list of the updates 

on your computer.

 Your screen 

should look similar to 

Figure 1.14.

 Click Close .

Continue to the next exercise.

FIGURE 1.13 Update installed

FIGURE 1.14 Update history

View update history

If you turn off automatic 
updating, be sure to check 
for updates regularly or you 
might put your computer at 
risk or experience problems 
when using Windows or 
other programs.
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Step-By-Step EXERCISE 1-6
Lock the Computer
Occasionally you may need to leave your computer for a short time. If you do not 

want to turn it off and then restart it when you come back, you can lock the computer. 

Vista has a feature called the Lock this computer option. The feature locks the 

computer so that others cannot use it. To unlock it, you need to enter the proper 

password, or series of characters that will allow access.

 Click Start .

 On the Start menu, at the 

bottom of the right pane, 

click Lock this computer 

 (see Figure 1.15).

 Your screen 

should look similar to 

Figure 1.16.

 Click in the password box 

and key your password (or 

the password assigned by 

your teacher). 

 Click Enter .

Continue to the next exercise.

FIGURE 1.15 Start menu 

 FIGURE 1.16 Locked password screen

Enter 

Lock this 
computer

Vista includes several 
different images that you 
can show to represent 
the user. Your image may 
be different from the 
robot shown in Figure 
1.15 and 1.16. 

To prevent accidental 
moving or resizing of the 
Taskbar, you can lock it 
into place. To lock and 
unlock the Taskbar, right-
click a blank space on the 
Taskbar and click Lock 

the Taskbar.
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Step-By-Step EXERCISE 1-7
Change Screen Saver Settings
Vista also can automatically lock the computer for you. You can set the screen saver, 

or program that replaces the image on the screen when it is not in use, to lock the 

computer. After the computer is idle for a period of time, the screen saver will appear. 

The next time someone attempts to use the computer, he or she will have to enter the 

correct password to use the computer.

 Click Start >Control 

Panel>Appearance and 

Personalization.

 Click Personalization. 

Click Change screen 

saver.

 Your dialog 

box should look similar to 

Figure 1.17.

 Click the Wait down arrow. 

Change the setting to 5. 

Under Power 

management, click 

Change power settings.

 In the Power Options 

window, in the left pane, 

click Require a password 

on wakeup.

 Your screen 

should look like Figure 1.18. 

 Under Password 

protection on wakeup, 

click Require a password 

(recommended). Click 

Save Changes (or Cancel 

if Require a password 

was already selected).

 Close the Power Options 

window. In the Screen 

Saver Settings dialog box, 

click OK.

 In the Appearance and 

Personalization window, 

click Close .

Continue to the next exercise.

F IGURE 1.17 Screen Saver Settings dialog box

FIGURE 1.18 System Settings window

Wait down arrow

Change power settings

Click 
here
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Step-By-Step EXERCISE 1-8
Confi gure Windows Internet Explorer 
Security Settings
As the default Web browser in Windows Vista, Internet Explorer sends and receives 

information between your computer and the Internet. In order to protect your 

computer to your satisfaction while still allowing Internet Explorer to send and 

receive the maximum amount of information, you can confi gure several settings in 

Internet Explorer, including the security settings.

 Click Start . Choose 

Control Panel>Security.

 Under Internet Options, 

click Change security 

settings.

 In the Select a zone to 

view or change security 

settings box, click 

Trusted sites.

 Your dialog 

box should look like Figure 

1.19. Click Sites.

 In the Trusted sites 

dialog box, in the Add this 

website to the zone box, 

key: https://www.msn.com.

 Your dialog 

box should look like Figure 

1.20.

 Click Add. Click Close.

Continue to the next exercise.

FIGURE 1.19 Internet Properties dialog box 

FIGURE 1.20 Trusted sites dialog box

Click Trusted sites

In Step 5, the name of the 
Web site must be keyed 
correctly or it will not be 
trusted. Getting the right 
characters in the right order 
is called proper syntax. On 
a sheet of paper, write the 
Internet addresses for fi ve 
Web sites you have visited 
online. Circle the common 
elements of syntax in each.
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Step-By-Step EXERCISE 1-9
Confi gure History and Temporary 
Internet Files Settings
Internet Explorer keeps a record of sites you have visited and some temporary fi les 

that are downloaded in order to make the program function effi ciently. You can 

confi gure Explorer as to how long the program stores those fi les and Web sites before 

deleting them.

 Click Start >Control 

Panel>Security>Internet 

Options. In the Internet 

Properties dialog box, 

click the General tab (see 

Figure 1.21).

 Under Browsing history, 

click Settings.

 In the Temporary 

Internet Files and 

History Settings dialog 

box, click the up arrow for 

the Disk space to use 

(8–10245MB) box until it 

reads 60 (see Figure 1.22).

 Under History, click in the 

Days to keep pages in 

history box and key: 7.

 Your dialog 

box should look similar to 

Figure 1.22.

 Click OK.

Continue to the next exercise.

FIGURE 1.21 Internet Properties dialog box General tab

FIGURE 1.22 Temporary Internet Files and History Settings dialog box

Browsing history

Disk space

If you delete all of your 
Web page browsing 
history, you do not delete 
your list of favorites or 
subscribed feeds. To 
delete all browsing history, 
choose Start>Internet 

Explorer and click Tools. 
Then, click Delete 

Browsing History, select 
Delete all, and click Yes.

Vista 13Lesson 1: Exercise 1-9



Step-By-Step

 Click Start >Control 

Panel>Security>Internet 

Options. In the Internet 

Properties dialog box, 

click the Privacy tab.

 Under Settings, click 

Default, if necessary.

 Under Settings, click and 

drag the slider up one notch 

so that the setting is at 

Medium High.

 Your dialog 

box should look like 

Figure 1.23.

 Click Advanced. Under 

Cookies, select Override 

automatic cookie 

handling. Under Third-

party Cookies, select 

Prompt. Click OK.

 Your dialog 

box should look like Figure 

1.24. Note the Settings 

description is now Custom.

Continue to the next exercise.

EXERCISE 1-10
Confi gure Privacy Settings
Internet Explorer has its own set of privacy settings that act similarly to the Windows 

Firewall. Explorer’s privacy settings deal mostly with the acceptance or denial of 

cookies, which are placed on your computer by the Web sites you visit to gather and 

store information about how you use the site. However, some cookies might put your 

privacy at risk. You can block, or control, the cookies that are stored on your computer 

to help protect your privacy.

FIGURE 1.23 Internet Properties dialog box Privacy tab

FIGURE 1.24 Custom Privacy settings

Slider

Settings are 
now listed 
as Custom

Cookies record your 
information history and 
preferences for viewing, 
including sign-in names 
and passwords. This 
allows Web sites to load 
the information for you 
automatically the next time 
you log on. 
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Step-By-Step EXERCISE 1-11
Use the Phishing Filter
You can sometimes run across Web sites online that are designed to capture your 

personal information and use it in marketing schemes or worse. The Phishing Filter 

in Internet Explorer is designed to protect users from those Web sites by blocking the 

sites and warning users if the sites are encountered.

 Click Start >Control 

Panel>Security>Internet 

Options. 

 In the Internet 

Properties dialog box, 

click the Advanced tab 

(see Figure 1.25).

 In the Settings box, scroll 

down to Phishing Filter.

 Double-click Phishing 

Filter to expand the 

options, if necessary. Select 

Turn on automatic 

website checking.

 Your screen 

should look like Figure 1.25.

 Click Apply.

 Your screen 

should look like Figure 1.26. 

Click OK.

Continue to the next exercise.

FIGURE 1.25 Internet Properties dialog box Advanced tab

FIGURE 1.26 Phishing Filter warning box

Phishing Filter

Common phishing scams 
are disguised in e-mails 
that look like offi cial 
messages from a trusted 
source, such as a bank or 
creditor. The message 
often directs recipients to 
a fraudulent site where 
they are asked to enter 
personal information that 
is commonly used for 
identity theft.
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Step-By-Step EXERCISE 1-12
Manage Pop-Up Windows
Internet Explorer can block malicious Web site functions. A pop-up window is an ad 

that suddenly appears in its own window on top of another Web site. Pop-up windows 

in Web sites can be informative, while others can be annoying. Some 

pop-ups may carry code, or computer programming language, that is harmful to your 

computer. You can confi gure Internet Explorer to block some or all pop-ups.

 Click Start >Control 

Panel>Security>Internet 

Options. 

 In the Internet 

Properties dialog box, 

click the Privacy tab.

 Under Pop-up Blocker, 

make sure the Turn on 

Pop-up Blocker check 

box is selected. 

 Your screen 

should look like Figure 1.27. 

Click Settings.

 In the Pop-up Blocker 

Settings dialog box, 

under Exceptions, in the 

Address of websites to 

allow box, key: http://www.

msn.com (see Figure 1.28).

 Your screen 

should look similar to 

Figure 1.28.

 Click Add. 

 Click Close.

 In the Internet Properties 

dialog box, click OK.

 In the Security window, 

click Close .

Continue to the next exercise.

FIGURE 1.27 Internet Properties dialog box Privacy tab

FIGURE 1.28 Pop-up Blocker Settings dialog box 

Make sure this is selected
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Step-By-Step EXERCISE 1-13
Create a Standard Password-Protected 
Local User Account
Having different accounts on one computer allows several different users to use the 

same computer without interfering with the settings or fi les of the other users. A 

standard account differs from an administrative account in that it can use all the 

programs and change personal settings but cannot add or remove programs or change 

settings that would affect other users.

 Choose Start >

Control Panel.

 In the Control Panel 

window, under User 

Accounts and Family 

Safety, click Add or 

remove user accounts 

(see Figure 1.29).

 In the User Account 

Control dialog box, click 

Continue.

 Your screen 

should look similar to 

Figure 1.30.

 In the Manage Accounts 

window, click Create a 

new account.

 In the Create New 

Account window, in the 

This name will appear 

on the Welcome screen 

and on the Start menu 

box, key: Second. 

Continued on the next page.

FIGURE 1.29 Control Panel window

FIGURE 1.30 Manage Accounts window

Click here 

Create new account

Create a password that is 
easy to remember, but 
diffi cult for other people to 
guess. A password that 
uses a random set of 
characters is more diffi cult 
to decipher than one that is 
not random.
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Step-By-Step EXERCISE 1-13 (Continued)

Create a Standard Password-Protected 
Local User Account Make sure the Standard 

user option is selected. 

 Your screen 

should look like Figure 1.31. 

 Click Create Account.

 Your screen 

should look like Figure 1.32.

 Click Create a new 

account.

 In the This name will 

appear on the Welcome 

screen and on the Start 

menu box, key: Third. 

Click Create Account.

 In the Manage Accounts 

window, click the Second 

user icon. Click Create a 

password.

 In the New password 

box, key: Turtle87. In the 

Confirm new password 

box, key: Turtle87.

 Click Create password. 

In the Change an 

Account window, click 

Close .

Continue to the next exercise.

FIGURE 1.31 Create New Account window 

FIGURE 1.32 Manage Accounts Window with account added 

New account name

New account added 

You can only add or 
remove user accounts if 
you are the administrative 
user and are working within 
your administrator account.

Create Account
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Step-By-Step EXERCISE 1-14
Disable a Standard Local User Account
The accounts you create on your computer can be controlled to the point that you can 

disable an account without actually deleting it. You can reactivate the account at any 

time using the Vista’s computer management functions.

 Click Start . In the right 

pane, right-click Computer 

and select Manage. Click 

Continue.

 Your screen 

should look like Figure 1.3

 In the left pane, under 

Computer Management 

(Local), click Local Users 

and Groups.

 In the center pane, double-

click the Users folder.

 Select the Second 

account. On the Menu bar, 

click Properties .

 Your screen 

should look like Figure 1.34.

 In the Second Properties 

dialog box, click the 

General tab. Verify that 

Password Never Expires 

is checked, and select 

Account is disabled. 

 Click OK. Click Close.

Continue to the next exercise.

FIGURE 1.33 Computer Management window

FIGURE 1.34 Second Properties dialog box General tab

Local users and groups

Center pane

While the Account 

Management folder can 
manage most account 
functions, the Computer 

Management folder pro-
vides even more control 
over your computer’s 
security.

Vista 19Lesson 1: Exercise 1-14



Step-By-Step EXERCISE 1-15
Require a User to Change a Password
As the administrator, or manager, of your computer, you can require some tasks of 

the other users on your machine. One of the most critical is to have users change their 

passwords regularly to prevent them from being discovered. You can activate this 

option from the Computer Management window as well.

 Click Start . In the right 

pane, right-click Computer 

and select Manage. Click 

Continue.

 In the Computer 

Management window, in 

the center pane, double-

click the Second account.

 In the Second Properties 

dialog box, clear the 

Password never expires 

check box.

 Select the User must 

change password at 

next logon check box.

 Your dialog 

box should look like 

Figure 1.35. Click OK.

 Your screen 

should look like Figure 1.36.

 In the Computer 

Management window, on 

the Menu bar, choose 

File>Exit.

 FIGURE 1.35 Second Properties dialog box

FIGURE 1.36 Computer Management window

Clear this box first 

To open the Account 

Properties dialog box 
from the Computer 

Management window, 
select the account in the 
center pane and choose 
Action>Properties.
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Vocabulary

After You ReadLESSON

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1. The   blocks Web sites that attempt to gather personal 
information from your computer. (p. 15)

 2. The only user allowed to add or remove software from the computer is the 
 . (p. 20)

 3. The   can be set to lock the computer automatically. (p. 11)

 4. A(n)   controls how programs send information into and 
out of a computer. (p. 3)

 5. In order to keep Vista current you must occasionally   the 
system. (p. 8)

  Vocabulary Activity

 6. Create flashcards to help you study the vocabulary terms. 
• Write each vocabulary term on one side of a 3-inch-by-5-inch index card.
• On the other side of the card, write the definition for that vocabulary word.
• Pair up with a classmate and take turns testing each other on the 

vocabulary words until you both get them correct.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. You can disable a standard local account from which window? (p. 19)
A. Account Management
B. Security Options

C. Computer Management
D. Windows Update

 8. You can update Windows Vista by using which application? (p. 8)
A. Windows Defender
B. Windows Update

C. Windows Firewall
D. Phishing Filter

 9. Windows Defender will place suspicious programs in what area? (p. 6)
A. firewall
B. cookie

C. quarantine
D. standard account

 10. Which tool allows you to lock the computer automatically? (p. 11)
A. Control Panel
B. Screen saver settings

C. Desktop
D. Start Menu

Key Terms

administrator

code

configure

cookie

Defender

firewall

malicious software

password

Phishing Filter

pop-up window

privacy settings

screen saver

security settings

standard account

update

virus

Web site

Academic Vocabulary

quarantine

resources
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Step-By-Step

LESSON

 Click Start .

 On the Start menu, at the 

bottom of the right pane, 

click Lock this computer 

 (see Figure 1.37).

 Your screen 

should look like Figure 1.38.

 Click in the password box. 

 Key your password (or the 

password assigned by your 

teacher).

 Click Enter .

FIGURE 1.37 Start menu

FIGURE 1.38 Locked Password screen

 1. Lock the Computer

Follow the steps to complete the activity.

Practice It Activities
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Step-By-Step

Practice It ActivitiesLESSON

 2. Change Screen Saver Settings

Follow the steps to complete the activity.

FIGURE 1.39 Personalization window

FIGURE 1.40 Screen Saver Settings dialog box

 Right-click in a blank area 

of the Vista desktop and 

select Personalize from 

the drop-down menu.

 Your screen 

should look like Figure 1.39.

 In the Personalization 

window, click Screen 

Saver.

 In the Screen Saver 

Settings dialog box, 

change the Wait box to 15.

 Check the On resume, 

display logon screen box.

 Your dialog 

box should look like 

Figure 1.40.

 Click OK.

 In the Personalization 

window, click Close .
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Step-By-Step

LESSON

 3.  Confi gure History and Temporary Internet
File Settings

Follow the steps to complete the activity.

FIGURE 1.41 Internet Properties dialog box General tab

FIGURE 1.42 Temporary Internet Files and History Settings dialog box

 Click Start . In the right 

pane of the Start menu, 

select Control Panel.

 In the Control Panel, 

select Network and 

Internet.

 Under Internet Options, 

click Delete browsing 

history and cookies.

Your screen 

should look like Figure 1.41.

 Under Browsing history, 

click Settings.

 In the Temporary 

Internet Files and 

History Settings dialog 

box, click the Disk space 

to use up arrow and 

change the number to 65.

 Under History, click in the 

Days to keep pages in 

history box. Key: 10.

 Your screen 

should look like Figure 1.42.

 Click OK. In the Network 

and Internet window, 

click Close .

Change Disk 
space to 65 

Practice It Activities
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Step-By-Step

LESSON

 4. Add New Account to Your Computer

You work in a small offi ce that has a limited number of computers available. Your 

supervisor has just hired a new employee and wants you to train her. You decide the 

easiest way to fi nd a workspace for her is to temporarily add an account for her to 

your computer.

FIGURE 1.43 Create New Account window

FIGURE 1.44 Manage Accounts Window with account added

 Create a new account.

 Name the new account 

Annie Borden.

 Make sure the Standard 

user option is selected.

 Your screen 

should look like Figure 1.43.

 In the Manage Accounts 

window, click the Annie 

Borden user icon (see 

Figure 1.44).

 Create a password for the 

new account.

 Click in the New password 

box and key: rescueBlue55. 

Click in the Confirm new 

password box and key: 

rescueBlue55.

 Click Create password.

 In the Change an 

Account window, click 

Close .

You Try It Activities
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Step-By-Step

LESSON

FIGURE 1.45 Computer Management window

FIGURE 1.46 Annie Borden Properties dialog box

 Click Start . In the right 

pane, right-click Computer 

and select Manage.

 In the User Account 

Control dialog box, click 

Continue.

 In the Computer 

Management window, in 

the left pane, click Local

Users and Groups.

 In the center pane, double-

click Users. 

Your screen 

should look like Figure 1.45.

 In the center pane, double-

click the Annie Borden

account.

 In the Annie Borden 

Properties dialog box, 

clear the Password never 

expires check box.

 Select the User must 

change password at 

next logon check box.

Your screen 

should look like Figure 1.46. 

Click OK.

 Close the Computer

Management window.

 5.  Have New Employee Create Password on 
First Login

You want the new employee to have her own account, but you do not want 

to be responsible for the security of her fi les on the computer. You decide 

to add her to your computer but have her create her own password the fi rst 

time she logs in.

You Try It Activities
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LESSON Critical Thinking Activities

 6. Beyond the Classroom Activity

Language Arts: Confi gure Privacy Settings Browse the Web to fi nd 

at least three news Web sites that you think are trustworthy. Using the tools 

you have learned about, change Internet Explorer’s security settings to assign 

these Web sites as Trusted sites.

■ Open the Internet Properties dialog box.

■ Click the Security tab. Select Trusted sites.

■ Enter the URLs of the news sites so that your computer will recognize 
them as trusted sites.

Open a Word document and list the news sites. Then, key a paragraph that 

explains why you think the news sites you picked are trustworthy. Save your 

document as: v1rev-[your fi rst initial and last name]6.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 1.3 Configure Windows Update settings

Perform a Manual Update It has been awhile since your last manual 

update of Vista and your automatic update only completes the critical 

updates. Manually update your Windows Vista operating system. Choose 

an available optional update that you would like to perform. With your 

teacher’s permission, download and install the update. After installing  the 

update, go to update history, fi nd the update, and print the details.

 8. 21st Century Skills Activity

Clarify Information One of your coworkers is not certain why an 

individual would want to scan for malicious software on a regular basis. 

Open Windows Defender to scan your machine for malicious programs.

Click the drop-down arrow next to Scan and select Quick Scan. (Even a 

quick scan might take several minutes. If your teacher does not assign a 

particular time to run a scan, get permission before starting the scan.)

After the scan, check the Windows Defender History to see if it has 

encountered any malicious programs. Then, open a Word document and 

describe the malicious program (if Windows Defender found one), as well 

as the action Windows Defender took. Explain why updating Vista 

regularly can help keep unauthorized software off your machine. Be sure 

you clearly identify why it is important to perform scans on a regular basis. 

Save the document as: v1rev-[your fi rst initial and last name]8.
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LESSON

 9. Create New Accounts 

Language Arts: Confi gure New User Accounts You are in tech 

support for a small company that has a limited number of workstations. 

■ Create three new accounts on your computer for three new 
employees. Use First, Second, and Third for the account names.

■ Assign passwords to the Second and Third accounts using the 
account names for the passwords. Configure the accounts to prompt 
the users to change their passwords on their first logon.

■ The First employee will not start work for three weeks. Disable, but 
do not delete, the account.

Open a Word document and key a brief note that tells the employees how 

to access their accounts. Include instructions about how to change their 

passwords. Save your fi le as: v1rev-[your fi rst initial and last name]9.

 10. Confi gure Privacy Settings 

Language Arts: Set Privacy Settings Employees usually are not 

allowed to browse the Internet during company time, but the new employees 

that have been hired will need to do research online. Your supervisor 

worries that cookies and other identity-related applications could 

compromise the company’s client information. 

■ Access the two new active accounts (reset the passwords by adding a 1 
to the end of the current passwords).

■ Set privacy settings for the two accounts to the highest possible level.

Open a Word document and key a paragraph that explains what types of 

Internet research an employee might be asked to complete. Save your fi le as: 

v1rev-[your fi rst initial and last name]10.

 11. Personalize the Desktop

Language Arts: Change Screen Saver Settings The Second account 

user wants the screen saver to lock the computer when it activates. He also 

wants a different screen saver.  The Third account user says that the screen 

saver comes on too soon. His screen saver should also lock his computer 

when it activates.  Make these changes to the accounts. Test them after you have 

set them up. Then, open a Word document and key two or three paragraphs 

that explain how the auto-lock feature can help to keep the information on a 

computer secure. Save your fi le as: v1rev-[your fi rst initial and last name]11.

Security Can you 
remember being asked to 
keep a secret? Knowing that 
you needed to keep the 
information secret probably 
made you more aware of its 
significance. Being aware 
of what others want to know 
is helpful in securing 
information.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. What information on 
a computer might you 
want to keep secure from 
others?

2. How can you keep the 
information on your 
computer secure?

Challenge Yourself Projects
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Key Concepts

Manage Mobile and Remote ComputingLESSON

 As laptops and wireless networks have become more popular, computer users 

have more choices about how and where they work and stay in touch. Knowing 

how to connect to a network when you are not in your own offi ce environment 

enables you to stay connected to resources and coworkers even if you have to 

travel great distances to accomplish tasks.

Be Courteous Your parents probably taught you to have good manners when 

you were growing up. In the business world, there is no reason not to practice 

those same values. In your communication with coworkers, supervisors, and 

especially clients, a courteous manner will go a long way toward making all parties 

feel that they are accomplishing something. Treat others with respect, and they 

more than likely will return that manner and not hesitate to work with you in the 

future. What is one thing you could do to become more courteous? 

 Confi gure power and shutdown 
functions

 Connect to remote and wireless 
networks

 Connect to a network by 
mapping a drive, browsing, or 
accessing shared folders

 Access offl ine folders and Web 
sites

 Synchronize folders

 Start, join, and sign in to a local 
collaboration network

 Display information on external 
display and network devices

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in the 
Student Edition for a 
description of the standards 
listed here.

ISTE Standards Correlation

NETS•S

1a, 2a, 2d, 3b, 3c, 4b, 5a, 5b, 
6a, 6b, 6c, 6d

Microsoft Certified 
Application Specialist 
Standards

Vista

2.1, 2.2, 2.3, 2.4, 2.5, 

5.1, 5.2
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Reading GuideLESSON

Read Out Loud If you fi nd you are having trouble comprehending what you read, read the material to 
yourself as if you are teaching it to someone else. The tone and infl ection that you use might give you 
hints as to the meaning of the text, and you might fi nd you have taught yourself, as well.

Read to Learn

• Learn how to connect to a variety of networks.
• Use wired or wireless connections.
• Explore ways to keep your information updated 

regardless of where it is kept.
• Communicate and present information in a 

format and medium that is easy to understand.

Main Idea

Vista’s network and interface functions allow you to 
connect to other users, groups, and networks to 
share and present information even if you are 
working from multiple locations.

Vocabulary

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

access
confl ict
enable

Quick Write Activity 

Describe Many businesses and government offi ces 
that do not provide network access are offering 
wireless connections to everyday computer users. 
On a separate sheet of paper, identify and describe 
at least three places you know of that offer wireless 
Internet access.

Study Skills

Don’t Be a Night Owl You might have heard the 
phrase “burning the midnight oil” used to describe 
someone up all night studying for a test. Avoid this 
habit. Instead of forcing yourself to stay up late, 
study for an exam in the same circumstances as you 
will take it—when you are not tired and you have 
had a full night’s sleep.

Academic Standards

English Language Arts
NCTE 3   Apply strategies to interpret texts.
NCTE 4   Use written language to communicate effectively.
NCTE 5   Use different writing process elements to communicate effectively.
NCTE 12 Use language to accomplish individual purposes.

Key Terms
collaborative
desktop
hibernate
mapping
network
power settings
Remote Desktop 
 Connection
shared folder

sleep mode
synchronize
Virtual Private 
 Network (VPN)
Windows Meeting 
 Space
Windows Mobility 
 Center
wired network
wireless network

Before You Read
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Step-By-Step EXERCISE 2-1
Confi gure Power Settings and Options 
With mobile computers becoming more popular, power consumption has become a 

more critical aspect to operating systems. Even most desktop computers will allow you 

to manage your power confi gurations. Vista’s power settings are different and adapt 

themselves depending on whether you are using a desktop computer, which is designed 

to remain in one location, or a laptop, which can be carried from place to place.

 On the Taskbar, click 

Start . In the right pane 

of the Start menu, click 

Control Panel.

 In the Control Panel 

window, click Hardware 

and Sound.

 Your screen 

should look like Figure 2.1.

 In the Hardware and 

Sound window, click 

Power Options.

 Your screen 

should look similar to 

Figure 2.2.

 Select High 

performance.

 Click Change plan 

settings.

Continued on the next page.

FIGURE 2.1 Hardware and Sound window

FIGURE 2.2 Power Options window

High performance

Power options

Change plan settings

You can also access Vista’s 
Power Options window by 
clicking the Mobile PC 
heading in the Control 

Panel if you are using a 
laptop or mobile device.
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Step-By-Step EXERCISE 2-1 (Continued)

Confi gure Power Settings and Options
 In the Edit Plan Settings 

window, click Change 

advanced power 

settings (see Figure 2.3).

 In the Power Options 

dialog box, under 

Advanced Settings, scroll 

down the list of power 

settings to Display. Click 

the   in front of Display

to expand the options.

 Double-click Turn off 

display after.

 Click Plugged in 

(Minutes). Click in the 

Minutes box to select the 

text and key: 40.

 Your dialog 

box should look similar to 

Figure 2.4.

 Click OK.

 In the Edit Plan Settings 

window, click Close .

Continue to the next exercise.

FIGURE 2.3 Edit Plan Settings folder

FIGURE 2.4 Power Options dialog box

Change advanced power settings

Expanded Display options

Depending on the type of 
com puter system you are 
using (laptop or desktop), and 
the power confi gura tions set 
up by the hardware’s manu-
facturer, the power options 
might appear different in the 
Power Options and Control 

Panel windows.

Vista 32Lesson 2: Exercise 2-1



Step-By-Step EXERCISE 2-2
Use Sleep and Hibernation Mode
If you are using a mobile, or laptop computer, it might be easier and more effi cient to 

put the system in a sleep or hibernate mode rather than turning it off. Sleep mode 

saves your information to the hard drive and puts the computer in a standby mode to 

resume instantly. Hibernate saves your information to the hard drive, and puts your  

computer into a standby mode, but allows you to turn off the power if necessary.

FIGURE 2.5 System Settings folder

FIGURE 2.6 Internet Explorer icon on desktop

Network icon in 
Notification area

 On the Taskbar, click 

Start . 

 Click Control Panel. In 

the Control Panel 

window, click Hardware 

and Sound.

 Under the Power Options, 

click Change what the 

power buttons do.

 Next to the When I press 

the power button option, 

click the drop-down arrow 

and select Hibernate 

(under both On battery 

and Plugged in if you are 

using a laptop computer).

 Your screen 

should look similar to 

Figure 2.5.

 Click Save Changes. In 

the Power Options 

window, click Close .

 Double-click the Internet 

Explorer icon on your 

desktop to open Internet 

Explorer (see Figure 2.6).

Continued on the next page.

Select Hibernate 

Double-click the icon

If the power has not been 
turned off, when your 
computer comes out of 
hibernate or sleep mode, it 
returns to its previous state.
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Step-By-Step EXERCISE 2-2 (Continued)

Use Sleep and Hibernation Mode

FIGURE 2.8 Start menu 

Shutdown options arrow

 Press the power button on 

your computer.

 After your computer goes 

into hibernation, press the 

power button again.

 Click your user icon or 

enter the password, if 

necessary to resume your 

session. 

 Your screen 

should look similar to 

Figure 2.7.

 Click Start . At the 

bottom of the right pane, 

click  to open the 

Shutdown options and 

select Sleep from the list 

(see Figure 2.8).

 Press the power button on 

your computer.

 Close Internet Explorer.

Continue to the next exercise.

FIGURE 2.7 Internet Explorer open on startup

Make sure you know where 
the power button for your 
machine is, and be careful 
not to confuse it with a 
Reset button, which will 
reboot the system instead 
of shutting it down.
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Step-By-Step EXERCISE 2-3
Choose a Network Connection
Your computer may have several different options set up to connect to different 

networks. A network is a group of computers connected to each other. You can 

choose connection settings to determine the network to which you will connect.

FIGURE 2.9 Network and Sharing Center

FIGURE 2.10 Network Connections window

 Click Start . In the right 

pane, right-click Network 

and select Properties.

 Your screen 

should look like Figure 2.9.

 In the left pane, click 

Manage network 

connections.

 In the Network 

Connections window, click 

the network connection 

assigned by your teacher. In 

the toolbar, select Enable 

this network device (see 

Figure 2.10).

 In the User Account 

Control dialog box, 

click Continue. Click 

Close  .

 In the Network 

Connections window, 

click Close .

Continue to the next exercise.

Network 
connection

Manage network 
connections

Click to enable 
selected connection

You can also open the 
Network and Sharing 

Center by clicking the 
network icon in the 
Notifi cation Area (the area 
on the right side of the 
Taskbar that contains 
shortcuts to programs and 
important status information) 
and selecting Network and 

Sharing Center.
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Step-By-Step EXERCISE 2-4
Connect to and Check the Status of a 
Wireless Network 
You can connect to a wireless network, or type of computer network that is wireless, 

in much the same way you connect to a wired network. You can also monitor the 

status of the wireless connection to check signal strength for best performance.

 Click Start . Right-click 

Network and select 

Properties.

 In the Network and 

Sharing Center window, 

select Connect to a 

network.

 In the Connect to a 

network dialog box, click 

the Show drop-down 

arrow and select Wireless 

(see Figure 2.11).

 Select the wireless network 

assigned by your teacher. 

Click Connect.

 At the successful 

connection prompt, click 

Close.

 Your screen 

should look similar to 

Figure 2.12.

 Under Connection, click 

View status.

 In the Wireless Network 

Connection Status dialog 

box, click Close .

 In the Network and 

Sharing Center window, 

click Close .

Continue to the next exercise.

FIGURE 2.11 Connect to a network dialog box

FIGURE 2.12 Network and Sharing Center connected to wireless network

Click to select Wireless

View status

Wireless network connected
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Step-By-Step EXERCISE 2-5
Remotely Connect to a Network 
at a Workplace (Computer)
Connecting to a network located in your offi ce is convenient, but the increasing 

popularity of mobile, or remote, computing has created a need to connect to networks 

regardless of your location. Microsoft Windows Vista allows you to connect to your 

offi ce network using a Virtual Private Network (VPN) over the Internet. 

FIGURE 2.13 Set up a connection or network dialog box

FIGURE 2.14 Connect to a workplace dialog box

Key Internet address here

 Click Start . Right-click 

Network and select 

Properties.

 In the left pane, select Set 

up a connection or 

network.

 In the Set up a 

connection or network 

dialog box, in the Choose 

a connection option box, 

scroll down and select 

Connect to a workplace.

 Your dialog 

box should look similar to 

Figure 2.13.

 Click Next. In the Connect 

to a workplace dialog 

box, select Use my 

Internet connection 

(VPN).

 In the Internet address 

box, key the IP address 

provided by your teacher 

(see Figure 2.14). Click 

Next.

Continued on the next page.

VPNs are encrypted, or 
private, so only authorized 
users have access to them.
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Step-By-Step EXERCISE 2-5 (Continued)

Remotely Connect to a Network at a 
Workplace (Computer)

FIGURE 2.15 Set Network Location dialog box

FIGURE 2.16 Network and Sharing Center with VPN connection active

Virtual Private 
Network 
established

 Under the Type your user 

name and password 

heading, in the User name 

and Password boxes, key 

the user name and 

password provided by your 

teacher. Click Connect.

 After receiving the You are 

connected message, click 

Close.

 In the Set Network 

Location dialog box, click 

Work (see Figure 2.15).

 In the User Account 

Control dialog box, click 

Continue.

 Click Close .

 Your screen 

should look like Figure 2.16.

 Click Close .

Continue to the next exercise.

To open the Connect to a 

network dialog box, right-
click the Network icon in 
the Notifi cation area on 
the Taskbar, and select 
Connect to a network.
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Step-By-Step EXERCISE 2-6
Use a Remote Desktop Connection
With Microsoft Windows Vista, you can connect to your own network wherever you go. 

You can also use another PC to connect to your own PC. You can use the programs on 

that computer while viewing its desktop through the Remote Desktop Connection.

FIGURE 2.17 System window 

Remote settings

FIGURE 2.18 System Properties dialog box

Select Users

 Click Start .

 In the Start menu, right-

click Computer and select 

Properties.

 In the left pane, under 

Tasks, click Remote 

settings (see Figure 2.17).

 In the User Account 

Control dialog box, click 

Continue.

 In the System Properties 

dialog box, under Remote 

Desktop, select Allow 

connections from 

computers running any 

version of Remote 

Desktop.

 Your dialog 

box should look like 

Figure 2.18.

 Click Select Users.

 In the Remote Desktop 

Users dialog box, click 

Add.

 In the Enter the object 

names pane, key the name 

provided by your teacher. 

Click OK. In the Remote 

Desktop Users dialog 

box, click OK.

 Click OK again.

 Close the System window.

Continued on the next page.
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Step-By-Step EXERCISE 2-6 (Continued)

Use a Remote Desktop Connection
 Click Start . Click All 

Programs.

 In the list, click 

Accessories.

 Click Remote Desktop 

Connection.

 Your dialog 

box should look like 

Figure 2.19.

 In the Remote Desktop 

Connection dialog box, 

key the name of the 

computer provided by your 

teacher.

 Click Connect.

 In the credentials box, key 

the user name and 

password provided by your 

teacher. Click OK.

 Your screen should look like 

Figure 2.20.

 In the Remote Desktop 

window, click Close .

 In the Disconnect 

Windows session dialog 

box, click OK. The remote 

connection is now closed.

Continue to the next exercise.

FIGURE 2.19 Remote Desktop Connection dialog box

FIGURE 2.20 Remote Desktop window

 You are connected to this Remote Desktop

Your desktop

If you are using Windows Vista, you cannot use a Remote Desktop 
Connection to connect to remote computers that use Windows XP.
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Step-By-Step EXERCISE 2-7
Disable Windows Remote Assistance
In order to keep your computer secure, you can prevent others from gaining 

unauthorized control your computer with the Windows Remote Assistance tool. By 

disabling the remote control option, you can keep others from being able to access, 

or gain entry to your computer using the Remote Assistance tool.

 Click Start .

 In the Start menu, right-

click Computer and select 

Properties.

 Your screen 

should look like Figure 2.21.

 In the left pane, under 

Tasks, click Remote 

settings.

 In the User Account 

Control dialog box, click 

Continue.

 In the System Properties 

dialog box, under Remote 

Assistance, clear the 

Allow Remote Assistance 

connections to this 

computer check box. 

 Your dialog 

box should look like 

Figure 2.22.

 Click OK.

 Click Close .

Continue to the next exercise.

FIGURE 2.21 System window

FIGURE 2.22 Remote Desktop Connection dialog box

Remote assistance option

Windows Remote 
Assistance allows you to 
permit another user to 
connect to your computer 
from another computer 
running a compatible 
operating system.
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Step-By-Step EXERCISE 2-8
Connect to a Network Computer by 
Mapping a Drive
A shared folder is a folder on a networked computer that has been set up to allow 

access by others on the network. Creating a shortcut to a shared folder, computer, or 

drive on a network is called mapping a network drive. Once a shared folder is mapped, 

you no longer have to key in its network address each time you want to use it.

 Click Start . In the right 

pane, select Computer.

 In the toolbar, click Map 

network drive .

 In the Map Network 

Drive dialog box, leave the 

default Drive letter as Z: 

and click Browse (see 

Figure 2.23).

 Click Browse and navigate 

to, and select, the folder 

assigned by your teacher. 

 Click OK. Click Finish.

 In the new mapped 

shared folder view, click 

Close .

 Your screen 

should look like Figure 2.24.

 Click Close .

Continue to the next exercise.

FIGURE 2.23 Map Network Drive dialog box

FIGURE 2.24 Computer folder with mapped drive added

Leave default Drive as Z:

Browse

Mapped drive

Mapping a drive through 
the network directory 
folder system is similar to 
reading a road map or 
creating a fl ow chart. On a 
separate piece of paper, 
draw a fl ow chart for how 
you would navigate 
through the folders to get 
to the network drive, begin-
ning just as you open the 
Network folder.
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Step-By-Step

 Click Start .

 In the Start menu, click 

Network (see Figure 2.25).

 Your screen 

should look similar to 

Figure 2.26.

 Double-click the computer 

icon for the computer 

assigned by your teacher. 

View the resources 

available on that computer.

 Click Close .

Continue to the next exercise.

FIGURE 2.25 Network on Start menu

FIGURE 2.26 Network folder

Computers on network

Network

EXERCISE 2-9
Connect to a Network Computer by 
Browsing a Network 
A simple way to connect to another computer is by browsing your network. Any 

computers on the network that have been confi gured to share resources and be 

identifi ed will show up in the Network folder.

You may also know the 
word network in relation to 
a television network. A 
television network uses 
individual local stations to 
carry a signal from one 
central location. Similarly, 
computer networks use 
individual local computer 
stations to transmit 
information from a central 
server.

To keep the Notification 
area uncluttered, hide any 
icons that you have not 
clicked recently.
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Step-By-Step EXERCISE 2-10
Connect to a Network Computer 
by Accessing Shared Folders
You can allow only certain people to access shared folders or you can open a shared 

folder to anyone with access to the network. Shared folders can be accessed by simply 

navigating to them on the network.

FIGURE 2.27 Network folder

FIGURE 2.28 Network Public folder

 Click Start .

 In the Start menu, click 

Network.

 Your screen 

should look similar to 

Figure 2.27.

 Double-click the computer 

assigned by your teacher.

 Double-click the Public 

folder in the network 

computer folder (see 

Figure 2.28).

 Browse through the fi les 

and folders available in 

the Public folder. Click 

Close .

Continue to the next exercise. 

Public folder on 
network

In Windows Vista, a public 
folder allows users to 
store and share fi les with 
other users on the same 
computer or network.
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Step-By-Step EXERCISE 2-11
Access Files While a Computer Is Offl ine
Vista allows you to access fi les from a network folder even if your computer is offl ine. 

When you set up your computer to work with offl ine fi les, Vista copies all the fi les from 

the network folder to your computer. Whenever the network fi les are not available, Vista 

uses the offl ine fi les. It can then synchronize, or reconcile the differences between the 

offl ine fi les and the same fi les on the network when you reconnect.

FIGURE 2.29 Offline Files dialog box

FIGURE 2.30 Assigned computer folder Public folder

Shared Public folder

 Click Start . In the 

Start menu, click Control 

Panel.

 Click Network and 

Internet.

 Click Offline Files. In the 

User Account Control 

dialog box, click Continue.

 Your dialog 

box should look similar to 

Figure 2.29.

 In the Offline Files dialog 

box, click Enable Offline 

Files.

 Click OK. In the Offline 

Files dialog box, click Yes 

to restart your computer.

 Click Start . Select 

Network.

 Double-click the computer 

assigned by your teacher.

 In the assigned computer 

folder, right-click the 

Public folder and select 

Always Available Offline

(see Figure 2.30).

 Click Close .

Continue to the next exercise.

Always Available 
Offline
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Step-By-Step EXERCISE 2-12
Synchronize Folders between Computers
Vista synchronizes offl ine folders automatically when you reconnect to the network, 

but there might be times when you want to sync the folders manually. You may also 

need to resolve a synchronization confl ict, or difference, between the fi les on the 

network and the fi les on your computer.

FIGURE 2.31 Sync Center folder

FIGURE 2.32 Sync Results folder

 Click Start . Click All 

Programs.

 Click Accessories. Select 

Sync Center.

 Your screen 

should look like Figure 2.31.

 Select the Offline Files 

folder. Click Sync .

 In the Sync Center folder 

in the left pane, click View 

sync results.

 Your screen 

should look similar to 

Figure 2.32.

 Click Close .

Continue to the next exercise.

Click to select

Synchronization refers to 
the idea of keeping multi-
ple copies of fi les and 
folders coherent with one 
another. The purpose of 
synchronization is to main-
tain data integrity. When 
you sync fi les or folders, 
you fi x the differ ences 
between the offl ine version 
of the fi les and the version 
of the fi les on the network.
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Step-By-Step EXERCISE 2-13
Resolve Synchronization Confl icts
Synchronizing fi les over a network means that access to those fi les is open to more 

than just your computer. Because of changes in the network or changes made by other 

users that have access to the fi les, confl icts may exist between the fi les held for offl ine 

use and the fi les on the network. These confl icts cannot be resolved using the sync 

function. Under these circumstances, use the Sync Center to resolve confl icts.

 Click Start . Select 

Network. Navigate to the 

Public folder.

 Right-click the Public 

folder and select Delete. 

Click Yes in the 

confi rmation box.

 Click Close .

 Click Start . Choose All 

Programs>Accessories>

Sync Center.

 Click Sync All .

 Your screen 

should look like Figure 2.33.

 In the left pane, click View 

sync conflicts.

 Click the fi le icon in the fi le 

area and click Resolve.

 In the Resolve Conflict 

dialog box, click Keep this 

version with the location 

On this computer (see 

Figure 2.34).

 Click Close .

Continue to the next exercise.

FIGURE 2.33 Sync Center with conflict

FIGURE 2.34 Resolve Conflict dialog box

Sync conflict

On this 
computer
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Step-By-Step EXERCISE 2-14
Make a Web Site Available Offl ine
You can save Web sites so that they are available offl ine. You do this by opening the 

Web page in Internet Explorer and saving it to a folder on your desktop. Using Internet 

Explorer, you can open the fi le even if you are offl ine.

FIGURE 2.35 Internet Explorer

FIGURE 2.36 Web site open offline

 Double-click the Internet 

Explorer icon on the 

desktop.

 Your screen 

should look similar to 

Figure 2.35.

 In the Navigation bar, key 

the address of a Web site 

provided by your teacher. 

Press . Click Page 

 and select Save As.

 In the Save Webpage 

dialog box, navigate to the 

folder designated by your 

teacher. In the File name 

box, key: [your first initial 

and last name]-webpage. 

Click Save.

 On the toolbar, click the 

Home  drop-down 

arrow. Select Blank Page.

 Click Tools  and select 

Work Offline.

 On the Menu bar, choose 

File>Open. Click Browse.

 In the Windows Internet 

Explorer dialog box, 

navigate to your saved Web 

page and select it. Click 

Open. Click OK.

Your screen 

should look like Figure 2.36.

 Click Close .

Continue to the next exercise.

Home drop-down arrow

Page Tools

Navigation bar

Vista 48Lesson 2: Exercise 2-14



Step-By-Step EXERCISE 2-15
Sign in to a Meeting Space
Windows Meeting Space is a function of Vista that allows computer users to work in 

a collaborative environment, sharing programs, information, and resources as if they 

were all meeting in the same room. This collaborative type of network requires that 

the users enable, or permit, other users to access their systems.

 Click Start . Select 

Control Panel. Click 

Network and Internet.

 Your screen 

should look like Figure 2.37.   

 Click People Near Me. 

Click the Settings tab. In 

the name box, key: [your 

first initial and last name].

 Your dialog 

box should look similar to 

Figure 2.38.

 Click the Sign In tab. 

Under Status, select Sign 

in to People Near Me. 

Click OK.

 In the People Near Me 

dialog box, click OK. In the 

User Account Control 

dialog box, click Continue.

 In the Network and 

Internet window, under 

Windows Firewall, click 

Allow a program 

through Windows 

Firewall.

 In the Windows Firewall 

Settings dialog box, on 

the Exceptions tab, select 

Windows Meeting 

Space and Windows 

Collaboration Computer 

Name Registration 

Service. Click OK.

Continued on the next page.

FIGURE 2.37 Network and Internet folder

FIGURE 2.38 People Near Me dialog box

Key your first 
initial and last 
name

People Near Me
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Step-By-Step EXERCISE 2-15 (Continued)

Sign in to a Meeting Space
  In the left pane, click 

System and 

Maintenance.

 Click Administrative 

Tools.

 In the right pane, double-

click Services.

 In the User Account 

Control dialog box, click 

Continue.

 In the Services window, 

click DFS Replication. In 

the description that opens, 

click Start the service 

(see Figure 2.39).

 Click Close .

 Close the Administrative 

Tools and the System and 

Maintenance window.

 Click Start . Choose 

All Programs>Windows 

Meeting Space.

 In the Windows Meeting 

Space Setup dialog box, 

click Yes, continue 

setting up Windows 

Meeting Space.

 In the User Account 

Control dialog box, click 

Continue.

Your screen 

should look like Figure 2.40.

Continue to the next exercise.

FIGURE 2.39 Services folder DFS Replication

FIGURE 2.40 Windows Meeting Space

Click to start 
the service
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Step-By-Step EXERCISE 2-16
Start a New Meeting
You can use Windows Meeting Space to start a meeting of your own. After you have 

signed in to Meeting Space, you can name the meeting, protect it with a password, 

and choose whether you want to allow others to see the password.

FIGURE 2.41 Windows Meeting Space

FIGURE 2.42 Windows Meeting Space board meeting

 In the Windows Meeting 

Space window, click Start 

a new meeting (see 

Figure 2.41).

 Under Meeting name, 

your fi rst initial and last 

name should be in the box, 

followed by the time. 

Highlight the time and key: 

board meeting.

 In the Password box, key: 

meeting1. 

 Click Create a meeting.

 Your screen 

should look like Figure 2.42.

Continue to the next exercise. 

Click to start new 
meeting

Meeting 
participant

You can also send a quick, 
one-on-one message to 
someone in the meeting. 
Under Particpants, right-
click the person’s name 
and click Send a note. 
Other participants will not 
see your correspondence.
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Step-By-Step EXERCISE 2-17
Join an Existing Local Collaboration Session
You can join a meeting space already in session by signing into Windows Meeting 

Space or accepting an invitation to the meeting.

FIGURE 2.43 Windows Meeting Space with meeting

FIGURE 2.44 Joined existing meeting

 In the Windows Meeting 

Space board meeting, 

click the Meeting drop-

down arrow on the menu at 

the top of your screen and 

select Leave meeting.

 Your screen 

should look like Figure 2.43.

 Click the available board 

meeting.

 In the password box, key: 

meeting1. 

 Click Join a meeting.

 Your screen 

should look similar to 

Figure 2.44.

 Click the Meeting drop-

down arrow and select 

Exit.

Continue to the next exercise. 

Click board meeting

Be careful when keying in 
a password. The use of 
proper spelling in a 
password is very 
important. If the password 
is incorrect, you might not 
be able to join a meeting.
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Step-By-Step EXERCISE 2-18
Prepare a Computer for a Presentation
Vista’s Windows Mobility Center allows you to customize settings for a laptop or 

other mobile computing device. You can create mobile settings for your computer 

that will help if you are giving a presentation. The settings are predetermined before 

the presentation. After the presentation, you can turn them off. You can reactivate 

them before your next presentation so that your settings will not have to be reset.

 Click Start  and select 

Control Panel.

 Click Mobile PC.

 Your screen 

should look like Figure 2.45.

 Under Windows Mobility 

Center, click Adjust 

settings before giving a 

presentation.

 In the Presentation Set-

tings dialog box, click the 

I am currently giving a 

presentation check box. 

 Your dialog 

box should look like 

Figure 2.46.

 Click OK.

Continue to the next exercise.

FIGURE 2.45 Mobile PC folder

FIGURE 2.46 Presentation Settings dialog box

Adjust settings 
before giving a 
presentation

Windows Mobility 
Center

You can also adjust the 
volume, check network 
connectivity, and change 
display brightness for your 
mobile computer using the 
Windows Mobility Center.
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Step-By-Step EXERCISE 2-19
Display Information on an External 
Display Device
Vista’s mobile computer capabilities allow you to display your computer’s information 

on any number of monitors and other external display devices. The Windows Mobility 

Center allows you to connect to and confi gure mobile and presentation settings.

 In the Mobile PC window, 

under Windows Mobility 

Center, click Connect to 

a projector or other 

external display (see 

Figure 2.47).

 Your screen 

should look like Figure 2.48.

 In the Windows Mobility 

Center dialog box, in the 

External Display box, 

click Connect display.

 Click Close .

 Close the Mobile PC 

folder.

Continue to the next exercise.

FIGURE 2.47 Mobile PC folder

FIGURE 2.48 Windows Mobility Center dialog box

Connect to a 
projector or other 
external display

Connect to 
external display

An external display device 
carries information out of a 
computer to display it 
visually. External display 
devices include monitors, 
projectors, and televisions.
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Step-By-Step EXERCISE 2-20
Connect to a Network Projector
Network projectors allow presentations to be displayed to users on a network. You 

can connect to a network projector to view the presentations online without being in 

the same place as the presenter.

 Click Start . Choose All 

Programs>Accessories>

Connect to a Network 

Projector (see Figure 2.49).

 Your screen 

should look like Figure 2.50.

 In the Connect to a 

Network Projector 

dialog box, click Search 

for a projector 

(recommended).

 In the list of Available 

projectors, select the one 

assigned by your teacher.

 Click Connect.

 Close the projector.

 Shut down Windows Vista.

FIGURE 2.49 Connect to a Network Projector

FIGURE 2.50 Connect to a Network Projector dialog box

Connect to  a 
Network Projector

A network projector refers 
to a projector that is 
connected to the network 
through a wired or wireless 
connection, rather than 
connected directly to the 
computer.
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Vocabulary

LESSON After You Read

Key Terms

collaborative

desktop

hibernate

mapping

network

power settings

Remote Desktop Connection

shared folder

sleep mode

synchronize

Virtual Private Network 

 (VPN)

Windows Meeting Space

Windows Mobility Center

wired network

wireless network

Academic Vocabulary

access

conflict

enable

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1. You can access a network remotely through a   .  (p. 37)

 2. Creating a shortcut to a network resource is called   the 
drive. (p. 42)

 3. You can connect to a(n)   without having to connect cables. 
(p. 36)

 4. Vista enables you to   network files with files on your 
computer. (p. 45)

 5. Synchronizing the files on your computer with network files will help you 
resolve a  . (p. 46)

  Vocabulary Activity

 6. Create a crossword puzzle using the vocabulary words. 
• On grid paper, list the vocabulary words so that they intersect at common 

letters, like a standard crossword puzzle. 
• Copy the arrangement of boxes onto another sheet of grid paper.
• On a third sheet, write the definitions for the words, listing the appropriate 

definitions in a “Down” column and the others in the “Across” column.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. Where would you go to create synchronized files on your computer? (p. 45)
A.  Control Panel>Network and 

Internet>Shared Files.
B.  Control Panel>Network and 

Internet>Offline Files.

C.  Control Panel>Internet 
Options>Offline Files.

D. Start Menu.

 8. Remote Desktop Connection allows you to access which programs? (p. 39)
A. The programs on the Taskbar.
B.  All programs on the remote 

computer.

C. Internet Explorer.
D. Windows Explorer.

 9. Where would you set up an external display? (p. 53)
A. Windows Mobility Center
B. Mobile PC

C. Appearance and Personalization
D. Ease of Access

 10. Where would you configure power settings? (pp. 31, 32)
A.  Control Panel>System and 

Maintenance>System
B. Screen saver settings

C. Desktop
D.  Control Panel>System and 

Maintenance>Power Options
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Step-By-Step

Practice It ActivitiesLESSON

 1. Confi gure Power Settings

Follow the steps to complete the activity.

FIGURE 2.51 Hardware and Sound window

Power Options

FIGURE 2.52 Power Options dialog box

 Click Start . In the right 

pane, click Control Panel. 

Click Hardware and 

Sound.

 Your screen 

should look like Figure 2.51.

 In the Hardware and 

Sound window, click 

Power Options. Select 

High performance and 

click Change plan 

settings.

 In the Edit Plan Settings 

folder, click Change 

advanced power 

settings.

 In the Power Options 

dialog box, scroll down to 

Display. Click  to 

expand the options.

 Double-click Turn off 

display after. Click 

Plugged in. Select the 

value in the Minutes box 

and key: 44.

 Your screen 

should look like Figure 2.52.

 Click OK. Click Close . 

Shut down Windows Vista.
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Step-By-Step

Practice It ActivitiesLESSON

 2. Choose a Network Connection

Follow the steps to complete the activity.

FIGURE 2.53 Network and Sharing Center

 Click Start . In the right 

pane, right-click Network 

and select Properties.

Your screen 

should look like Figure 2.53.

 In the left pane of the 

Network and Sharing 

Center, click Manage 

network connections.

 Click the network con-

nection assigned by your 

teacher. In the toolbar, 

select Enable this 

network device (see 

Figure 2.54).

 In the User Account 

Control dialog box, click 

Continue.

 Click Close .

 In the Network and 

Sharing Center, click 

Close .

 Shut down Windows Vista.

Manage network 
connections

FIGURE 2.54 Network Connections folder
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Step-By-Step

Practice It ActivitiesLESSON

 3. Prepare a Computer for Presenting Information

Follow the steps to complete the activity.

FIGURE 2.55 Mobile PC folder

 Click Start  and select 

Control Panel.

 Click Mobile PC.

 Your screen 

should look like Figure 2.55.

 Under Windows Mobility 

Center, click Adjust 

settings before giving a 

presentation.

 In the Presentation 

Settings dialog box, clear 

the I am currently giving 

a presentation option.

 Your dialog 

box should look like 

Figure 2.56.

 Click OK.

 Close the Mobile PC

folder.

 Shut down Windows Vista.

FIGURE 2.56 Presentation Settings dialog box
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Step-By-Step

LESSON

 4. Remotely Connect to a Network at a Workplace

You are away from the offi ce on a trip to meet with clients when your supervisor 

calls and asks for some sensitive fi les that are only available on your machine. The 

fi les are too big to send by e-mail, so you decide to connect to your workplace 

VPN to upload the fi les through the Internet.

FIGURE 2.57 Connect to a workplace dialog box

FIGURE 2.58 Network and Sharing Center with VPN connection active

 Click Start . Right-click 

Network and select 

Properties.

 Select Set up a connec-

tion or network. Under 

Choose a connection 

option, select Connect to 

a workplace.

 Click Next. Select Use my 

Internet connection 

(VPN).

Your screen 

should look like Figure 2.57.

 Key the IP address 

provided by your teacher. 

Click Next. Key the user 

name and password 

provided by your teacher. 

Click Connect.

 After receiving the You are 

connected message, click 

Close. In the Set Network 

Location box, select Work.

 In the User Account 

Control dialog box, click 

Continue. Click Close.

 Your screen 

should look like Figure 2.58.

 Click Close . Shut 

down Windows Vista.

You Try It Activities
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Step-By-Step

LESSON You Try It Activities

 5. Use Remote Desktop Connection

Your supervisor has received the fi les but says there is a corruption with some of the 

software on his machine. He is not sure how to fi x it. You decide to use Remote 

Desktop Connection to see if you can fi gure out how to solve the problem from 

your location.

FIGURE 2.59 Remote Desktop Connection dialog box

FIGURE 2.60 Remote Desktop window

 Click Start . Click All 

Programs.

 Click Accessories.

 Click Remote Desktop 

Connection.

 Your dialog 

box should look like 

Figure 2.59.

 In the Remote Desktop 

Connection dialog box, 

key the name of the 

computer provided by your 

teacher.

 Click Connect.

 In the Credentials box, 

key the user name and 

password provided by your 

teacher. Click OK.

 Your screen 

should look like Figure 2.60.

 In the Remote Desktop

window, click the 

Close .

 In the Disconnect 

Windows session dialog 

box, click OK.

 Shut down Windows Vista.
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Critical Thinking ActivitiesLESSON

 6. Beyond the Classroom Activity

Language Arts: Connect to a Network Computer Connect to the 

network computer assigned by your teacher using the Network folder. Using 

the tools you have learned, make a designated folder available offl ine.

■ Disable the network connection.

■ Make two changes in the files in the designated folder. Print the files 
so that you have a hard copy of the changes.

■ Reconnect to the network and synchronize the files. Resolve any 
conflicts.

Open a Word document and create a checklist that details the steps you 

took to disable the network connection. After you have created the checklist, 

key a short paragraph that describes some advantages to working with 

offl ine fi les. Save your fi le as: v2rev-[your fi rst initial and last name]6.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 2.4 Connect to another computer

Manipulate a Remote Desktop Connect to another computer assigned 

by your teacher using Remote Desktop Connection. 

Once you have connected to the remote computer, open Internet Explorer 

on the remote computer and add three trustworthy news Web sites to the 

favorites on that machine. Close Internet Explorer and exit Remote 

Desktop Connection. Then, open a Word document and list the three 

Web sites. Key a short paragraph that explains the reasoning behind your 

choices and why the sites are trustworthy. Save your fi le as: v2rev-[your fi rst 

initial and last name]7. 

 8. 21st Century Skills Activity

Communicate Responsibly Communication is important in the 

modern workplace. While more and more communication takes place 

through computer-aided activities rather than in face to face conversations, 

this communication can be less effi cient if you do not treat others with 

respect. Set up a meeting to discuss the importance of communicating 

responsibly in the workplace using Microsoft Meeting Space. Invite three 

classmates to the meeting via e-mail. Ask them each to send you one reason 

why being courteous is important in the business world. Add their ideas to 

the meeting agenda. Join at least one other meeting by accepting an 

invitation from one of your other classmates. 
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LESSON

 9. Make Files Available Offl ine 

Language Arts: Increase Accessibility The Inventory Control 

department at your company is complaining that the slow network 

connection makes it too diffi cult to work on inventory fi les on the network. 

You have been asked to solve the problem.

■ Browse the network to the folder assigned by your teacher and make it 
available offline.

■ Map the folder so that it is quickly accessible every time.

■ Synchronize the files in the folder.

Open a Word document and key one paragraph that describes how working 

with offl ine fi les can help boost effi ciency and protect fi les against network 

outages. Save your fi le as: v2rev-[your fi rst initial and last name]9.

 10. Connect to a Wireless Network

Language Arts: Activate a Wireless Connection Your supervisor 

needs wireless access for his mobile computer and has given you access to 

his machine.

■ Activate a wireless connection to connect to the network.

■ Check the connection status of the wireless network. 

Open a Word document and key a paragraph that compares and contrasts 

the advantages and disadvantages of wireless networks. What would life be 

like without wireless networks? How would your life change if wireless 

networks disappeared from the world? Save your fi le as: v2rev-[your fi rst 

initial and last name]10. 

 11. Use a Remote Connection 

Language Arts: Personalize a Desktop Remotely You have 

connected your supervisor to the wireless network, but you have realized 

there were some last-minute tweaks to his settings that you forgot to 

accomplish. Use Remote Desktop Connection to connect to the computer 

assigned by your teacher and:

■ Double the screen saver time.

■ Change the desktop background.

■ Configure the power settings for maximum performance.

Open a Word document and key a paragraph that identifi es how being able 

to connect to a work computer from a home computer is benefi cial to a 

business. Save your fi le as: v2rev-[your fi rst initial and last name]11. 

Challenge Yourself Projects

Finish the Task Many jobs 
today are not defined by the 
traditional “9-to-5” work 
schedule. The standard work 
day has shifted more toward 
focusing on the completion 
of tasks instead of the 
amount of time in a work 
day. Mobile computing, 
networking and instant 
communication have all 
contributed to this shift.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. What type of career would 
you choose: time-based 
or task-based? Why?

2. How might you affect 
your coworkers if you did 
not complete each of the 
tasks in the Challenge 
Yourself Projects?
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Key Concepts

Manage Software, Disks, and DevicesLESSON

As personal computers become more advanced, the potential for technical 

problems also rises. While most workplaces that depend on computers employ 

technicians to maintain their PCs and networks, understanding some of the key 

Vista functions will allow you to solve or avoid many common problems. Vista 

also allows you to tailor your computer to fi t your needs.

Ask Questions Whether in the workplace or the classroom, at some point 

someone will want you to take on a task that you do not completely understand. 

Never be afraid to ask questions. It is more than likely the person questioned will 

appreciate the fact that you were paying enough attention to want to know more. 

Think hard about what you really want to know. The better the question is, the 

more informative the answer is likely to be. How could asking questions help you 

accomplish a certain task? 

 Create a restore point

 Install, uninstall, update, and 
run a program in compatibility 
mode

 Analyze the space and 
partitions on a hard disk

 Enable and disable devices 

 Update and roll back drivers

 Adjust display settings

 Install and share local and 
network printers

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in the 
Student Edition for a 
description of the standards 
listed here.

ISTE Standards Correlation

NETS•S

1a, 2a, 2d, 3b, 3c, 4b, 5a, 5b, 
6a, 6c

Microsoft Certified 
Application Specialist 
Standards

Vista

3.1, 3.2, 3.3, 3.4, 3.5, 3.6
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Reading GuideLESSON

Highlight To help your reading comprehension, consider using a highlighter to capture the main points 
of each paragraph. As you read, the act of highlighting these points reinforces them in your mind and 
makes it easier to study them when you go back to review.

Read to Learn

• Learn how to install and manage software.
• Manage your hard disk and hardware devices.
• Optimize your display settings.
• Install and confi gure network and local printers.

Main Idea

Use Vista’s functions to optimize your system and 
manage your computer’s hardware and software.

Vocabulary

Key Terms

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

available
complex
primary

Quick Write Activity 

Describe Think about the types of programs that 
you might have used on a computer. On a separate 
sheet of paper, write the names of fi ve different 
programs installed on your computer that were not 
developed specifi cally for Windows Vista.

Study Skills

Organize Your Workstation A messy 
environment can be distracting. Increase your 
effectiveness by lessening distractions. Organize 
an area where you can do homework assignments, 
write papers, and complete projects.

Academic Standards

English Language Arts
NCTE 1 Read texts to acquire new information.
NCTE 3 Apply strategies to interpret texts.
NCTE 5 Use different writing process elements to communicate effectively.

Math
NCTM (Measurement) Understand measurable attributes of objects and the units, systems, and processes 
or measurement.
NCTM (Measurement) Apply appropriate techniques, tools, and formulas to determine measurements.

compatibility
 mode
Computer 
 Management
confi gure
device
Device Manager
Disk
 Management

display
driver
hard disk
hardware
operating system
PC card
restore point
Safely Remove 
 Hardware

screen
 resolution
share
software
uninstall
USB device

Before You Read
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Step-By-Step EXERCISE 3-1
Create a Restore Point
To allow the Vista operating system to be effective in recovering from major system 

errors, it is necessary for you to create a restore point. An operating system is the 

program that manages all other programs on your computer. A restore point is the 

most recent stored state of the settings of your computer’s operating system. If your 

system crashes, System Restore will return Vista to the most recent restore point. 

 Click Start >All 

Programs>Maintenance. 

Click Backup and 

Restore Center.

 Your screen 

should look like Figure 3.1.

 In the left pane, click 

Create a restore point 

or change settings. Click 

Continue.

 In the System Properties 

dialog box, under 

Available Disks, select 

the OS (C:) (System) 

drive. Leave the box 

checked (see Figure 3.2).

 Click Create. In the 

System Protection 

dialog box, key: First 

Manual Restore Point.

 Click Create. Click OK.

 In the System Properties 

dialog box, click OK.

 Click Close .

Continue to the next exercise.

FIGURE 3.1 Backup and Restore Center

FIGURE 3.2 System Properties dialog box

Create a 
restore point 
or change 
settings

Make sure this box is checked

Vista automatically creates 
restore points when it 
detects that changes are 
being made to the system, 
but you can also manually 
set a restore point.
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Step-By-Step EXERCISE 3-2
Install and Uninstall a Software Program
Adding, running, and removing programs is part of the everyday operation of most 

computers. How you install and confi gure, or set up, a program is largely up to the 

program and its installation components. Vista makes it easier to remove some 

programs which do not have readily available, or built-in, uninstall features. 

 Choose Start >Control 

Panel. Click Programs.

 Your screen 

should look like Figure 3.3.

 In the Programs window, 

under Programs and 

Features, click Uninstall 

a program. 

 Your screen 

should look like Figure 3.4.

 Ask your teacher which 

program to select in the 

program list. On the toolbar 

above the list, click 

Uninstall .

 In the User Account 

Control dialog box, click 

Continue.

 In the Uninstall confi r ma-

tion dialog box, click Yes.

 Click OK. Click Close 

.

Continue to the next exercise.

FIGURE 3.3 Control Panel

FIGURE 3.4 Programs and Features window

Uninstall a 
Program

Installation procedures will 
vary from one program to 
another. For more on how 
to install a program, 
choose Start>Control 

Panel>Programs. Under 
Programs and Features, 
click How to install a 

program.

Click to uninstall selected software
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Step-By-Step EXERCISE 3-3
Install a Software Update
Software is a general term that is applied to application programs such as Word and 

Excel. Microsoft and other software publishers create updates for software regularly, 

and you should update your software as often as possible. For publishers other than 

Microsoft, check with the publisher to see how to download and install updates.

FIGURE 3.5 Windows Update window

FIGURE 3.6 Available updates

 Choose Start >All 

Programs>Windows 

Update.

 Your screen 

should look like Figure 3.5.

 In the left pane, click 

Check for updates.

 Click View available 

updates.

 Your screen 

should look similar to 

Figure 3.6.

 Click the check box for the 

update assigned by your 

teacher and click Install.

 In the User Account 

Control dialog box, click 

Continue.

 In the Windows Update 

window, click Close .

Continue to the next exercise.

Check for updates

Often, updates will take a 
while to download and 
install on your system. Do 
not interrupt the update by 
closing the folder or clicking 
Stop before the update is 
complete. Be patient. If you 
interrupt the process, you 
may damage the program 
or operating system.

Check boxes to select updates
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Step-By-Step EXERCISE 3-4
Confi gure a Program to Use 
Compatibility Mode
Many older programs designed for previous versions of Windows will work in Vista. 

If an older program experiences problems or does not work at all, you may still be 

able to run them in Vista. Vista’s compatibility mode simulates earlier versions of 

Windows so that older programs will run effectively.

FIGURE 3.8 Compatibility mode settings

 Choose Start >All 

Programs.

 Click Accessories. Right-

click Notepad, or another 

program chosen by your 

teacher, and select 

Properties.

 Your dialog 

box should look similar to 

Figure 3.7.

 In the program’s 

Properties dialog 

box, click the 

Compatibility tab.

 Under Compatibility 

mode, click the Run this 

program in compatibility 

mode for: check box.

 Click the compatibility 

mode drop-down arrow 

and select Windows 98/

Windows Me.

Your dialog 

box should look like 

Figure 3.8.

 Click OK.

Continue to the next exercise.

FIGURE 3.7 Notepad Properties dialog box

Compatibility 

Mode drop-
down arrow

Not all programs can be 
run in compatibility mode. 
If programs were designed 
for use with Vista, this 
option will not be available.
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Step-By-Step EXERCISE 3-5
Analyze the Space Available on a Hard Disk
Every individual program, update, and data fi le on your computer takes up space on 

the hard disk on your computer. The hard disk, or hard drive, is a magnetic disk that 

stores computer data. You can check how much space is left on your hard disk.

FIGURE 3.9 Start menu 

FIGURE 3.10 Computer folder

Computer

Disk details for  
selected disk

 Choose Start >

Computer (see Figure 3.9).

 In the Computer folder, 

select the system drive (C:) 

that you want to check free 

space on.

 Your screen 

should look similar to 

Figure 3.10. Note that the  

drive information displays 

in the Details pane at the 

bottom of the folder.

 Click Close .

Continue to the next exercise.

You can fi nd the amount 
of free space on a drive 
by choosing Start>

Computer>Manage. 
Select Disk Management.

Computer storage space 
is measured in gigabytes 
(GB). A gigabyte is one 
billion (1,000,000,000) 
bytes. File and program 
sizes are usually measured 
in kilobytes (KB - 100,000 
bytes) and megabytes 
(MB - 1,000,000 bytes). 
Use a calculator to deter-
mine how many bytes of 
free space your PC has.

Vista 70Lesson 3: Exercise 3-5



Step-By-Step EXERCISE 3-6
Determine if a Hard Disk Is Partitioned
Vista has many management programs that allow you to gather information about 

your computer and help you tune your system to run at peak effi ciency. One of the 

most powerful tools is the Computer Management folder, which includes the Disk 

Management tools.

When you partition a hard 
drive, you divide a disk into 
separate volumes. These 
volumes are fractions of the 
original whole. Fold a piece 
of paper in three equal 
sections. Then, fold the 
paper in half. Unfold the 
paper. It is still the same 
size, but is divided into 
separate parts. How many 
sections is the paper 
divided, or partitioned, into?

FIGURE 3.11 Start menu

Select to open the 
User Account 
Control dialog box

FIGURE 3.12 Disk Management view

Partitions for disk 0

Disk Management

 Click Start . Right-click 

Computer and select 

Manage (see Figure 3.11).

 In the User Account 

Control dialog box, click 

Continue. Under Storage, 

click Disk Management.

 Your screen 

should look similar to 

Figure 3.12.

 At the bottom of the Disk 

Management window, 

the hard disks will be 

numbered starting with 0. 

 Click the fi rst disk label. If 

more than one volume 

appears in the top pane, 

the disk has multiple 

partitions. 

 Click Close .

Continue to the next exercise.
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Step-By-Step EXERCISE 3-7
Check the Hard Disk for Problems
You should check your system periodically for errors to ensure that your hard disk is 

running properly. Maintaining your hard disk will help keep all of your software and 

hardware running. Nearly every program and connection your computer holds is on the 

hard disk. If the hard disk fails, the data on the hard disk may be damaged or deleted.

FIGURE 3.13 Computer folder

Ask your teacher which 
drive to select. Your 
choices may not match 
those shown here.

FIGURE 3.14 Drive Properties dialog box

Tools tab

Check Now

 Choose Start >

Computer.

 Your screen 

should look like Figure 3.13.

 In the right pane, select the 

hard drive chosen by your 

teacher.

 Right-click the drive and 

select Properties.

 In the drive Properties 

dialog box, click the Tools 

tab (see Figure 3.14).

 Under Error-checking, 

click Check Now.

Continued on the next page.

To see the errors on the 
disk that the program 
corrected, click See 

details in the Check Disk 
confi rmation dialog box.  

The routine performance of 
maintenance will help keep 
your computer running at its 
best. Proper maintenance is 
also essential in keeping 
other complex machines 
running effi ciently. Write a 
paragraph explaining the 
steps you need to complete 
in order to maintain a 
machine, such as a bike, 
car, or cell phone.
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Step-By-Step EXERCISE 3-7 (Continued)

Check the Hard Disk for Problems

FIGURE 3.15 Check Disk dialog box

FIGURE 3.16 Checking Disk confirmation dialog box

 In the User Account 

Control dialog box, click 

Continue.

 In the Check Disk dialog 

box, click both check 

boxes. 

 Your dialog 

box should look like 

Figure 3.15. 

 Click Start.

 Your dialog 

box should look like 

Figure 3.16. Click Close.

 In the Properties, dialog 

box, click OK.

 Close the Computer 

folder. 

Continue to the next exercise. 

If the Automatically fix 
file system errors check 
box is selected for a disk 
that is in use, you will be 
prompted to reschedule 
the disk check for the next 
time you restart your 
computer.

To automatically repair problems with fi les and folders, select the 
Automatically fi x fi le system errors check box in the Check 
Disk dialog box. To fi nd and repair physical errors on the hard 
disk itself, select the Scan for and attempt recovery of bad 
sectors check box.
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Step-By-Step EXERCISE 3-8
Enable and Disable Devices
Each individual piece of hardware, or actual physical part, in your computer is called 

a device. Vista allows you to manage these devices through the Device Manager. You 

can enable or disable devices on your computer to resolve confl icts or conserve 

resources.

 Click Start  and select 

Control Panel. Click 

Hardware and Sound.

 Click Device Manager. In 

the User Account 

Control dialog box, click 

Continue.

 In the list of devices, scroll 

down to Ports. Click  

in front of Ports to expand 

the listing.

 Your screen 

should look like Figure 3.17.

 Right-click Printer Port 

(LPT1) and select 

Disable. Click Yes.

 Your screen 

should look similar to 

Figure 3.18.

 Select the Printer Port. 

In the Device Manager, 

choose Action>Enable.

 Close the Device 

Manager. Close the 

Control Panel.

Continue to the next exercise.

FIGURE 3.17 Device Manager

FIGURE 3.18 Device Manager with Printer Port disabled

Available ports

Many Device Manager 
functions in the drop-
down menus can also be 
activated using the toolbar 
in the Device Manager.

Device disabled icon 
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Step-By-Step EXERCISE 3-9
Update a Device Driver 
Vista’s Device Manager also allows you to update a driver for a listed device. The 

process is similar to a software update. Drivers for devices might be updated to 

resolve hardware confl icts, maximize the effi ciency of the device, or make the device 

compatible with a newer operating system.

 Click Start  and select 

Control Panel.

 In the Control Panel, click 

Hardware and Sound.

 Click Device Manager.

 In the User Account 

Control dialog box, click 

Continue.

 In the Device Manager, 

Click Ports. Click Printer 

Port (LPT1). Right-click 

the device and select 

Update Driver Software 

(see Figure 3.19).

 Your screen 

should look similar to 

Figure 3.20.

 In the Update Driver 

Software dialog box, click 

Search automatically 

for updated driver 

software.

 Read the Update Driver 

Software confi rmation 

dialog box, Click Close.

Continue to the next exercise.

FIGURE 3.19 Device Manager

FIGURE 3.20 Update Driver Software dialog box
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Step-By-Step EXERCISE 3-10
Change a Driver to a Previous Version
Sometimes updating to the most current driver for a device causes more problems than 

it solves. In this case, Vista offers you the option of rolling back the driver to the previous 

version. This returns the device to its original state before you updated the driver.

FIGURE 3.21 Mobile Intel(R) Device Properties dialog box

FIGURE 3.22 System Settings Change warning box 

 Click Start  and select 

Control Panel.

 In the Control Panel, click 

Hardware and Sound.

 Click Device Manager.

 In the User Account 

Control dialog box, click 

Continue.

 Right-click the driver 

assigned by your teacher 

and select Properties.

 In the device Properties 

dialog box, click Roll Back 

Driver (see Figure 3.21).

 In the Driver Package 

rollback confi rmation 

dialog box, click Yes.

 In the device Properties 

dialog box, click Close.

 Your dialog 

box should look similar to 

Figure 3.22.

 In the System Settings 

Change warning box, 

click Yes to restart your 

computer.

Continue to the next exercise.

Roll Back Driver
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Step-By-Step EXERCISE 3-11
Remove PC Cards and USB Devices
A PC card or USB device is a portable hardware device on which you can save data 

to be moved from one computer to another. They do not normally require a complex, 

or complicated, installation or driver update. You can connect or disconnect them 

while your computer is running. There are some precautions to take, however, before 

disconnecting the devices if the Safely Remove Hardware icon is displayed.

FIGURE 3.24 Safely Remove Hardware dialog box

 Insert the PC Card or USB 

device that you will be 

using for this lesson. Close 

all windows that may 

appear on your screen.

 In the Notification area of 

the Taskbar, double-click 

the Safely Remove 

Hardware  icon (see 

Figure 3.23).

 In the Safely Remove 

Hardware dialog box, in 

the Hardware devices 

box, follow your teacher’s 

instructions as to which 

device to select. 

 Your dialog 

box should look similar to  

Figure 3.24.

 Click Stop.

 In the Stop a Hardware 

device dialog box, select 

the device in the list area 

and click OK.

 Remove the PC card by 

ejecting it, or a USB device 

by unplugging it.

 In the Safe To Remove 

Hardware confi rmation 

box, click OK.

 In the Safely Remove

Hardware dialog box, 

click Close.

Continue to the next exercise.

FIGURE 3.23 Safely Remove Hardware icon in Taskbar

Safely Remove 
Hardware icon

Notification area 
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Step-By-Step EXERCISE 3-12
Adjust Display Resolution and Color 
Depth and Display Refresh Rate 
Vista has many features to make using your computer easier, and among one of the 

most notable is the large number of display settings. You can optimize your display 

for your particular monitor using the features in the Personalization folder.

FIGURE 3.25 Display Settings dialog box 

FIGURE 3.26 Advanced Monitor Settings

 Right-click in an open area 

of the desktop and select 

Personalize.

 Click Display Settings.

 In the Display Settings 

dialog box, click 

Advanced Settings. Click 

the Monitor tab.

 Your dialog 

box should look similar to 

Figure 3.25.

 Under Monitor Settings, 

click the Screen refresh 

rate drop-down arrow to 

view the different options. 

Click Cancel.

 In the Display Settings 

dialog box, click the 

Colors drop-down arrow 

and select the medium 

color depth (16 bit).

 In the Display Settings 

dialog box, click and drag 

the Resolution slider to 

the lowest setting.

Your dialog 

box should look similar to 

Figure 3.26. Click Apply.

 In the Display Settings

dialog box, click No.

 Click Close.

Continue to the next exercise.
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Step-By-Step EXERCISE 3-13
Adjust Icon Size
You can adjust your screen resolution to get more information on the display, but 

the higher the resolution the smaller some images become. In order to make your 

desktop more readable, Vista allows you to adjust the size of your desktop icons.

FIGURE 3.27 Desktop with large icons

Icons enlarged

FIGURE 3.28 Desktop with medium icons

 Right-click in an open area 

of the desktop and choose 

View>Large Icons.

 Your screen 

should look similar to 

Figure 3.27.

 Right-click in an open area 

of the desktop and choose 

View>Medium Icons.

 Your screen 

should look similar to 

Figure 3.28.

Continue to the next exercise.

Medium icons

The images on your  monitor 
are made up of individual 
dots of color called pixels. 
The more pixels you have 
on the screen, the higher 
the resolution.

Many monitors allow for 
screen resolutions any-
where from 800 × 600 to 
1280 × 1024. A low 
resolution screen would 
be 800 pixels wide and 
600 pixels high. To fi nd 
out the overall number of 
pixels, you would multiply 
800 × 600.
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Step-By-Step EXERCISE 3-14
Adjust Monitor Resolution 
on a Secondary Monitor 
You can connect more than one monitor to your PC, which you might do when giving 

a presentation or working with video editing or graphics programs. You can adjust the 

secondary monitor settings independently of the primary, or main, monitor settings.

FIGURE 3.29 Display Settings dialog box

FIGURE 3.30 Control Panel

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Appearance and 

Personalization, click 

Adjust screen 

resolution.

 In the monitor icon area, 

click the monitor labeled 2

(see Figure 3.29).

 Adjust the Resolution 

slider to the lowest possible 

setting.

 Click OK.

 Your screen 

should look like Figure 3.30.

Continue to the next exercise.

Select monitor 2

Slide to change 
resolution

You can add a second 
monitor to your computer 
if you have a video card 
that supports multiple 
monitors, or your 
computer has more than 
one video card.
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Step-By-Step EXERCISE 3-15
Extend the Desktop onto 
a Secondary Monitor
Vista’s display features allow you to extend your desktop onto a secondary monitor, 

meaning you now have the area of two monitors to display your entire desktop. You 

might use this when you have more than one program open and want to see a full 

window view of each. You can also select a monitor to be the primary monitor.

FIGURE 3.31 Display Settings dialog box

FIGURE 3.32 Main monitor selected

  Click Start  and select 

Control Panel. Under 

Appearance and 

Personalization, click 

Adjust screen 

resolution.

 In the monitor icon area, 

select the monitor icon 

labeled 2.

 Check the box next to 

Extend the desktop 

onto this monitor.

 Your dialog 

box should look like 

Figure 3.30. Click OK.

 In the settings confi rmation 

dialog box, click Yes. 

 In the Control Panel, 

under Appearance and 

Personalization, click 

Adjust screen 

resolution.

 In the Display Settings

dialog box, click the 

monitor icon that you want 

to be your primary monitor.

 Select the check box next 

to This is my main 

monitor (see Figure 3.32).

 Click OK.

 In the Control Panel, click 

Close .

Continue to the next exercise.

Check to set as 
primary monitor 
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Step-By-Step EXERCISE 3-16
Install a Local Printer
In addition to confi guring your display settings to make your information more 

readable, you must also confi gure your printer. A printer connected directly to your 

computer is called a local printer.

FIGURE 3.33 Add Printer dialog box

FIGURE 3.34 Choose a printer port window

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Printer.

 In the toolbar, click Add 

a printer .

Your screen 

should look similar to 

Figure 3.33.

 In the Add Printer dialog 

box, click Add a local 

printer. 

 In the Choose a printer 

port dialog box, make sure 

Use an existing port is 

selected. Click the port 

drop-down arrow and follow 

your teacher’s instructions 

for selecting  a port.

 Your dialog 

box should look similar to 

Figure 3.34.

 Click Next.

Continued on the next page.
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Step-By-Step EXERCISE 3-16 (Continued)

Install a Local Printer

FIGURE 3.35 Install the printer driver window

FIGURE 3.36 Printers folder with new local printer added

New printer added

 In the Install the printer 

driver window, in the 

Manufacturer and 

Printers boxes, follow 

your teacher’s instructions 

for selecting the options 

(see Figure 3.35).

 Click Next.

 Clear the Set as the 

default printer option and 

click Next.

 With your teacher’s permis-

sion, click Print a test 

page. Click Finish.

 Your screen 

should look similar to 

Figure 3.36.

Continue to the next exercise.

If you have added a printer 
but are unable to use it, 
you may need to install or 
update the printer driver so 
that it is compatible with 
the version of Windows 
running on your computer.
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Step-By-Step EXERCISE 3-17
Install a Network Printer
In order for several users to share a printer, Vista enables you to connect to a printer 

that is on a network. You install this printer in much the same way as you install a 

local printer.

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Printer.

 In the toolbar at the top of 

the screen, click Add a 

printer .

 Click Add a network, 

wireless or Bluetooth 

printer.

 In the available printers list 

box, follow your teacher’s 

instructions for selecting a 

printer. Click Next.

 In the Printer name box, 

follow you teacher’s 

instructions for the printer 

name you should key (see 

Figure 3.37).

 Click Next. In the 

confi rmation window, click 

Print a test page (with 

your teacher’s permission). 

Click Finish.

 Follow your teacher’s 

instructions for selecting a 

printer. Right-click the 

printer icon and select Set 

as Default Printer from 

the drop-down menu.

 Your screen 

should look like Figure 3.38.

Continue to the next exercise.

FIGURE 3.37 Printer name window

FIGURE 3.38 New default printer

 Printer set as default
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Step-By-Step EXERCISE 3-18
Share a Printer on a Network
Many networks connect several computers to the same printer. You can connect your 

PC to the printer and share the printer with other users through the network.

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Printer.

 In the Printers window, 

follow your teacher’s 

instructions for selecting a 

printer.

 Right-click the printer icon 

and select Sharing from 

the list.

 In the printer Properties 

dialog box, click Change 

sharing options.

 Your dialog 

box should look like 

Figure 3.39.

 In the User Account 

Control dialog box, click 

Continue.

 Click the Share this 

printer check box.

 In the Share name box, 

follow your teacher’s 

instructions for naming 

the printer.

 Click OK.

Your screen 

should look similar to 

Figure 3.40.

Continue to the next exercise.

FIGURE 3.39 Printer Sharing Options

FIGURE 3.40 Shared printer added

Click to change 
share options

Shared printer Network printer added
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Step-By-Step EXERCISE 3-19
Make Printer Drivers Available for Other 
Operating Systems
When you share a printer on a network, you can not be sure that everyone on the 

network is using the same operating system or computer system that you are. For that 

reason, Vista enables you to install additional drivers for the printer so that other 

users will not have to search for a driver when they connect to the shared printer.

FIGURE 3.41 Printer Properties dialog box

FIGURE 3.42 Additional Drivers dialog box

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Printer.

 In the Printers window, 

right-click the shared 

printer and select Sharing.

 In the printer Properties 

dialog box, click Change 

sharing options (see 

Figure 3.41).

 In the User Account 

Control dialog box, click 

Continue.

 Under Drivers, click 

Additional Drivers.

 Your screen 

should look similar to 

Figure 3.42.

 In the Additional Drivers 

dialog box, follow your 

teacher’s instructions for 

selecting the drivers and 

click OK (see Figure 3.42).

 Click OK.

 Close the Printers 

window.

 Close the Control Panel.

Additional Drivers

New driver to add
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Vocabulary

After You ReadLESSON

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1. You can remove PC cards and USB devices while your computer is running by 
using the   feature. (p. 77)

 2. Programs that were designed for older versions of Windows can be run in 
 . (p. 69)

 3. Use the display settings dialog box to select a(n)  . (p. 80)

 4. A(n)   allows a device to work with your computer’s operating 
system. (p. 75)

 5. You can enable or disable devices in the  . (p. 74)

  Vocabulary Activity

  Practice vocabulary using synchronized folders. In Lesson 2, you learned 
how to synchronize files and folders on a network.

■ Create a Word document that contains the vocabulary words from this 
lesson. Save the document as: terms-[your first initial and last name]. Copy 
it to the Terms folder on your network.

■ Create another Word document that contains only the definitions of the 
vocabulary. Save the document as: definitions-[your first initial and last 
name]. Copy it to the Definitions folder on the network.

■ Make both folders available offline. Disable your network connection and 
open the terms and definitions files of a classmate. Add the definitions to 
the terms file and the terms to the definitions file. Enable your network 
connection and synchronize the files.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. What can you do if an updated driver causes system problems? (p. 76)
A.  Scan the hard disk.
B.  Download an updated driver 

with Windows Update.

C. Nothing.
D. Roll back the driver.

 8. Where would you find out if your hard disk is partitioned? (p. 71)
A.  In the Computer Management 

folder.
B. In the Device Manager.

C.  In the Disk Management 
folder.

D. Windows Explorer.

 9. Where would you set the display’s color depth? (p. 78)
A. Display Settings dialog box
B. Device Manager

C. Appearance and Personalization
D. Monitors folder

Key Terms

compatibility mode

Computer Management

configure

device

Device Manager

Disk Management

display

driver

hard disk

hardware

operating system

PC card

restore point

Safely Remove Hardware

screen resolution

share

software

uninstall

USB device

Academic Vocabulary

available

complex

primary
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Step-By-Step

Practice It ActivitiesLESSON

 Choose Start >All 

Programs>Maintenance. 

Click Backup and 

Restore Center.

 Your screen 

box should look like 

Figure 3.43.

 In the left pane, click 

Create a restore point 

or change settings. Click 

Continue.

 In the System Properties 

dialog box, on the System 

Protection tab, in the 

Available Disks box, 

select the OS (C:) 

(System) drive.

 Your dialog 

box should look similar to 

Figure 3.44. Click Create.

 In the System Protection 

dialog box, key: Second 

Manual Restore Point. Click 

Create. Click OK.

 In the System Properties

dialog box, click OK.

 Close the Backup and 

Restore Center.

 Exit Vista.

 1. Create a Restore Point

Follow the steps to complete the activity.

FIGURE 3.43 Backup and Restore Center

FIGURE 3.44 System Properties dialog box
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Step-By-Step

Practice It ActivitiesLESSON

 2. Confi gure a Program for Compatibility Mode

Follow the steps to complete the activity.

 FIGURE 3.45 Notepad Properties

FIGURE 3.46 Compatibility mode settings

 Start Vista.

 Choose Start >All 

Programs.

 Click Accessories. Select 

Notepad, right-click and 

select Properties.

 Your dialog 

box should look similar to 

Figure 3.45.

 In the program’s 

Properties dialog box, 

click the Compatibility 

tab.

 Under Compatibility 

mode, click the Run this 

program in compatibility 

mode for: check box.

 Click the Compatibility 

mode drop-down arrow 

and select Windows 

2000.

Your dialog 

box should look similar to 

Figure 3.46.

 Click OK.

 Exit Vista.
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Step-By-Step

Practice It ActivitiesLESSON

 Start Vista.

 Click Start  and select 

Control Panel.

 In the Control Panel, click 

Hardware and Sound.

 Click Device Manager.

 Your screen 

should look similar to 

Figure 3.47.

 Right-click the device 

assigned by your teacher 

and select Update Driver 

Software.

 In the Update Driver 

Software dialog box, click 

Search automatically 

for updated driver 

software (see Figure 3.48).

 In the Update Driver 

Software dialog box, click 

Close.

 In the System Settings 

Change dialog box, click 

Yes to restart your 

computer.

 Exit Vista.

 3. Update a Device Driver

Follow the steps to complete the activity.

FIGURE 3.47 Device Manager

FIGURE 3.48 Update Driver Software dialog box
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Step-By-Step

LESSON

 4. Install a Local Printer

Your supervisor often prints sensitive personnel information and does not want 

to send it to the shared printer in the main offi ce. She asks you to install a new 

printer in her offi ce for her computer.

FIGURE 3.49 Choose a printer port window

FIGURE 3.50 Printers folder with new local printer added

 Click Start  and select 

Control Panel. Under 

Hardware and Sound, 

click Printer.

 Click Add a printer . 

Click Add a local printer.

 In the Choose a printer 

port window, ask your 

teacher what port to select.

 Your screen 

should look similar to 

Figure 3.49. Click Next.

 Under Manufacturer and 

Printers, select the 

options designated by 

your teacher. Click Next.

 In the Printer name box, 

key: [your first initial and 

last name] printer two.

 Clear the Set as the 

default printer option and 

click Next.

 With your teacher’s 

permission, click Print a 

test page. Click Finish.

 Your screen 

should look like Figure 3.50.

 Exit Vista.

You Try It Activities
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Step-By-Step

LESSON You Try It Activities

 5. Change the Default Printer

Your supervisor’s default printer is still the printer in the main offi ce area. Change the 

default printer to the one you just installed locally on her computer.

FIGURE 3.51 Start menu

FIGURE 3.52 Printers folder with new default printer

 Click Start . In the 

Start menu, click Printers 

(see Figure 3.51).

 Select the [your first 

initial and last name] 

printer two.

 Right-click the printer icon 

and select Set as Default 

Printer.

Your screen 

should look similar to 

Figure 3.52. 

 Close all open windows. 

Exit Vista. 
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Critical Thinking ActivitiesLESSON

 6. Beyond the Classroom Activity

Language Arts: Personalize Your Display Make your display more 

comfortable for you to use. Using the tools you have learned:

■ Adjust your display resolution to best suit you.

■ Set the display refresh rate to the optimal setting.

■ Adjust the size of the icons to your liking.

Open a Word document and key a paragraph that describes the changes 

you made and why these settings are the best for you. Save the document 

as: v3rev-[your fi rst initial and last name]6.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 3.2 Manage Disks

Size Up Your Hard Disk Find out how much space is available on your 

computer’s hard disk.

Using the skills you have learned, fi nd out:

■ How many hard disks are on your machine.

■ How many volumes each disk has.

■ How much free space is in each volume.

■ What the total amount of free space on the hard disks is.

Open a Word document and create a table with two columns. In the fi rst 

column, enter the above bullet points. In the second column, key the 

answer for each bullet point. Put your name at the top of the document. 

Print this document and give it to your teacher. Save the document as: 

v3rev-[your fi rst initial and last name]7.

 8. 21st Century Skills Activity

Ask Your Computer the Right Questions Some computer applications 

and updates are automatic. Others must be activated by you. Knowing whether 

the hard disk is developing problems or errors is critical, but you will not 

know for certain unless you scan the disk. Otherwise, it might be too late if the 

errors start to interfere with your programs.

Scan a volume (other than your C: drive) of your hard disk for errors. Share 

your results with your teacher. 
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LESSON

 9. Look Ahead  

Language Arts: Manage Space on Your Hard Drive Your manager  

at an online book store uses a particular viewer to read some of his older 

documents. Check to see if there is space on the computer hard disk to 

install the program. (Your teacher will provide the program for you.)

■ Check the program’s properties to see if you can determine the size of 
the program file.

■ Check the free space on the hard disk for the volume that you will 
install the program on (this is usually C:).

■ Install the program by following its installation instructions.

When you are fi nished, open a Word document and key a paragraph 

explaining why managing the size and contents of your hard drive is 

important. Explain what can happen if you try to load a program without 

checking to see if your hard drive has enough free space. Save the document 

as: v3rev-[your fi rst initial and last name]9.

 10. Confi gure Compatibility 

Language Arts: Work in Compatibility Mode While the book store 

has upgraded the computer network to Vista, the viewer itself was designed 

for a previous version of Windows.

Confi gure the program to run in compatibility mode for Windows XP. 

Then, open a Word document and key a paragraph that describes the steps 

you took to confi gure the program to work in compatibility mode. Save the 

document as: v3rev-[your fi rst initial and last name]10.

 11. Set Up Printers  

Language Arts: Install a Network Printer Now that your manager 

has the viewer installed, he needs to connect to a shared printer capable of 

printing the documents.

■ Install a network printer that is provided by your teacher. 

■ Run the program and print a sample document to check the program 
and printer connection. 

Open a Word document and key one or two paragraphs that describes how 

installing additional drivers for a shared network printer might be important 

for business owners and employees. Save the document as: v3rev-[your fi rst 

initial and last name]11.

Challenge Yourself Projects

Plan Ahead Before you 
begin any project in the 
workplace, it is good to 
have a plan. Start off by 
looking at resources and 
options for the project so 
that you can deal with 
problems before they occur. 
These projects teach you 
how to use Vista to 
efficiently manage your 
computer’s hardware and 
software.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. Which is the more effi-
cient – running a pro-
gram in compatibility 
mode or upgrading the 
program?

2. In the long run, which is 
more cost effective? 
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Key Concepts

Manage Files and FoldersLESSON

Organizing your computer fi les and folders is the key to maintaining the 

information on your computer system. Having vital information stored on your 

computer does you no good if you cannot fi nd it. Search functions, backups, 

permissions, and fi le properties all contribute to your computer fi ling system, and 

not using these functions would make you and your computer less effi cient.

Use Good Judgment How would you defi ne good judgment? Showing good 

judgment could be as simple as thinking before you act. It could also mean that 

you carefully review your options and predict what the consequences will be 

before making decisions. Thinking about past mistakes can help you learn how 

to act in a similar situation. For certain activities such as driving, using good 

judgment can even be a life-saving skill. What decision have you made recently that 

showed good judgment?

 Show and hide fi les, folders, 
and information about fi les and 
folders

 Confi gure Windows Explorer 
layouts

 Create, delete, and rename fi les 
and folders

 Confi gure permissions and 
share folders

 Search for fi les and folders and 
fi lter results

 Back up and restore fi les and 
schedule backups

 Copy data to removable media

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in 
the Student Edition for a 
description of the standards 
listed here.

ISTE Standards Correlation

NETS•S

1a, 2a, 2d, 3b, 3c, 4b, 5a, 5b, 
6a, 6c

Microsoft Certified 
Application Specialist 
Standards

Vista

4.1, 4.2, 4.3, 4.4, 4.5, 
4.6, 4.7
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Reading GuideLESSON

Key Terms In order to gain a more complete understanding of the terms you are reading, keep a Key 
Term Journal. Divide a piece of paper into four columns. Label them  Key Term, What is it?, What else is it 
like?, and What are some examples? Write down each term and answer the questions as you read.

Read to Learn

• Learn to manage fi les and folders.
• Become familiar with search techniques.
• Learn to back up and restore data and save it to 

removable media.

Main Idea

Use Vista’s fi le and folder confi guration features to 
organize and archive the data on your computer.

Vocabulary

Key Terms

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

feature
indicate
medium
secure

Quick Write Activity 

Describe Businesses may fi le information by 
categories such as customer name, date, or ID 
number. On a separate sheet of paper, identify three 
types of businesses that might fi le information 
based on an ID number.

Study Skills

Eliminate Distractions Trying to study while 
listening to the radio, watching TV, or performing 
some other task at the same time makes you less 
effective at both efforts. Try to avoid doing anything 
else when you are studying and make that time 
more effective.

Academic Standards

English Language Arts
NCTE 1 Read texts to acquire new information.
NCTE 5 Use different writing process elements to communicate effectively.
NCTE 7 Conduct research and gather, evaluate, and synthesize data to communicate discoveries. 
NCTE 8 Use information resources to gather information and create and communicate knowledge.

Backup and Restore 
 Center
CD
DVD
Favorite Links
fi le extension
fi lter
folder shortcut
folder type
group
hidden fi le

keyword
metadata
permissions
rename
shadow copy
share
sort
stack
virtual folder
wildcard
Windows Explorer

Before You Read
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Step-By-Step EXERCISE 4-1
Show and Hide File Extensions
One of the key tools for fi le management is Windows Explorer. From this window 

you can set the majority of fi le and folder viewing options and navigate to any 

location on your computer to view them. Every fi le has a fi le extension, which is a set 

of characters added to the end of its name to identify its type of format. You can 

choose to show or hide the fi le extensions in the Folder Options dialog box.  

 With your teacher’s help, 

navigate to the data fi les 

folder. Select all of the fi les 

for this lesson. Copy and 

paste them into your 

Documents folder. 

  Choose Start >All 

Programs>Accessories. 

 Select Windows Explorer. 

In the Windows Explorer 

toolbar, click Organize. 

Select Folder and Search 

Options.

 Click the View tab.

 In the Advanced settings 

box, scroll down to Hide 

extensions for known 

file types. Clear the check 

box to show fi le extensions 

(see Figure 4.1).

 Under Folder views, click 

Apply to Folders. In the 

dialog box, click Yes.

 In the Folder Options 

dialog box, click OK. Click 

Close .

 Choose Start >

Documents.

Your screen 

should look like Figure 4.2. 

Click Close .

Continue to the next exercise.

FIGURE 4.1 Folder Options dialog box 

FIGURE 4.2 Files showing file extensions

Clear check box
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Step-By-Step EXERCISE 4-2
Show and Hide Protected 
Operating System Files
As a safety precaution, many operating system fi les will not appear in a folder view.  

Your system might be damaged if these fi les were to be moved or lost. In order to view 

these fi les, you must change the folder settings.

 Click Start >Control 

Panel.

 In the right pane, click 

Appearance and 

Personalization.

 Your screen 

should look like Figure 4.3.

 Click Folder Options.

 In the Folder Options 

dialog box, click the 

View tab.

 In the Advanced settings 

pane, scroll to Hide pro-

tected operating system 

files (Recommended) 

and clear the check box.

 Your screen 

should look like Figure 4.4.

 In the Warning box, 

click Yes.

 Click OK.

Continue to the next exercise.

FIGURE 4.3 Appearance and Personalization window 

FIGURE 4.4 Change folder settings

Folder Options
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Step-By-Step EXERCISE 4-3
Show Hidden Files and Folders
In addition to the operating system folder, other fi les and folders might be hidden. A 

hidden fi le is a fi le that Windows Vista does not display. Hidden fi les and folders 

make windows look less cluttered. They also prevent people from moving or deleting 

them. Use the folder options settings to hide or show a hidden fi le or folder.

FIGURE 4.5 Appearance and Personalization window 

FIGURE 4.6 Protect System files

 Click Start  and select 

Control Panel.

 In the right pane, click 

Appearance and 

Personalization.

 Your screen 

should look like Figure 4.5.

 Under Folder Options

select Show hidden files 

and folders. In the Folder 

Options dialog box, click 

the View tab.

 In the Advanced settings 

pane, under Hidden files 

and folders, select Show 

hidden files and folders.

 Your dialog 

box should look like 

Figure 4.6. Click Apply.

 In the Advanced settings 

pane, click the check box 

in front of Hide protected 

operating system files 

(Recommended).

 Under Hidden files and 

folders, select Do not 

show hidden files and 

folders.

 Click OK.

 In the Appearance and 

Personalization window, 

click Close .

Continue to the next exercise.

Show hidden files 
and folders
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Step-By-Step EXERCISE 4-4 
Confi gure Windows Explorer Layouts
You use Windows Explorer to view most of the fi les and folders on your computer. 

Windows Explorer  can be confi gured to show fi les and folders in different ways. You 

can change the layout to show such things as details or previews of fi les.

FIGURE 4.8 Windows Explorer layout changed 

 Click Start and 

choose All Programs>

Accessories. Select 

Windows Explorer.

 Your screen 

should look similar to 

Figure 4.7.

 On the toolbar, click 

Organize and choose 

Layout>Menu Bar.

 Click Organize and 

choose Layout>Preview 

Pane.

 Click Organize and 

choose Layout>Details 

Pane to close the pane.

 Select Excel file.xlsx in 

the fi le list.

 Your screen 

should look similar to 

Figure 4.8.

 Click Close .

Continue to the next exercise.

FIGURE 4.7 Windows Explorer default layout

Organize folder layouts 

Details pane

Preview of selected 
Excel file 

Details pane hidden

Select a fi le to view the 
most common properties 
associated with the fi le in 
the  Details pane.
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Step-By-Step EXERCISE 4-5
Create a Folder
In order to keep fi les organized on your computer, you should categorize them as 

much as possible. One of the primary ways to organize fi les is to keep the different 

categories of fi les in separate folders. You can create new folders in any location. 

FIGURE 4.9 Windows Explorer 

FIGURE 4.10 Windows Explorer with new folder added

File

 Click Start  and 

choose All Programs>

Accessories>Windows 

Explorer.

 Your screen 

should look similar to 

Figure 4.9.

 In the Menu bar, choose 

File>New>Folder.

 Key: [your first initial and 

last name]-1.

 Press .

 Click Organize and 

choose Layout>

Details Pane.

 Your screen 

should look similar to 

Figure 4.10.

Continue to the next exercise.

Details of new folder

You can also create a new 
folder by right-clicking in an 
open area of the fi le list and 
choosing New>Folder.

New folder
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Step-By-Step EXERCISE 4-6
Rename a Folder
Changing the name of a folder is easy in Microsoft Windows Vista. You should be 

careful when you rename folders, as programs often have stored information in 

specifi c addresses. If you rename the folder in which a program has stored information 

for later use, the program may no longer be able to access that information.

FIGURE 4.11 Windows Explorer with original folder name

FIGURE 4.12 Windows Explorer with renamed folder

Folder renamed

 Click Start  and 

choose All Programs>

Accessories>Windows 

Explorer.

 In the Windows Explorer 

fi le list, select the [your 

first initial and last 

name]-1 folder you created 

in the previous exercise.

 In the Menu bar, click File 

and select Rename.

 Your screen 

should look similar to 

Figure 4.11.

 Press   on your 

keyboard. Press 

 once to 

delete the 1 and key: 2.

 Press .

 Your screen 

should look similar to 

Figure 4.12.

 Click Close .

Continue to the next exercise.

You can also rename a 
folder by right-clicking 
on the folder and selecting 
Rename. You can also 
select the folder and press 

 on your keyboard.

Vista 102Lesson 4: Exercise 4-6



Step-By-Step EXERCISE 4-7
Add a Folder Shortcut to the Start Menu 
To make access to your personal folders faster, you can add a folder shortcut to the Start 

menu. The folder shortcut bypasses the folder path, and takes you directly from the Start 

menu to the folder. Vista will open the Windows Explorer view of the folder.

FIGURE 4.13 Windows Explorer

FIGURE 4.14 Start menu with folder shortcut added

 Click Start  and 

choose All Programs>

Accessories and select 

Windows Explorer.

 Your screen 

should look similar to 

Figure 4.13.

 Click the [your first initial 

and last name]-2 folder. 

 Drag and drop the folder 

onto the Start  button.

 Close Windows Explorer.

 Click Start .

 Your screen 

should look similar to 

Figure 4.14.

 Click Start  to close 

the Start menu.

Continue to the next exercise. 

Drag folder to Start 
menu button on 
desktop Taskbar

Folder added to Start menu

If you use a folder regularly, 
you can also create a 
shortcut for the folder on 
your desktop. Right-click 
the folder and select 
Create Shortcut. Then 
click the shortcut and drag 
it onto the desktop.
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Step-By-Step EXERCISE 4-8
Add Folders to the Favorite Links List
Vista is designed to allow you quick access and navigation through the computer’s 

directory. The Favorite Links list is part of that effort. The list appears in the folder 

views in the Navigation pane under the Favorite Links heading.

FIGURE 4.15 Documents folder

FIGURE 4.16 Folder added to Favorite Links

 Click Start  and select 

Documents.

 Your screen 

should look similar to 

Figure 4.15.

 Click the [your first initial 

and last name]-2 folder.

 Drag and drop the folder in 

a blank area on the 

Favorite Links list in the 

left pane.

 Your screen 

should look similar to 

Figure 4.16.

 Click Close .

Continue to the next exercise.

You may need to resize 
the folder links in the left 
pane in order to have 
room to add the folder to 
your Favorite Links list. 
Move your cursor to the 
top of the Folders label 
until it becomes a double-
headed arrow. Click and 
 drag it down.

Drag folder to left pane 

Folder added to Favorite Links list
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Step-By-Step EXERCISE 4-9
Confi gure the NTFS Permissions 
of a Folder
In addition to hiding folders, you can set permissions for the folders. By changing 

permissions, you prevent others from changing any aspect of a folder. You can set the 

same permissions for a group of users or different permissions for individual users.

 Click Start  and select 

Documents.

 Right-click the [your first 

initial and last name]-2 

folder. Select Properties. 

Click the Security tab.

 Your dialog 

box should look similar to 

Figure 4.17. Click Edit. 

 In the Permissions for 

[your first initial and 

last name]-2 dialog box, 

click Add.

 In the Select Users or 

Groups dialog box, click 

in the Enter the object 

names to select box and 

key: Annie Borden;Third.

 Your dialog 

box should look like 

Figure 4.18.

 Click Check Names. 

Click OK.

Continued on the next page.

FIGURE 4.17 Properties dialog box Security tab

FIGURE 4.18 Select Users or Groups dialog box

No spaces

In Step 6, make sure you 
key the text exactly as 
written: a space between 
“Annie” and “Borden”, no 
spaces between “Borden”, 
“;”, or “Third”. Otherwise 
the system will not recog-
nize the user names.

Click to edit 
permissions
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Step-By-Step EXERCISE 4-9 (Continued)

Confi gure the NTFS Permissions 
of a Folder In the Permissions dialog 

box, under Group or user 

names, select Third 

(MAIN-USER\Third) 

(see Figure 4.19).

 Under Permissions for 

Third, clear the Allow 

check box for Read & 

execute. Click the Allow 

check boxes for List 

folder contents and 

Read. All other check 

boxes should be blank.

 Click Apply. Under Group 

or user names, select 

Annie Borden.

 Under Permissions for 

Annie Borden, click the 

Deny check box for Full 

control. Note that all the 

Deny boxes are checked.

 Click OK.

 In the Windows Security 

dialog box, click Yes.

 Click OK.

 Right-click in an open area 

of the Documents fi le list 

and select Refresh.

Your screen 

should look like Figure 4.20.

 Click Close .

Continue to the next exercise.

FIGURE 4.19 Permissions dialog box

FIGURE 4.20 Documents folder with folder with permissions

Select to change 
permissions

Permissions added 
to folder 
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Step-By-Step EXERCISE 4-10
Set the Folder Type 
The folder type can indicate, or convey, what sort of fi les are saved inside it. You can 

change the type assigned to a folder based on the kind of fi les you want to save in the 

folder. Making folders of different types makes it easier to fi nd your fi les later.

FIGURE 4.21 Documents folder

FIGURE 4.22 Folder Properties dialog box Customize tab

 Click Start  and select 

Documents.

 In the Documents folder 

list, right-click the [your 

first initial and last 

name]-2 folder and 

select Properties 

(see Figure 4.21).

 In the Properties dialog 

box, click the Customize 

tab.

 Under What kind of 

folder do you want?, 

click the folder type 

drop-down arrow and 

select Pictures and 

Videos.

 Your dialog 

box should look like 

Figure 4.22.

 Click OK.

 Click Close .

Continue to the next exercise.

Select Properties

Folder type drop-
down arrow

Even if you customize a 
folder to hold a specifi c 
type of fi le, you can save 
any type of fi le in that 
folder. For example, you 
can save a Word 
document in a Pictures 

and Videos folder.
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Step-By-Step EXERCISE 4-11
Share a Folder on a Hard Disk
You can set up a folder on your hard disk so that other users can share the contents 

of that folder.

 Click Start  and select 

Documents.

 Create a new Documents 

folder called: [your first 

initial and last name]-3.

 Right-click the folder and 

select Properties. Click 

the Sharing tab.

 Your dialog 

box should look similar to 

Figure 4.23.

 Under Network File and 

Folder Sharing, click 

Share.

 In the File Sharing dialog 

box, under Choose 

people to share with, 

click the drop-down arrow 

and select Annie Borden.

 Your screen 

should look like Figure 4.24. 

Click Add.

 Click the drop-down arrow.  

Select Third. Click Add.

 In the user pane under 

Permission Level, click 

the drop-down arrow next 

to the Reader level for 

Third. Select Contributor.

 Click Share. Click 

Continue. Click Done. 

Close both dialog boxes.

Continue to the next exercise.

FIGURE 4.23 Folder Properties Sharing tab

FIGURE 4.24 File Sharing dialog box

Click to add user

Vista 108Lesson 4: Exercise 4-11



Step-By-Step EXERCISE 4-12
Add Permissions to Share for Users
In addition to allowing specifi c people to access the folder, you can set specifi c 

permissions for users that allow them to share fi les and folders. This added level of 

security will help keep your data safe, or secure, and your folders well organized.

FIGURE 4.25 Properties dialog box

FIGURE 4.26 Permissions for folder dialog box

Add

 Click Start  and select 

Documents.

 Right-click the [your first 

initial and last name]-3 

folder and select 

Properties.

 In the folder Properties 

dialog box, click the 

Sharing tab, if necessary. 

Under Advanced 

Sharing, click Advanced 

Sharing (see Figure 4.25).

 In the User Account 

Control dialog box, 

click Continue.

 In the Advanced Sharing 

box, select Share this 

folder.

 Click Permissions.

 Your dialog 

box should look similar to 

Figure 4.26.

 In the Permissions 

for folder dialog box, 

click Add.

Continued on the next page.

Advanced Sharing
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Step-By-Step EXERCISE 4-12 (Continued)

Add Permissions to Share for Users

FIGURE 4.27 Select Users or Groups dialog box

Check Names

FIGURE 4.28 Documents folder with new shared folder

 In the Select Users or 

Groups dialog box, click in 

the Enter the object 

names to select box and 

key: Annie Borden;Third.

 Your dialog 

box should look similar to 

Figure 4.27.

 Click Check Names. 

Click OK.

 In the Permissions for 

dialog box, under Group 

or user names, click 

Third. Under Permissions 

for Third, check the Allow 

box for Full Control.

 Click Apply.

 Under Group or user 

names, select Annie 

Borden. Under Permis-

sions for Annie Borden, 

check the Deny box for 

Full Control.

 Click OK.

 In the Windows Security 

warning box, click Yes.

 Click OK. Click Close.

Your screen 

should look similar to 

Figure 4.28.

 Click Close .

Continue to the next exercise.

New shared folder

The Full Control permission level allows users to see the 
contents of a fi le or folder, make changes to existing fi les and 
folders, create new fi les and folders, and run programs in a folder.
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Step-By-Step EXERCISE 4-13
Search for Files and Folders 
Using a Virtual Folder
Over time, your computer may accumulate more fi les and folders than you can keep 

track of. To keep you from losing valuable information, Vista offers several search features 

to help you fi nd fi les and folders on your computer or on a network. Vista also allows 

you to index the searches so that only the locations that you want are included in your 

search. The most readily available search feature, or function, is the virtual folder, a 

directory that organizes fi les based on their content in order to speed up fi le searches..

FIGURE 4.29 Search folder

FIGURE 4.30 Search folder with tree results

 Click Start  and select 

Documents.

 Right-click the folder [your 

first initial and last 

name]-2 and select 

Properties.

 In the Properties dialog 

box, click Advanced.

 In the Advanced 

Attributes dialog box, 

make sure Index this 

folder for faster 

searching is checked. 

Click OK twice.

 Click Start  and select 

Search.

 Your screen 

should look like Figure 4.29.

 Click in the Search box 

and key: [your first initial 

and last name]-2.

 In the Show only menu, 

click Picture. In the search 

box, key: tree.

Your screen 

should look similar to 

Figure 4.30.

 Click Close .

Continue to the next exercise.

Picture Search box

Picture file search  results
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Step-By-Step EXERCISE 4-14
Search for Files and Folders 
Using Wildcards
If you do not know exactly which fi le or folder name you are looking for, but you 

know part of the fi le or folder name, you can still complete a search. Vista allows you 

to use a character, called a wildcard, to search for partial fi le or folder names. Wildcard 

characters tell Vista that a character or several characters are being left out of the 

search term. Wildcards increase the number of matches in a search.

FIGURE 4.31 Search folder with wildcard character added

FIGURE 4.32 Search folder with new wildcard search

 Click Start  and select 

Search.

 In the search box, key: 

note. Review the search 

results.

 In the search box at the 

end of note, key: ?.

Your screen 

should look similar to 

Figure 4.31.

 In the search box, press 

 to delete 

note?. Key: *.jpg.

 Your screen 

should look similar to 

Figure 4.32.

 Click Close .

Continue to the next exercise.

Wildcard character

The * and the ? are two 
of the most common 
wildcard characters. The * 
stands for any number of 
characters from zero to 
many, and the ? stands for 
one unknown character.

Wildcard character
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Step-By-Step EXERCISE 4-15 
Search for Files and Folders 
Using Keywords 
Each folder has a search box in the upper-right corner that lets you search the contents 

of fi les and folders within the folder. You can search by a keyword. A keyword is a 

word that appears within the fi le or folder’s name or contents, to generate results. 

FIGURE 4.33 Documents folder

FIGURE 4.34 Documents folder with excel keyword search

 Click Start  and select 

Documents.

 Your screen 

should look similar to 

Figure 4.33.

 Click in the Search box 

and key: excel.

Your screen 

should look similar to 

Figure 4.34.

 Click Close .

Continue to the next exercise.

Results of excel search in Documents folder

If you want to search by 
fi le type, key the fi le 
extension. For example, to 
fi nd an MP3 fi le, key MP3. 
For more accurate results, 
key in *.mp3. 
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Step-By-Step EXERCISE 4-16
Redisplay the Results of 
a Previous Search
When you search for a fi le or folder, you might not get the results you want on the 

fi rst try. You might think after the second effort, however, that your fi rst attempt was 

better. If you frequently conduct the same search, you can go back to the previous 

search results instead of having to key the search again.

FIGURE 4.35 Documents folder with list of saved searches displayed

FIGURE 4.36 Search folder with .jpg search

 Click Start  and select 

Search.

 In the Search box, key: 

*.jpg.

 On the toolbar, click Save 

Search.

 In the Save As dialog box, 

click Save. 

 Click Close .

 Click Start  and select 

Documents.

 In the left pane, under 

Favorite Links, click 

Searches.

 Your screen 

should look similar to 

Figure 4.35.

 In the fi le list, double-click 

the .jpg search. Note the 

search results. 

 Your screen 

should look similar to 

Figure 4.36. 

 Click Close .

Continue to the next exercise.

Saved .jpg search
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Step-By-Step EXERCISE 4-17
Filter Results of a Search
Vista’s fi lter functions help you to narrow down the results of your search after you 

have generated your initial results. In the toolbar above the main menu are fi lter 

buttons that divide the results into categories based on the type of fi le returned by 

the search.

 Click Start  and select 

Search.

 In the search box, key: jpg.

 Your screen 

should look similar to 

Figure 4.37. 

 Click Show Advanced 

Search .

 In the Location drop-down 

menu, select Choose 

search locations.

 In the Choose Search 

Locations dialog box, 

under Change selected 

locations, click the 

expansion arrow next to 

Public and check the 

Public Pictures box.

 Click OK. Click Search.

 Click Hide Advanced 

Search .

 In the Show only toolbar, 

click Picture.

Your screen 

should look similar to 

Figure 4.38. Click Close 

.

Continue to the next exercise.

FIGURE 4.37 Search folder searching for .jpg

FIGURE 4.38 Search results for .jpg filtered by picture

Filtered by Picture

Filter buttons

Advanced 
Search
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Step-By-Step EXERCISE 4-18
Change the Way Files Are 
Displayed within Folders
You can set a variety of viewing styles in a folder. You can choose which fi les you see 

and how many details you see about fi les, such as the fi le size, fi le type, and more. You 

also can customize how the fi le icon appears.

 Click Start  and select 

Documents.

 On the toolbar, click 

Organize.

 Choose Layout>Preview 

Pane to close the Preview 

Pane, if necessary.

Your screen 

should look similar to 

Figure 4.39.

 On the toolbar, click the 

More options drop-down 

arrow next to Views  .

 Select Extra Large Icons.

 Your screen 

should look like Figure 4.40.

Continued on the next page.

FIGURE 4.39 Documents folder default view

FIGURE 4.40 Extra Large Icons view

More options arrow

Views button

To see the size of a folder 
in a ScreenTip when you 
rest the mouse pointer 
over the folder, choose 
Organize>Folder and 
Search Options and 
click the View tab. Select 
the Display file size 
informa tion in folder 
tips  check box.
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Step-By-Step EXERCISE 4-18 (Continued)

Change the Way Files Are 
Displayed within Folders 

FIGURE 4.41 Documents folder Medium Icons view

FIGURE 4.42 Documents folder list

 Click the Views More 

options drop-down arrow.

 Select Medium Icons.

 Your screen 

should look like Figure 4.41.

 Click Views  . 

Your screen 

should look like Figure 4.42.

 Click Close .

Continue to the next exercise.

Clicking the Views drop-
down arrow allows you to 
choose a specifi c view 
option. If you click the 
Views button itself, 
Windows Explorer will 
auto matically cycle to the 
next view. As you continue 
to click the button, you 
can cycle through all of 
 the available views.
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Step-By-Step EXERCISE 4-19
Display and Hide File and Folder Details 
There are many levels of information that you can display for your fi les and folders. The 

settings you choose will depend upon how much information you need or want.

 Click Start  and select 

Documents.

 On the toolbar, click 

Views  . Select the 

Details view.

 On the toolbar, click 

View and select 

Choose Details.

 In the Choose Details 

dialog box, in the Details 

pane, clear the Tags check 

box (see Figure 4.43).

 Scroll down the Details 

list and click the 

Attributes check box. 

Click OK.

 Your screen 

should look similar to 

Figure 4.44.

 Click Close  . 

Continue to the next exercise.

FIGURE 4.43 Choose Details dialog box 

FIGURE 4.44 Default folder new details

New detail added

To open every new folder 
in its own folder window, 
choose Organize>Folder 

and Search Options 
and click the General 
tab. Then, click Open 
each folder in its 
own window.
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Step-By-Step EXERCISE 4-20
Group, Stack, and Sort Files by Details
You can group, stack, or sort fi les. Each method is a way of organizing and presenting 

your fi les. You may want to stack, or pile, a collection of related fi les that are organized 

by common fi le properties, such as by fi le name or size. You may want to group 

related fi les by fi le type. You can also sort fi les by the last date they were modifi ed.

FIGURE 4.45 Documents folder grouped by attributes

FIGURE 4.46 Documents folder stacked by name

Double-click

 Click Start  and select 

Documents.

 In the main menu bar, 

click View and choose 

Group By>Attributes.

 Your screen 

should look similar to 

Figure 4.45.

 Click View and choose 

Stack By>Name.

 Your screen 

should look similar to 

Figure 4.46.

Continued on the next page.

Grouping, stacking, and 
sorting are ways of 
organizing data by certain 
criteria. On a separate 
sheet of paper, write down 
which method you would 
use to sort fi le names 
alphabetically. Describe 
the steps you would take 
to do that.
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Step-By-Step EXERCISE 4-20 (Continued)

Group, Stack, and Sort Files by Details

FIGURE 4.47 Stack Q–Z

Back button

FIGURE 4.48 Documents folder sorted by descending size

 In the Documents folder 

list pane, double-click Q–Z.

 Your screen 

should look like Figure 4.47.

 Click Back  twice to go 

back to the view that 

grouped fi les by attributes.

 Click View and choose 

Sort By>Descending.

 Click View and choose 

Sort By>Size.

 Your screen 

should similar to 

Figure 4.48.

 Click Close .

Continue to the next exercise.

File size listed in 
descending order

If you want to see only the 
fi les written by a particular 
person, or author, sort the 
contents of a folder by 
that person’s name. Only 
the fi les that contain that 
name will display.
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Step-By-Step EXERCISE 4-21 
Add Metadata to a File
Metadata is information about a fi le that is included in a fi le’s properties. This 

information can be useful when you are searching for a fi le or when you are deciding 

how to display or categorize your fi les. Metadata can contain personal information, so 

check the metadata before you share the fi le.

FIGURE 4.49 Properties dialog box Details tab

FIGURE 4.50 New information added

 Click Start  and select 

Documents.

 Right-click Word file.docx 

in the fi le list and select 

Properties.

 In the Properties dialog 

box, click the Details tab.

 Under Description, roll 

the mouse pointer over the 

blank area to the right of 

Title (see Figure 4.49). 

Click in the Add a title 

box and key: Books for 

ABA. Press .

 Roll the mouse over the 

blank area to the right of 

Subject and click in the 

box. Key: List of titles to 

sell at American Book-

sellers Association meeting. 

Press .

 Roll the mouse over the 

blank area to the right of 

Comments and click in 

the box. Key: Not all of the 

titles have been entered 

yet. Press .

 Your screen 

should look like Figure 4.50. 

Click OK.

 Click Close .

Continue to the next exercise.

Roll pointer over space 
to open this box
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Step-By-Step EXERCISE 4-22 
Remove Properties and Personal 
Information from a File
Because any property or personal information connected to a fi le can be read by 

anyone who has access to that fi le, Vista offers several functions to remove pieces of 

information that you do not want to share with others.

FIGURE 4.51 Remove Properties dialog box

FIGURE 4.52 Documents folder with new file added 

 Click Start  and select 

Documents.

 Right-click the PowerPoint 

file.pptx file in the fi le list 

and select Properties.

 Click the Details tab. Click 

Remove Properties and 

Personal Information.

 In the Remove 

Properties dialog box, 

make sure the Create a 

copy with all possible 

properties removed 

option is selected (see 

Figure 4.51).

 Click OK. Click OK again.

 Your screen 

should look like Figure 4.52.

 In the Documents folder, 

select PowerPoint file - 

Copy.pptx and note the 

properties listed in the 

details pane.

 Click Close . 

Continue to the next exercise.

New file added

File properties

In the Remove Properties 

dialog box, note that you 
can also remove individual 
properties from the fi le.
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Step-By-Step EXERCISE 4-23
Create, Rename, Move and Delete Files 
Vista allows you to create new fi les for various applications simply by right-clicking. 

For example, you can create a new Word fi le without even opening the Word 

application. You can also delete, move, or rename fi les to suit your needs.

FIGURE 4.53 Documents folder new document

FIGURE 4.54 Documents folder renamed document

 Click Start  and select 

Documents.

 Right-click in an open area 

of the fi le list and choose 

New>Microsoft Office 

Word Document. 

Press .

 Your screen 

should look similar to 

Figure 4.53.

 In the Menu bar, click File 

and select Rename.

 Key: Word file 2 (see 

Figure 4.54). Press .

Continued on the next page.

New Word file renamed

New Word file added

Edit

If you give several fi les of 
the same type the same 
name and then need to 
rename them, you can 
rename all the fi les at 
once. Select the fi les you 
want to rename, right-click 
the fi les, and then click 
Rename. Each fi le will 
have the same name, 
followed by a different 
sequential number. For 
example, Document  (2), 
Document (3), and so on. 
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Step-By-Step EXERCISE 4-23 (Continued)

Create, Rename, Move, and Delete Files

FIGURE 4.55 Move Items dialog box

FIGURE 4.56 File moved to Downloads folder

 In the Menu bar, click Edit 

and select Move to 

folder.

 In the Move Items dialog 

box, choose [your user 

name]>Downloads. Click 

Move (see Figure 4.55).

 In the left pane, under 

Folders, click the 

Downloads folder.

 Your screen 

should look like Figure 4.56.

 Right-click Word file 

 2.docx and select Delete. 

In the confi rmation box, 

click Yes.

 Click Close .

Continue to the next exercise.

To move a consecutive 
group of fi les or folders, 
click the fi rst item, hold 
down , and click the 
last item. Click Edit in the 
Menu bar and select 
Move to folder.
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Step-By-Step EXERCISE 4-24
Copy Data Files to a CD or DVD
You can save your fi les to the hard disk or network drives, or you can save them to a 

removable medium, or format, like a CD or a DVD.  Saving data to a removable 

medium ensures a higher level of security for your data. It can protect your privacy 

and protect the data if the computer hardware fails.

 Open your computer’s disc 

drive and insert a CD or 

DVD. Close the drive.

 In the AutoPlay dialog 

box, click Burn files to 

disc (see Figure 4.57).

 In the Burn a Disc dialog 

box, in the Disc title box, 

key: [your first initial and 

last name]. Click Next.

 Your screen 

should look similar to 

Figure 4.58.

 In the left pane, under 

Folders, expand the Main 

User folder and select the 

Documents folder.

 Hold down  and click 

all the fi les in the folder.

 In the Menu bar, click 

File and choose Send 

To>[your CD/DVD 

drive].

Continued on the next page.

FIGURE 4.57 AutoPlay dialog box

FIGURE 4.58 CD/DVD drive folder

Disc title

Expand this folder and 
select Documents

The word medium as it is 
used here, refers to an 
individual method of 
distributing information. 
You may recognize it better 
in its plural form, media.

Vista 125Lesson 4: Exercise 4-24



Step-By-Step EXERCISE 4-24 (Continued)

Copy Data Files to a CD or DVD 
 In the drive folder, click File

and select Close session 

(see Figure 4.59).

 Close the drive folder view 

by clicking Close .

 In the left pane, under 

Folders, select [your CD/

DVD drive].

 Your screen 

should look similar to 

Figure 4.60.

 Click Close .

 Eject your disc from the 

computer’s disc drive and 

turn it in to your teacher.

Continue to the next exercise.

FIGURE 4.59 CD/DVD drive folder

FIGURE 4.60 Files added to CD/DVD drive folder

Close session

Files sent from Documents folder

CD/DVD drive

When you copy fi les to a 
writeable disc, the process 
is known as burning a 
disc. Burning your data to 
a disc is also useful for 
storing, archiving, and 
sharing fi les among 
different computers.
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Step-By-Step EXERCISE 4-25
Back Up Files and Folders
To make sure you do not lose valuable data if your computer hardware or software is 

damaged or malfunctions, you should regularly back up your data. Vista has functions 

that make backing up fi les easier. You can choose to back up only some information 

without backing up all data.

FIGURE 4.61 Backup and Restore Center

FIGURE 4.62 Back Up Files wizard

 Click Start  and select 

Control Panel.

 In the Control Panel, 

click System and 

Maintenance.

 Click Backup and 

Restore Center.

Your screen 

should look like Figure 4.61.

 Under Back up files or 

your entire computer, 

click Back up files.

 In the User Account 

Control dialog box, click 

Continue.

 In the Back Up Files 

wizard, select On a hard 

disk, CD, or DVD. In the 

drop-down list, select the 

option assigned by your 

teacher. Click Next.

 Under Which file types 

do you want to back up, 

clear all the check boxes 

except Documents. 

 Your 

screen should look like 

Figure 4.62. Click Next.

 Click Save settings and 

start backup. In the 

confi rmation box, click 

Close .

Continue to the next exercise.
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Step-By-Step EXERCISE 4-26
Schedule Backups
You can set up your system to perform automatic backups. Automatic backups allow 

you to reset your system to an earlier period, called a restore point, if your system is 

damaged. You can schedule regular backups in the Backup and Restore Center.

FIGURE 4.64 Back Up Files wizard 

 Click Start  and select 

Control Panel.

 In the Control Panel, 

click System and 

Maintenance. Click 

Backup and Restore 

Center.

 Under Back up files or 

your entire computer, 

click Change settings.

 Your screen 

should look like Figure 4.63.

 Click Change backup 

settings.

 In the User Account 

Control dialog box, click 

Continue. Click Next 

three times.

 Under How often do you 

want to create a back-

up?, make sure How 

often is set to Weekly.

 Click the What day drop-

down arrow and select 

Sunday. Click the What 

time drop-down arrow 

and select 12:00 AM 

(midnight).

Your wizard 

should look like Figure 4.64.

 Click Save settings and 

exit. Click Close .

Continue to the next exercise.

FIGURE 4.63 Backup Status and Configuration window

Change backup 
settings
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Step-By-Step EXERCISE 4-27
Restore Files and Folders from a 
Backup File 
Once you have backed up your fi les, you can restore them at any time using the Backup 

and Restore Center. You can restore fi les to the most recent backup, or you can restore 

fi les based on a previous restore point or backup. 

FIGURE 4.65 Add files to restore folder

FIGURE 4.66 Copy File dialog box

 Click Start  and select 

Control Panel. 

 Click Backup and 

Restore Center.

 Under Restore files or 

your entire computer, 

click Restore files.

 In the Restore Files

window, select Files from 

the latest backup and 

click Next.

 In the Select the files 

and folders to restore 

screen, click Add files.

 In the Add files to 

restore folder, hold  

and select all the fi les.

 Your screen 

should look similar to 

Figure 4.65.

 Click Add. Click Next. 

Click Start restore.

 In the Copy File dialog 

box, click the Do this for 

all conflicts check box. 

Select Copy, but keep 

both files.

Your screen 

should look similar to 

Figure 4.66.

 Click Finish. Click 

Close .

Continue to the next exercise.

Click here
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Step-By-Step EXERCISE 4-28 
Restore a Previous Version of a File
You do not always have to use the Backup and Restore Center to view a previous 

version of a fi le. You can retrieve a previous version of a fi le while viewing it in a 

folder, using either a backup copy, or a shadow copy, which is created by your 

computer and saved locally when the system protection is turned on.

FIGURE 4.67 Properties dialog box file versions

FIGURE 4.68 Previous Versions dialog box

Most recent Shadow copy

 Click Start  and select 

Documents.

 In the fi le list, select Word 

file.docx. Right-click the 

fi le and select Restore 

previous versions.

 Your dialog 

 box should look like 

Figure 4.67.

 In the Properties dialog 

box, under File versions, 

select the most recent 

Shadow copy of the fi le 

and click Restore.

 Your dialog 

 box should look like 

Figure 4.68.

 In the Previous Versions 

dialog box, select Restore.

 I n the Properties dialog 

box, click OK.

 Click Close .

Restore

Only one version of a fi le is 
saved as a shadow copy. 
If you modify a fi le more 
than once in a day, only 
the version that was 
current when the restore 
point was made is saved 
as a shadow copy.
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Vocabulary

After You ReadLESSON

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1. A DVD is an example of a removable  . (p. 125)

 2. A(n)   is a character that can be used to represent any number 
or letter in a search. (p. 112)

 3. You can use a   to navigate directly to a specific folder from 
the Start menu. (p. 103)

 4. You can restore individual files using backup copies or a  . 
(p. 130)

 5. You can determine who has access to your shared folders by setting 
 . (p. 105)

  Vocabulary Activity

 6. Practice vocabulary by sharing folders.

  Create a folder labeled Vocabulary on your hard disk and set it to be a shared 
folder.

■ Set the permissions on the folder to allow only the classmate assigned by 
your teacher.

■ Within the shared folder, create and name a folder for each vocabulary 
word.

■ Navigate to your assigned classmate’s shared folder. Within each folder, 
create a Word file named for the vocabulary word on the folder and key 
the definition for the word in the file.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. What is metadata? (p. 121)
A.  Secret information embedded in 

a file.
B.  Information added to the 

properties of a file.

C.  Information about a file’s 
address.

D.  Your name and personal 
information.

 8. What is the folder called that displays your search results? (p. 111)
A.  A shared folder
B.  A Boolean operator

C. A virtual folder
D. A Search folder

 9. Which of the following are file extensions? (p. 97)
A.  Documents/Music files/Picture 

files/Video files
B.  .jpg/.mov/.mpg/.accdb

C. Documents/Music/Photos/Data
D. Documents/Pictures and Videos/ 

Music Details/Music icons

Key Terms

Backup and Restore Center

CD

DVD

Favorite Links

file extension

file icon

filter

folder shortcut

folder type

group

hidden file

keyword

metadata

permissions

rename

shadow copy

share

sort

stack

virtual folder

wildcard

Windows Explorer

Academic Vocabulary

feature

indicate

medium

secure
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Step-By-Step

Practice It ActivitiesLESSON

 1. Show and Hide File Extensions

Follow the steps to complete the activity.

FIGURE 4.69 Windows Explorer

FIGURE 4.70 Folder Options dialog box

 Choose Start >All 

Programs>Accessories. 

Select Windows 

Explorer.

 Your screen 

should look similar to 

Figure 4.69.

 In the Windows Explorer 

toolbar, click Organize and 

select Folder and Search 

Options.

 In the Folder Options 

dialog box, click the 

View tab.

 In the Advanced Settings 

box, select the Hide 

extensions for known 

file types check box.

 Your dialog 

 box should look like 

Figure 4.70.

 In the Folder views area, 

click Apply to Folders.

 In the Folder views

confi rmation dialog box, 

click Yes.

 In the Folder Options

dialog box, click OK. Click 

Close . Exit Vista.
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Step-By-Step

Practice It ActivitiesLESSON

 2. Change the Way Files Are Displayed within Folders

Follow the steps to complete the activity.

FIGURE 4.71 Documents folder default view

FIGURE 4.72 Documents folder Medium Icons

 Click Start  and select 

Documents.

 On the toolbar click 

Organize and choose 

Layout>Preview Pane.

 Your screen 

should look similar to 

Figure 4.71.

 On the toolbar, click the 

Views More options 

drop-down menu and 

select Medium Icons.

 Your screen 

should look similar to 

Figure 4.72.

 Click the Views More 

options arrow and select 

Details.

 Close the Preview pane.

 Click Close .

 Exit Vista.
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Step-By-Step

Practice It ActivitiesLESSON

 3. Group, Stack, and Sort Files

Follow the steps to complete the activity.

FIGURE 4.73 Stack Q–Z

FIGURE 4.74 Documents folder sorted by descending size

Back button

 Click Start  and select 

Documents.

 In the main menu, click 

View and choose Group 

By>Attributes.

 Click View and choose 

Stack By>Name.

 In the Documents folder 

list pane, double-click Q–Z.

 Your screen 

should look similar to 

Figure 4.73.

 Click Back  twice.

 In the Menu bar, click 

View and choose Sort 

By>Descending.

 Click View and choose 

Sort By>Size.

Your screen 

should look similar to 

Figure 4.74.

 Click Close .

 Exit Vista.
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Step-By-Step

LESSON

 4.  Remove Properties and Personal 
Information from a File 

Your supervisor wants you to send a database to the company accountant for a 

preliminary audit, but he wants to remove any identifying information from the 

fi le. Use the Remove Properties function before sending the fi le.

FIGURE 4.75 Remove Properties dialog box 

FIGURE 4.76 Documents folder with new file added

 Click Start  and select 

Documents.

 Right-click Word file.docx 

in the fi le list and select 

Properties.

 Click the Details tab. Click 

Remove Properties and 

Personal Information.

 In the Remove 

Properties dialog box, 

make sure the Create a 

copy with all possible 

properties removed 

option is selected. 

Click OK.

 Your screen 

should look like Figure 4.75.

 In the Properties dialog 

box, click OK.

 Your screen 

should look similar to 

Figure 4.76. 

 In the Documents folder, 

select the Word file – 

Copy.docx fi le and note 

the properties listed in the 

details pane.

 Click Close .

 Exit Vista.

You Try It Activities
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Step-By-Step

LESSON You Try It Activities

 5. Copy Data Files to a CD or DVD 

The accountancy fi rm does not accept database information via e-mail, so you will 

have to save the fi le to a different medium and send it via standard mail. You decide to 

burn the information to a CD or DVD.

FIGURE 4.77 AutoPlay dialog box

FIGURE 4.78 CD/DVD drive folder with file added 

 Open your computer’s disc 

drive and insert a CD or 

DVD. Close the drive.

 Select Burn files to disc.

Your screen 

should look like Figure 4.77.

 In the Disc title box, key: 

[your first initial and last 

name]-5. Click Next.

 Under Folders, expand the 

Main User folder and 

select the Documents 

folder. Select Access 

file.accdb.

 In the main menu, click File 

and select Send To>

[your CD/DVD drive].

 In the drive folder, click File 

and select Close session. 

Close the drive folder.

 In the Documents folder, 

under Folders, select 

[your CD/DVD drive].

 Your screen 

should look like Figure 4.78.

 Click Close . 

Remove the disc from the 

drive and turn it in to your 

teacher. Exit Vista.
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Critical Thinking ActivitiesLESSON

 6. Beyond the Classroom Activity

Language Arts: Back Up Files By now you have created several fi les 

for this lesson and your work in the previous lessons. Using the skills you 

learned in this lesson, back up all the fi les you have created on your 

computer so far. Back up this information to a network location or to a CD 

or DVD, depending upon the option your teacher assigns. 

Save the backup fi les in a single folder named: v4rev-[your fi rst initial and 

last name]6. When you are fi nished, open a Word document and key a 

paragraph that describes why you should back up the fi les on your computer 

on a regular basis. Share your paragraph with the class.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 4.2.4 Add a folder shortcut to the Start menu

Shortcut to Vocabulary Using the skills you have learned in this lesson, 

create a shortcut to the Vocabulary shared folder you created in this lesson’s 

Vocabulary Activity. Put the shortcut to the shared folder on the Start menu 

so that you can quickly access the Vocabulary folder.

When you are fi nished, open a Word document and key a paragraph that 

describes why customizing your Start menu can help you to complete your 

tasks in a more effi cient manner. Key another paragraph that describes how 

to remove a folder shortcut from the Start menu. Save your fi le as: v4rev-

[your fi rst initial and last name]7. Share your paragraph with the class.

 8. 21st Century Skills Activity

Use Good Judgment for Security Often, keeping your computer secure 

is a matter of good judgment. Allowing the wrong people or resources to 

access your computer could lead to its security being compromised.

Using the skills you have learned in this lesson, create a shared folder 

named: v4rev-[your fi rst initial and last name]8. Set the permissions on this 

folder to include your teacher and a group of classmates assigned by your 

teacher. Give your teacher full, unrestricted access. Give the group of 

students access only to view the contents of the folder. 

Open a Word document and key a paragraph that describes what a user can 

do if he or she has Full control permissions to a fi le or folder. Save the fi le 

as: v4rev-[your fi rst initial and last name]8. 
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LESSON

9. Back Up Your Data

Language Arts: Protect Files Your supervisor wants to have backups 

made of the company’s business fi les each week. Schedule an automatic 

backup to run every Saturday morning to back up the fi les in your 

Documents folder. Set the fi les to be backed up to the network location 

specifi ed by your teacher in a folder named: v4rev-[your fi rst initial and 

last name]9.

Open a Word document and list three examples of commonly used folders 

that a business might want to backup. Then, key a paragraph that describes 

how making backups for commonly used folders can protect your company 

from losing important data. Share your ideas with the class.

 10. Set Permissions

Language Arts: Restrict Access to a Folder While you want backups 

to be readily available in order to preserve your business data fi les, you do 

not want just anyone to have access to your corporate information. Set the 

v4rev-[your fi rst initial and last name]9 folder you created above to have 

permissions only for your teacher. 

Open a Word document and key a paragraph that describes how setting 

permissions on fi les and folders can help protect your document against 

unwanted changes and comments. Identify three types of information a 

business might want to restrict access to in order for the business to 

remain successful.

Save your fi le as: v4rev-[your fi rst initial and last name]10.

 11. Hide Files

Language Arts: Control Files As a further security measure for the 

fi les, make the fi les within the v4rev-[your fi rst initial and last name]9

folder hidden fi les to protect them from accidentally being moved or 

deleted. Change your settings in Windows Explorer so that you can view 

hidden fi les.

Open a Word document and key a paragraph that explains why is it 

important to ensure that you are the only one that has the control, or 

power, to view hidden fi les. 

Save your fi le as: v4rev-[your fi rst initial and last name]11.

Challenge Yourself Projects

Always Make Copies  
Backing up your data is one of  
the most important tasks you 
can perform to ensure the 
security of your information. 
These projects teach you how 
to use the backup techniques 
you have learned so that you 
have an effective backup 
strategy.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. Why is it important to 
save information such as 
memos, mail, and other 
important documents?

2. What methods should 
you use to protect and 
back up information that 
is not stored on your 
computer? 
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Key Concepts

Customize Windows VistaLESSON

Customizing your computer’s work area and desktop is similar to organizing 

your desk at home or at work. Having a comfortable and uncluttered workspace 

allows you to keep track of everything you need to complete your work. The skills 

you will learn in this lesson will help you to maximize your effi ciency by showing 

you how to adjust Vista’s settings.

Promote Accessibility Everyone is unique, and our uniqueness allows us to 

appreciate our differences. In order for workers to perform at the top of their 

abilities, they need to have easy access to everything they require to do their jobs.  

A person who is visually impaired may need to adjust the settings on his or her 

computer. A person with a condition that affects his or her motor skills and 

coordination may need to adjust the speed and sensitivity of equipment, such as 

a mouse. What are three valuable resources that you have access to at school or in 

the workplace? What would happen if you did not have access to these resources?

 Customize the Start menu

 Confi gure programs to start 
automatically

 Add toolbars to the Taskbar

 Move, hide, and customize the 
Taskbar and Notifi cation area

 Change the appearance of your 
computer and arrange desktop 
icons

 Change the sound, screen saver, 
and mouse settings

 Confi gure Windows Sidebar 
and download and install new 
gadgets

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in 
the Student Edition for a 
descrip tion of the standards 
listed here.

ISTE Standards Correlation

NETS•S

1a, 2a, 2d, 3b, 3c, 4b, 5a, 5b, 
6a, 6c

Microsoft Certified 
Application Specialist 
Standards

Vista

6.1, 6.2, 6.3, 6.4 
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Reading GuideLESSON

Watch Your Speed Sometimes we read so fast that we do not take enough time to understand what we 
are reading. To better learn diffi cult concepts, slow down when you have trouble understanding. Take a 
moment to reread anything that you do not completely comprehend.

Read to Learn

• Learn to optimize the Start menu and Taskbar to 
make tools and programs more accessible.

• Practice how to change the settings for your 
computer’s sound, mouse, and screen saver.

• Learn to confi gure Windows Sidebar and 
download and install new gadgets. 

Main Idea

Learn how to adapt Windows Vista to best suit your 
needs and improve your effi ciency.

Vocabulary

Key Terms 

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

associate
method

Quick Write Activity 

Describe On a separate sheet of paper, list three 
tools on the Vista desktop that you use frequently.  
Write one or two sentences about how these tools 
could be even more useful.

Study Skills

Double-Check Your Work Review the papers you 
prepare for school or work to ensure that all 
questions are answered and relevant. Double-
checking your work could be a big step toward 
improving your grades.

Academic Standards

English Language Arts
NCTE 3 Apply strategies to interpret texts.
NCTE 4 Use written language to communicate effectively.
NCTE 5 Use different writing process elements to communicate effectively.
NCTE 7 Conduct research and gather, evaluate, and synthesize data to communicate discoveries.

 Math
NCTM (Measurement) Apply appropriate techniques, tools, and formulas to determine measurements.

gadget
mouse pointer
Notifi cation area
pin

Quick Launch toolbar
Start menu
Startup folder
Windows Sidebar

Before You Read
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Step-By-Step EXERCISE 5-1
Customize the Start Menu
Windows Vista allows you to customize many of its functions. One of the easiest ways 

to make Vista more effi cient is to make the Start menu fi t your needs. The primary 

way you can do this is by using the Customize the Start menu function. This tool 

allows you to adjust what items appear in the Start menu.

 Click Start  and select 

Control Panel.

 In the Control Panel win-

dow, select Appearance 

and Personalization.

 Your screen 

should look like Figure 5.1.

 Under Taskbar and Start 

Menu, click Customize 

the Start menu.

 In the Taskbar and Start 

Menu Properties dialog 

box, be sure the Start 

menu is selected. 

 Your screen 

should look like Figure 5.2. 

 Click Customize.

Continued on the next page.

FIGURE 5.1 Appearance and Personalization window

FIGURE 5.2 Taskbar and Start Menu Properties dialog box 

Customize the 
Start menu

Select Start menu

If you are unsure what a 
program in the Start menu 
does, move the mouse 
pointer over its icon or 
name. A ScreenTip will 
appear that displays 
information about the  
program.
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Step-By-Step EXERCISE 5-1 (Continued)

Customize the Start Menu
 In the Customize Start 

Menu dialog box, scroll 

down to Music and click 

Display as a menu (see 

Figure 5.3).

 Scroll down and select 

the Printers check box. 

Click OK.

 In the Taskbar and Start 

Menu Properties dialog 

box, click OK.

 Close the Appearance 

and Personalization 

window.

 Click Start .

 Your screen 

should look like Figure 5.4. 

 Click Start  again to 

close the Start menu.

Continue to the next exercise.

FIGURE 5.3 Customize Start Menu dialog box

FIGURE 5.4 Start menu customized

Music

Printers added to 
Start menu

You also can access the 
Taskbar and Start Menu 

Properties dialog box by 
right-clicking the Taskbar, 
choosing Properties, 
and clicking the Start 

Menu tab.

Music added to 
Start menu
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Step-By-Step EXERCISE 5-2
Pin and Unpin Items in the Start Menu
You can also customize your Start menu to include shortcuts to the programs you use 

most often. You can pin these programs to the Start menu, which makes them appear 

on the Start menu. A pinned program is available on the Start menu at all times.

FIGURE 5.5 Pinning Calculator to Start menu

FIGURE 5.6 Unpinning Calculator from Start menu

Calculator

 Click Start  and 

choose All Programs>

Accessories.

 Right-click Calculator and 

select Pin to Start Menu 

(see Figure 5.5).

 In the Start menu, click 

Back.

 Your screen 

should look like Figure 5.6.

 Right-click Calculator in 

the Start menu and select 

Unpin from Start Menu.

 Click Start .

Continue to the next exercise.

Pin to Start Menu

Back 

Many computer terms, 
such as pin, are meta-
phors. You pin a program 
that you want to make 
easily accessible to the 
Start menu much as you 
would pin a list of phone 
numbers to a bulletin board 
near your phone. Make a 
list of computer terms that 
are also meta phors for 
other common items.
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Step-By-Step EXERCISE 5-3
Confi gure a Program to Start Automatically
If there are programs you always use when you turn on your computer, you can set up 

those programs to start automatically when Windows Vista starts. Placing the shortcuts 

of programs onto the Startup folder makes them run automatically when Vista starts.

FIGURE 5.8 Startup folder with Notepad added

 Click Start  and select 

All Programs.

 Right-click the Startup 

folder and select Open.

 In the left pane under 

Folders, navigate to the 

Accessories folder and 

select it.

 In the Accessories folder 

pane, right-click on the 

Notepad icon and select 

Create Shortcut.

 Click and drag the shortcut 

to the Startup folder (see 

Figure 5.7).

 Under Folders, click the 

Startup folder.

 Your screen 

should look like Figure 5.8.

 Click Close .

Continue to the next exercise.

FIGURE 5.7 Drag Notepad onto Startup folder

Drag new shortcut to this folder

The next time you start 
Windows Vista, the 
Notepad program will start 
automatically. If you do not 
want this program to run 
automatically, open the 
Startup folder and delete 
the Notepad shortcut. Be 
careful not to remove any 
other programs or program 
shortcuts in the Startup 
folder.
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Step-By-Step EXERCISE 5-4
Display the Quick Launch Toolbar
on the Taskbar
The Quick Launch toolbar allows you to quickly start your most frequently used 

programs. The Quick Launch toolbar is displayed on the Vista Taskbar. You can 

modify the Quick Launch toolbar to contain shortcuts to any programs you desire.

FIGURE 5.9 Taskbar and Start Menu Properties dialog box

FIGURE 5.10 Quick Launch toolbar in Vista Taskbar 

 Click Start  and select 

Control Panel.

 Click Appearance and 

Personalization.

 Click Taskbar and Start 

Menu.

 In the Taskbar and Start 

Menu Properties dialog 

box, click the Taskbar tab. 

Click the Show Quick 

Launch check box.

 Your dialog 

box should look similar to 

Figure 5.9.

 Click OK.

 In the Appearance and 

Personalization folder, 

click Close .

 Your screen 

should look similar to 

Figure 5.10.

Continue to the next exercise.

Show Quick Launch

Quick Launch toolbar on Taskbar

You can open the Quick 

Launch toolbar—or any 
other toolbar—from the 
Taskbar by right-clicking 
an open area of the 
Taskbar and choosing 
Toolbars>Quick Launch.
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Step-By-Step EXERCISE 5-5
Add a Toolbar to the Taskbar
The Vista Taskbar can display several different types of toolbars in addition to the 

Quick Launch toolbar. These toolbars can be opened from the Taskbar and Start 

Menu Properties dialog box, accessed through the Control Panel, or by right-clicking 

the Taskbar itself.

 Click Start  and select 

Control Panel.

 Select Appearance and 

Personalization.

 Click Taskbar and Start 

Menu.

 In the Taskbar and 

Start Menu Properties

dialog box, click the 

Toolbars tab.

 Click the Desktop check 

box.

 Your screen 

should look similar to 

Figure 5.11.

 Click OK.

 Close the Appearance 

and Personalization 

window.

 On the Taskbar, to the 

right of the Desktop

toolbar label, click the 

double right-arrow .

Your screen 

should look similar to 

Figure 5.12.

 Click the double right-arrow 

again to close the toolbar 

menu.

Continue to the next exercise.

FIGURE 5.11 Taskbar and Start Menu Properties dialog box Toolbars tab

FIGURE 5.12 Desktop toolbar menu

Desktop Toolbar
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Step-By-Step EXERCISE 5-6
Move and Hide the Taskbar
While the Taskbar serves many useful purposes, it does take up space at the bottom 

of your screen. You can move the Taskbar to another part of the desktop or even hide 

it when you want to use all of the screen area.

FIGURE 5.13 Desktop with Taskbar at bottom

Click and hold Taskbar 
and drag to right side

FIGURE 5.14 Taskbar at right side of screen

 Click in a blank area on the 

Taskbar, and drag the 

Taskbar up and to the 

right side of the screen 

(see Figure 5.13).

 Release the mouse button.

 Your screen 

should look similar to 

Figure 5.14.

 Click Start  to view the 

Start menu.

 Click Start  to close 

the menu.

 Right-click on a blank area 

of the Taskbar and select 

Properties.

Continued on the next page. 

Be careful to not clutter the 
desktop. You can improve 
your computer’s perfor-
mance and fi nd fi les and 
folders more easily if you 
store them in the 
Documents folder rather 
than on the desktop.
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Step-By-Step EXERCISE 5-6 (Continued)

Move and Hide the Taskbar

FIGURE 5.15 Taskbar and Start Menu Properties dialog box

FIGURE 5.16 Taskbar hidden

 In the Taskbar and Start 

Menu Properties dialog 

box, on the Taskbar tab, 

check the Auto-hide the 

taskbar box.

 Your screen 

should look similar to 

Figure 5.15. Click OK.

Your screen 

should look similar to 

Figure 5.16.

 Move your mouse pointer 

all the way to the right side 

of the screen to display the 

Taskbar. Drag the 

Taskbar back to the 

bottom of the screen.

 Right-click the Taskbar 

and select Properties.

 In the Taskbar and Start 

Menu Properties dialog 

box, clear the Auto-hide 

the taskbar check box 

and click OK.

Continue to the next exercise.

You can only move the 
Taskbar if it is not locked. 
To lock and unlock the 
Taskbar, right-click in a 
blank area on the Taskbar 
and select Lock the 

Taskbar.
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Step-By-Step EXERCISE 5-7
Customize the Notifi cation Area
The Notifi cation area is on the right side of the Taskbar. It displays the icons for some 

services, applications, and the computer’s clock. You can customize the Notifi cation 

area just as you can customize the rest of the Taskbar.

 Right-click a blank area on 

the Taskbar and select 

Properties.

 In the Taskbar and Start 

Menu Properties dialog 

box, click the Notification 

Area tab.

 Under Icons, check the 

Hide inactive icons box, 

if necessary.

 Your dialog 

box should look similar to 

Figure 5.17.

 Click Customize.

 In the Customize 

Notification Icons dialog 

box, click Windows 

Sidebar. In the Behavior 

column, click the drop-

down arrow and select 

Show (see Figure 5.18).

 Click OK. In the Taskbar 

and Start Menu 

Properties box, click OK.

Continue to the next exercise.

FIGURE 5.17 Taskbar and Start Menu Properties dialog box

FIGURE 5.18 Customize Notification Icons dialog box

Click to 
show drop-
down menu
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Step-By-Step EXERCISE 5-8
Change the Appearance of a Computer
Vista contains functions that allow you to change specifi c aspects of your computer’s 

appearance, like the Start menu or Taskbar. It also has functions that allow you to 

change the overall appearance of the desktop. For example, you can change the colors 

and font styles in active and inactive windows and dialog boxes.

 Right-click in an open area 

of the desktop and select 

Personalize from the 

drop-down menu.

 Click Window Color and 

Appearance. Under 

Window Color and 

Appearance, click Open 

classic appearance 

properties for more 

color options.

 In the Appearance 

Settings dialog box, under 

Color scheme, select 

Windows Standard.

 Your dialog 

box should look like 

Figure 5.19. Click Apply.

  Your screen 

should look similar to 

Figure 5.20.

 Select the previous setting. 

Click OK.

 Click Close .

Continue to the next exercise.

FIGURE 5.19 Appearance Settings dialog box 

FIGURE 5.20 Windows Standard appearance

In Step 3, note your com-
puter’s Color scheme 
setting before you change 
it to Windows Standard. 
You can see a preview by 
clicking on each Color 

scheme.  

Dialog box in Windows 
Standard color scheme

Taskbar in Windows 
Standard color scheme
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Step-By-Step EXERCISE 5-9
Arrange Desktop Icons
You can arrange program and folder icons on your desktop to best suit your needs, or 

you can let Vista arrange the icons for you using a method, or system, you choose. 

You can have the icons sorted by such details as name or type, or you can have them 

aligned to a grid or arranged automatically.

 Right-click in an open area 

of the desktop.

 In the drop-down menu, 

choose View>Auto 

Arrange (see Figure 5.21) 

to have Windows arrange 

the desktop icons 

automatically.

 Right-click in an open area 

of the desktop and choose 

Sort By>Name.

 Your screen 

should look similar to 

Figure 5.22.

 Right-click in an open area 

of the desktop and choose 

View>Auto Arrange to 

deselect the Auto 

Arrange feature.

 If necessary, arrange the 

desktop icons back to the 

way you prefer.

Continue to the next exercise. 

FIGURE 5.21 Desktop drop-down menu 

FIGURE 5.22 Desktop icons sorted by type 

Auto Arrange  
desktop  

Right-click desktop for 
drop-down menu

You can also sort your 
desktop icons by fi le size 
or the last date they were 
modifi ed.

Excel file icons 
appear together
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Step-By-Step EXERCISE 5-10
Change the Sound Settings
You can modify the sound properties in Vista to customize many different audio settings. 

You can change the volume settings for all sounds. You can also  associate, or assign, 

sounds to a certain action, such as logging on or receiving a new e-mail. These settings 

are changed by applying different sound fi les to program events. The new sounds will 

play when you perform the actions to which they are associated.

 Click Start  and select 

Control Panel.

 Click Appearance and 

Personalization. Click 

Personalization.

 Your screen 

should look like Figure 5.23. 

 In the Personalization

folder, click Sounds.

 In the Sound dialog box, 

under Program, scroll 

down and click Device 

Connect.

 Click Test.

 Under the Sounds 

heading, click the drop-

down arrow and select 

tada.wav.

 Click Test.

 Your dialog 

box should look like 

Figure 5.24. Click OK.

 Click Close .

Continue to the next exercise. 

FIGURE 5.23 Personalization window

FIGURE 5.24 Sound dialog box

Sounds

Notification sound for selected action

If you cannot hear sounds, 
make sure you have 
speakers connected to 
your computer. Also, make 
sure your sound settings 
are not on mute.
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Step-By-Step EXERCISE 5-11
Change the Screen Saver Settings
You can personalize the screen saver, which is the picture or animation that Vista 

displays on your screen when your computer is idle. You can choose a new screen 

saver from several different options. Vista allows you to disable the screen saver. You 

also can change the settings for the screen saver, including the amount of time before 

it activates and whether you must enter a password to return to your desktop.

 Right-click on an open area 

of the desktop and select 

Personalize.

 In the Personalization 

window, click Screen 

Saver (see Figure 5.25).

 In the Screen Saver 

Settings dialog box, click 

the Screen saver drop-

down arrow and select 

Mystify.

 Under Screen saver, in 

the Wait box, click the 

down arrow to 5 minutes.

 Your dialog 

box should look similar to 

Figure 5.26. 

 Click Preview to see a 

preview of the Mystify 

screen saver on your 

monitor. Click any key to 

end the screen saver.

 Click OK.

 Close the Personalization

window.

Continue to the next exercise.

FIGURE 5.25 Personalization window

FIGURE 5.26 Screen Saver Settings dialog box

Screen Saver
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Step-By-Step

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Mouse 

(see Figure 5.27)

 In the Mouse Properties 

dialog box, click the 

Pointer Options tab.

 Under Motion, slide the 

selector all the way toward 

the Fast setting.

 Under Visibility, Check 

Show location of 

pointer when I press 

the CTRL key box.

 Your dialog 

box should look like 

Figure 5.28.

 Click OK.

 Close the Control Panel.

 Press and release . 

Move the mouse pointer 

around the screen.

Continue to the next exercise.

EXERCISE 5-12
Change the Mouse Settings
You can change the mouse pointer settings in Vista to make the mouse more 

comfortable for you to use. Vista allows you to adjust the speed the mouse pointer 

moves over the desktop or the speed at which it registers double-clicks. You can swap 

the functions of the buttons, or make the mouse pointer more visible.

FIGURE 5.27 Control Panel

FIGURE 5.28 Mouse Properties dialog box

Mouse

Slide all the 
way to the 
right
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Step-By-Step EXERCISE 5-13
Display and Confi gure the Windows Sidebar
The Windows Sidebar is another function of Vista designed to help you make the 

most of your computer desktop. The Sidebar is a panel on the desktop that displays 

gadgets. A gadget is a mini application that can be used to perform tasks, such as 

displaying the time, date, or contacts. 

 Click Start  and 

choose All Programs>

Accessories>Windows 

Sidebar.

 Your screen 

should look like Figure 5.29.

 Click Start  and select 

Control Panel.

 Click Appearance and 

Personalization.

 In the Appearance and 

Personalization window, 

click Windows Sidebar 

Properties.

 In the Windows Sidebar 

Properties dialog box, 

under Arrangement, 

check the Sidebar is 

always on top of other 

windows box.

 Your dialog 

box should look like 

Figure 5.30. Click Apply.

  Click OK. Close the 

Appearance and 

Personalization window.

Continue to the next exercise.

FIGURE 5.29 Windows Sidebar opened 

FIGURE 5.30 Windows Sidebar Properties dialog box

Windows Sidebar

Gadget
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Step-By-Step EXERCISE 5-14
Download and Install a Gadget
Windows Vista provides several pre-installed gadgets for the Sidebar. You can also 

download more gadgets online from the Microsoft Windows Live Gallery. Once you 

have downloaded a gadget from the Internet, or have chosen a pre-installed option, 

you can install and display the gadget in the Windows Sidebar. You can install up to 

six different gadgets on the Sidebar.

 At the top of the Windows 

Sidebar, click the  to 

open the Gadget Gallery 

(see Figure 5.31).

 In the Gadget Gallery, 

click Get more gadgets 

online.

  Your screen 

should look like Figure 5.32.

 Follow your teacher’s 

instruction for selecting a 

gadget. Click Download.

 In the Windows Internet 

Explorer confi rmation box, 

click OK.

 In the File Download 

dialog box, click Save.

 In the Save As dialog 

box, navigate to the 

Documents folder and 

click Save.

 Close Internet Explorer.

 Close the Gadget Gallery. 

Continued on the next page.

FIGURE 5.31 Gadgets button

FIGURE 5.32 Gadget Gallery

Click to display Gadget Gallery

Click for online gadgets

By default, new gadgets 
are installed at the top of 
the  Sidebar. If there is not 
enough room for all of the 
gadgets, the gadget at the 
bottom will be removed.
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Step-By-Step EXERCISE 5-14 (Continued)

Download and Install a Gadget
 Click Start  and select 

Documents.

 Double-click the gadget 

that you downloaded.

 In the Windows Sidebar 

Security Warning box, 

click Install.

 In the Documents folder, 

click Close .

 Click the  to reopen the 

Gadget Gallery.

 Your screen 

should look similar to 

Figure 5.33.

 In the Gadget Gallery, 

double-click the gadget. 

Close the Gadget Gallery.

 Your screen 

should look similar to 

Figure 5.34.

Continue to the next exercise.

FIGURE 5.33 Internet Explorer Sidebar page

FIGURE 5.34 Sidebar with Picture Puzzle added

New gadget opened

Being able to follow instruc-
tions is important to any 
academic study. Look for 
a gadget that you think will 
help you in your work. On 
a separate sheet of paper, 
explain how you will use 
the new gadget to help 
with an upcoming project.
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Vocabulary

After You ReadLESSON

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1. A clock is an example of a(n)   that can be added to the 
Windows Sidebar. (p. 155)

 2. You can configure a program to run automatically when Windows Vista starts 
by putting it into the  . (p. 144)

 3. The   is where the majority of the programs in Vista are 
launched. (p. 141)

 4. You can   applications to the Start menu in order to make 
them easily accessible. (p. 143)

 5. A sound can be    with an action, which will result in the 
sound being played when the action is performed. (p. 152)

  Vocabulary Activity

 6. Create a word search using eight of the Vocabulary words from the lesson.
■ Pick eight words for the search. 
■ Write the definitions for the words. These will be the clues for the search.
■ Create a block of letters—your eight words should be hidden in this block.
■ Exchange your word search with a classmate and solve their search. Use the 

definitions to identify the eight vocabulary words, then find the words in 
the block of letters.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. How do you display the Quick Launch toolbar? (p. 145)
A.  Start>Control Panel>Quick 

Launch
B.  Right-click the Taskbar and 

choose Toolbars>Quick Launch

C.  Start>Control Panel> 
Personalize>Quick Launch

D.  Choose Quick Launch in the 
Start menu

 8. How do you move the Taskbar? (p. 147)
A.  Control Panel>Personalization>

Taskbar and Start menu.
B.  Drag it to a new location.

C.  Right-click and drag the Taskbar 
to a new location.

D.  Right-click and select Move 
Taskbar.

 9. How do you change the screen saver? (p. 153)
A.  In the Personalization folder, 

click Screen Saver.
B.  In the Control Panel, click 

Screen Saver.

C.  Right-click on the desktop and 
select Screen Saver.

D.  Right-click the Taskbar and 
select Screen Saver.

Key Terms

gadget

mouse pointer

Notification area

pin

Quick Launch toolbar

Start menu

Startup folder

Windows Sidebar

Academic Vocabulary

associate

method
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Step-By-Step

LESSON

 Click Start  and select 

Control Panel.

 Select Appearance and 

Personalization.

 Click Taskbar and Start 

Menu.

 In the Taskbar and Start 

Menu Properties dialog 

box, click the Toolbars tab 

(see Figure 5.35).

 Add the Links toolbar to 

the Taskbar.

 Click OK.

 Close the Appearance 

and Personalization 

window.

 On the Taskbar, click the 

double right-arrow after the 

Links label.

 Your dialog 

box should look similar to 

Figure 5.36.

 Click the double right-arrow 

again to close the toolbar 

menu.

  Exit Vista.

FIGURE 5.35 Taskbar and Start Menu Properties dialog box

FIGURE 5.36 Links toolbar menu

 1. Add a Toolbar to the Taskbar

Follow the steps to complete the activity.

Practice It Activities

Links toolbar 
expanded
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Step-By-Step

Practice It ActivitiesLESSON

 2. Change the Appearance of your Screen

Follow the steps to complete the activity.

FIGURE 5.37 Appearance Settings dialog box

FIGURE 5.38 Windows Classic appearance

 Right-click in an open area 

of the desktop and select 

Personalize from the 

drop-down menu.

 Click Window Color and 

Appearance.

 In the Appearance 

Settings dialog box in the 

Color scheme pane, 

select Windows Classic 

(see Figure 5.37).

 Click Apply.

 Your screen 

should look similar to 

Figure 5.38.

 In the Appearance 

Settings dialog box in the 

Color scheme pane, 

select Windows Vista 

Basic and click OK.

 In the Personalization

window, click Close .

  Exit Vista.
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Step-By-Step

LESSON

 3.  Change the Sound Settings

Follow the steps to complete the activity.

FIGURE 5.39 Personalization window

FIGURE 5.40 Sound dialog box

 Click Start  and select 

Control Panel.

 Click Appearance and 

Personalization. Click 

Personalization.

 Your screen 

should look like Figure 5.39. 

 Click Sounds.

 In the Sound dialog box, 

under Program, scroll 

down to and select New 

Mail Notification.

 Click Test.

 Under Sounds, click the 

drop-down arrow and 

select Windows 

Exclamation.wav.

 Click Test.

Your screen 

should look like Figure 5.40. 

Click OK.

 Close the Personalization

window.

  Exit Vista.

Practice It Activities
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Step-By-Step

LESSON

 4. Change the Screen Saver

Your supervisor has asked you to set up his computer. Now he would like the screen 

saver changed. You decide to change the screen saver to a more constant pattern and 

to increase the amount of time the computer must be idle before it activates. 

FIGURE 5.41 Personalization window

FIGURE 5.42 Screen Saver Settings dialog box

 Right-click in an open area 

of the desktop and select 

Personalize.

 Click Screen Saver 

(see Figure 5.41).

 In the Screen Saver 

Settings dialog box, 

change the Screen Saver 

to Aurora.

 Change the wait time to 

15 minutes.

 Your dialog 

box should look like 

Figure 5.42.

 Preview the changes.

 Click OK.

 Close the Personalization 

folder.

  Exit Vista.

You Try It Activities
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Step-By-Step

LESSON

FIGURE 5.43 Mouse Properties dialog box Pointer Options tab

FIGURE 5.44 Mouse Properties dialog box Buttons tab

 Click Start  and select 

Control Panel.

 In the Control Panel, 

under Hardware and 

Sound, click Mouse.

 In the Mouse Properties 

dialog box, click the 

Pointer Options tab.

 In the Motion area, slide 

the selector midway 

between the Slow and 

Fast settings.

 Your dialog 

box should look like 

Figure 5.43.

 Click the Pointers tab.

 Change the Scheme to 

Windows Standard 

(Extra Large).

 Move the mouse pointer 

around the screen to check 

the speed.

Your dialog 

box should look like 

Figure 5.44.

 Close the Control Panel.

  Exit Vista.

 5.  Change the Mouse Settings

While you are changing your supervisor’s screen saver, he asks that you also change 

his mouse settings so that the cursor moves more slowly. He would also like to 

make the pointer larger so that he can see it more easily.

You Try It Activities
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LESSON Critical Thinking Activities

 6. Beyond the Classroom Activity

Language Arts: Personalize Your Desktop You work for the community 

newspaper. You decide to customize your desktop functions to make the 

computer more effi cient for you in your role at the paper.

■ Change the more common sound settings to sounds that better 
suit you and your work environment.

■ Move or hide the Taskbar to better use your viewable area.

■ Add or remove gadgets on the Sidebar, or turn off the Sidebar, 
depending upon your preference. 

Open a Word document and key an essay that lists the changes you made 

to your desktop. Describe why you made the changes and how they will 

help to increase your effi ciency. Save your document as: v5rev-[your fi rst 

initial and last name]6.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 6.4 Manage the Windows Sidebar

Finding New Gadgets Make a list of the gadgets from Microsoft that 

might be useful in your position at the paper. Using the skills you have 

learned:

■ Download three new gadgets from the Internet. Do not install them.

■ Save the gadgets in your Documents folder.

■ Save copies of the gadgets into a network folder location provided by 
your teacher in a folder you create labeled: v5rev-[your first initial and 
last name]7. Then, open a Word document and key a paragraph that 
explains why the Gadgets Gallery might be useful in the newspaper 
business. Share your answers with the class.

 8. 21st Century Skills Activity

Increase Accessibility One way to appreciate diversity in the workplace 

is to make computers more accessible to those with disabilities. Make your 

computer easier to use for someone who might have a learning diffi culty or 

physical disability:

■ Adjust the mouse options to make the pointer as visible as possible.

■ Adjust the speed of the mouse to make it move as far as possible with 
the least amount of effort. Share your new settings with a classmate.
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LESSON

 9. Modify Quick Launch Toolbar  

Language Arts: Create Shortcuts You use a few programs at work 

often enough that you decide to make them readily accessible. Display the 

Quick Launch toolbar on the Taskbar if it is not visible.

■ Create new shortcuts on the desktop for the following programs: 
Internet Explorer, Outlook, and Word.

■ Move the programs onto the Quick Launch toolbar.

After you have added the programs to the toolbar, open a Word document 

and key a paragraph that explains how you moved the shortcut icons to the 

toolbar.  Save your document as: v5rev-[your fi rst initial and last name]9.

 10. Confi gure Programs 

Language Arts: Open Outlook on Startup The newspaper’s supervising 

manager wants each employee to check his or her calendar appointments 

and e-mail at the beginning of each shift.

Confi gure Outlook to open automatically on your desktop when Vista

starts. Make the program open in a window that takes up about a quarter of 

the screen. Open a Word document and key a paragraph that explains why 

checking your e-mail and calendar appointments on a consistent basis is 

critical in today’s workplace. Would you want to do business with a vendor 

that did not engage in consistent and timely response to its e-mail or phone 

messages? Explain how not checking your calendar could result in poor 

service. Save your document as: v5rev-[your fi rst initial and last name]10.

 11. Convert Currency

Math: Download and Install a Gadget You are responsible for updating 

the currency exchange rates feature in the Business section of your newspaper. 

Use the Gadget Gallery to fi nd a currency converter gadget. Download and 

save the gadget in your Documents folder. Then, install it and add it to 

Sidebar.

After you have added the gadget to the Sidebar, use the converter to 

determine the following conversions from U.S. dollars to Japanese yen:

■ $1 ■ $5

■ $10 ■ $20

Use Word to create a table for your answers. Save the document as: v5rev-

[your fi rst initial and last name]11.

Customize Every person 
works at different speeds 
and with different styles, 
which is why customizing 
your desktop to your needs 
is necessary. These projects 
teach you how to use the 
skills you have learned to 
adapt your computer 
workspace to its most 
efficient mode.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. How does your custom 
desktop differ from 
some of your classmates’ 
desktops?

2. How does your desktop 
differ from the Vista 
default?

Challenge Yourself Projects
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Key Concepts

LESSON

With personal computers and operating systems becoming more complex, there 

are more things that might go wrong with them. It is a good idea to be able to 

maintain your computer to keep it in good running order. You should also be 

able to diagnose and repair some minor malfunctions on your own. The exercises 

in this lesson will give you the skills to perform these tasks. The exercises in this 

lesson can make permanent changes to your computer and software. Do not 

complete any of the exercises without the express permission of your teacher.

Use the Right Resources You are surrounded by sources of information 

everywhere you look. A school bulletin board offers a place for students to 

exchange information about extracurricular activities and items or services for sale. 

Your school library has books, magazines, and newspapers, as well as librarians 

who can help you fi nd resources for a research project. An Internet connection  

opens an almost limitless source of information. How do you know when you are 

using a reliable resource? How do you fi nd a valid resource on the Internet?

 Use Windows ReadyBoost

 Defragment a hard disk

 Use Windows Help and 
Support

 Display information about your 
computer’s performance

 Enable and disable network 
connections

 Use advanced startup options

 Manage Remote Assistance 

Standards

The following standards are 
covered in this lesson. Refer 
to pages xxiv and 715 in 
the Student Edition for a 
description of the standards 
listed here.

ISTE Standards Correlation

NETS•S

1a, 2a, 2d, 3b, 3c, 4b, 5a, 5b, 
6a, 6c

Microsoft Certified 
Application Specialist 
Standards

Vista

7.1, 7.2, 7.3, 7.4, 7.5, 

7.6, 7.7, 7.8

Optimize and Troubleshoot

Vista 166Lesson 6: Optimize and Troubleshoot

B
an

an
aS

to
ck

/J
up

ite
r 

Im
ag

es



LESSON

Memory Aids Successful readers use “mind tricks” to help them remember. A proven strategy is to make 
associations with new ideas as you learn them. The term WYSIWYG (wiz-zee-wig) is an example, standing 
for “What You See Is What You Get.” As you read, make up your own memory aids.

Read to Learn

• Use utilities to manage your computer.
• Evaluate system statistics.
• Discover how to use help and support.

Main Idea

Use Vista’s utilities to maintain your computer and 
to repair common system malfunctions.

Vocabulary

Key Terms

Academic Vocabulary
These words appear in your reading and on your 
tests. Make sure you know their meanings.

establish
identify
restore

Quick Write Activity 

Describe On a separate sheet of paper, write down 
three problems you have had in the past with a 
computer. Write down possible solutions to the 
problems next to them.

Study Skills

Look It Up If you hear or read a word that you do 
not know, look it up in the dictionary or on your 
computer. Before long, this practice will become a 
vocabulary-building habit.

Academic Standards

English Language Arts
NCTE 3 Apply strategies to interpret texts.
NCTE 4 Use written language to communicate effectively.
NCTE 8 Use information resources to gather information and create and communicate knowledge.
Math
NCTM (Measurement) Apply appropriate techniques, tools, and formulas to determine measurements.

Advanced Boot Options
command prompt
CPU
defragment
Internet Protocol (IP)
memory cache
optimize
page fi le memory
ping
print queue
processor
RAM

ReadyBoost
Remote Assistance 
 Invitation
statistics
system restore point
Task Manager
unresponsive
Windows Experience 
 Index
Windows Help and 
 Support

Before You Read

Reading Guide
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Step-By-Step EXERCISE 6-1
Use Windows ReadyBoost
Windows ReadyBoost speeds up your computer by using space on certain removable 

media, or digital storage devices. It does this by expanding the available memory, or 

memory cache. ReadyBoost uses part of the removable media as a temporary location 

to store information that is being transferred. You can activate ReadyBoost when you 

connect removable storage media, such as a USB drive, to your computer.

 Connect to your computer 

the removable media 

provided by your teacher.

 In the AutoPlay dialog box 

under General Options, 

select Speed up my 

system (see Figure 6.1).

 In the Secure Digital 

Storage Device 

Properties dialog box, 

click the ReadyBoost tab.

 Click Use this device.

 Your dialog 

box should look like 

Figure 6.2.

 Click OK.

Continue to the next exercise.

FIGURE 6.1 AutoPlay dialog box

FIGURE 6.2 Secure Digital Storage Device Properties dialog box

Select this option 
for ReadyBoost 

You can also open the 
Properties dialog box 
ReadyBoost tab by 
selecting an appropriate 
media drive from the 
Computer folder, right-
clicking the drive, and 
selecting Properties.
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Step-By-Step EXERCISE 6-2
Manually Defragment a Hard Disk
Over time, data can spread out across a hard disk. This process is called fragmentation.  

When you defragment a computer’s hard disk, all the data is reorganized on the disk 

so that it is stored and grouped most effectively. Defragmenting a hard disk enables 

the computer to access the information more quickly.

 Click Start  and select 

Control Panel.

 In the Control Panel, 

click System and 

Maintenance.

 Your screen 

should look like Figure 6.3.

 In the System and 

Maintenance window, 

under Administrative 

Tools, click Defragment 

your hard drive.

 In the User Account 

Control dialog box, enter 

the password, if necessary. 

Click Continue.

 In the Disk Defragmenter 

dialog box, click 

Defragment now (see 

Figure 6.4).

 Click Close.

 Close the System and 

Maintenance window.

Continue to the next exercise.

FIGURE 6.3 System and Maintenance window

FIGURE 6.4 Disk Defragmenter dialog box

Defragment now

Defragment your 
hard drive

 Defragmenting your hard 
disk might take several 
minutes to a few hours, 
depending on the size and 
degree of fragmentation of 
your hard disk. Do not use 
your computer during this 
process.
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Step-By-Step EXERCISE 6-3
Adjust Power Options
Power options are another way to optimize your computer. When you optimize your 

computer, you make it perform as well as it possibly can. You can set the power 

options to maximize your computer’s processing power and speed, or you can 

confi gure the computer to run in a power-conserving mode.

FIGURE 6.5 System and Maintenance window

FIGURE 6.6 Power Options

High performance

 Click Start  and select 

Control Panel.

 In the Control Panel, 

click System and 

Maintenance.

 Your screen 

should look like Figure 6.5.

 Click Power Options.

 Select the High 

performance option if 

it is not already selected.

 Your screen 

should look like Figure 6.6.

 Click Close .

Continue to the next exercise.
Power Options

Your user rights and 
computer’s hardware 
confi guration might limit 
the changes you can make 
to the  Power Options set-
tings. Ask your teacher if 
you need more information 
about the settings.
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Step-By-Step EXERCISE 6-4
Use Windows Help and Support and the
Knowledge Base
To answer questions about Vista, you can use the Windows Help and Support  tool. 

After entering a search term, you will be directed to a list of related topics with 

information and answers. If you search the Knowledge Base, you will fi nd articles 

created by technicians based on issues raised by users. Articles are frequently updated.

FIGURE 6.8 Working with the Network Connections folder help

 Click Start . In the right 

pane at the bottom of the 

Start menu, click Help 

and Support.

 Your screen 

should look similar to 

Figure 6.7.

 Under Find an answer, 

click Windows Basics.

 Scroll down to Help and 

Support. Under Help 

and Support, click 

Getting help.

 Click in the Search Help 

box and key: network 

connections. Press .

 Click Working with the 

Network Connections 

folder.

 Read the information about 

working with the  Network 

Connections folder. Click 

To set up a network or 

connection to expand the 

topic (see Figure 6.8).

Continued on the next page.

FIGURE 6.7 Windows Help and Support home

Windows 
Basics

Search Help Help and Support  Home 

Click to expand 

To browse Help topics 
by subject, click  Browse 
Help  and select a sub-
ject heading from the list.
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Step-By-Step EXERCISE 6-4 (Continued)

Use Windows Help and Support and 
Knowledge Base

FIGURE 6.9 Knowledge Base displayed in Internet Explorer

FIGURE 6.10 Results of Knowledge Base search

 Click Help and Support 

home .

 Under Ask someone, click 

More support options.

 Under Other resources, 

click Knowledge Base.

 Your screen 

should look like Figure 6.9.

 Click the fi rst option in the 

Search Results list.

 Your screen 

should look similar to 

Figure 6.10.

 Close Internet Explorer.

 Close Windows Help and 

Support.

Continue to the next exercise.

The Microsoft Knowledge 

Base is an online feature 
of Windows Help and 

Support. This means you 
must be connected to the 
Internet to access it. If 
your computer is currently 
offl ine, you will not be 
able to search the 
Knowledge Base.
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Step-By-Step EXERCISE 6-5
Learn the CPU and Page File Usage of 
a Computer
Vista tracks statistics, or numerical data, about the operation of your computer. These 

statistics include the percentage of the computer’s CPU, or Central Processing Unit, 

that is being used and how much page fi le memory is in use. A page fi le is memory 

on the hard drive that the computer uses to temporarily supplement RAM, or Random 

Access Memory. You can track these statistics using the Task Manager.

 Click Start  and select 

Control Panel.

 Select System and 

Maintenance, then 

click Performance 

Information and Tools.

 Click Advanced Tools.

Your screen 

should look like Figure 6.11. 

 Click Open Task 

Manager. In the Windows 

Task Manager, click the 

Performance tab (see 

Figure 6.12).

 Under CPU Usage, note 

the percentage displayed 

under the graph. This is the 

current CPU use.

 Under System, note the 

numbers to the right of 

Page File. This is the 

current amount of memory 

devoted to page fi le use.

 Close the Windows Task 

Manager. Close the 

Advanced Tools window.

Continue to the next exercise.

FIGURE 6.11 Advanced Tools

FIGURE 6.12 Memory usage in the Windows Task Manager

CPU 
use

Memory for 
page file use

You can also open the 
Task Manager by right-
clicking in a blank area of 
the Taskbar and selecting 
Task Manager. 

Open Task 
Manager 
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Step-By-Step EXERCISE 6-6
Display the Amount of RAM and 
the Processor Speed
Sometimes, you may need to check the amount of RAM a computer has, as well as the 

speed of its processor. The processor is the main circuit chip that performs the 

calculations that run the computer. Both RAM and processor statistics are important 

in deciding which software and hardware to add to your computer.

FIGURE 6.13 Computer Properties

Processor speed

FIGURE 6.14 System information

 Click Start .

 Right-click Computer and 

select Properties (see 

Figure 6.13).

 Your screen 

should look similar to 

Figure 6.14.

 Under System, note the 

information given for 

Processor. This most likely 

includes a number given in 

gigahertz (GHz). This is your 

processor speed.

 Under Memory (RAM), 

note the number given in 

gigabytes (GB) or mega-

bytes (MB). This is the 

amount of RAM installed on 

your computer.

 Click Close .

Continue to the next exercise. 

RAM memory 
installed on system

RAM is the short-term 
storage that your computer 
uses to run programs. RAM 
memory is designed to 
clear when your computer 
is turned off. 

CPU and processor are 
synonyms. The terms can 
be used interchangeably.
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Step-By-Step EXERCISE 6-7
Find the Hardware and Devices 
Installed on a Computer
Vista utilities enable you to fi nd out exactly what hardware and devices are connected 

to or installed on your computer. The Device Manager is the utility that displays 

installed devices and allows you to enable, disable, and uninstall them. 

FIGURE 6.15 System window

FIGURE 6.16 Device Manager

 Click Start .

 Right-click Computer and 

select Properties.

 In the System window, in 

the left pane, select Device 

Manager (see Figure 6.15).

 In the Use Account 

Control dialog box, click 

Continue.

 In the Device Manager, 

click  in front of Disk 

drives. Note that all your 

computer’s disk drives are 

displayed.

 Your screen 

should look similar to  

Figure 6.16.

 Choose File>Exit.

 In the System window, 

click Close .

Continue to the next exercise.

Device Manager

Disk drives 
displayed
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Step-By-Step EXERCISE 6-8
Learn the System Performance 
Rating of a Computer
Vista rates your system performance using the Windows Experience Index, a number 

that determines a base score for your system that can be used to ensure that programs 

and other software will run correctly and quickly on your computer. To change your 

score, you must upgrade your computer.

 Click Start  and select 

Control Panel.

 Select System and 

Maintenance. Under 

System, click Check your 

computer’s Windows 

Experience Index base 

score.

Your screen 

should look like Figure 6.17.

 If your computer currently 

has no score, click Rate 

this computer. If your 

computer has a score, click 

Update my score.

 In the User Account 

Control dialog box, click 

Continue.

 Your screen 

should look similar to 

Figure 6.18. Click View 

and print details.

 Click Print this page. 

With permission from your 

teacher, click Print in the 

Print dialog box.

 Close the More details 

about my computer

page.

 Close the Performance 

Information and Tools

window.

Continue to the next exercise.

FIGURE 6.17 Rate and improve your computer’s performance screen

FIGURE 6.18 Rate and improve screen with rating updated

Rate this 
computer

View and 
print details
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Step-By-Step EXERCISE 6-9
Find the IP Confi guration of a Computer
The Internet Protocol (IP) confi guration of a computer is key to connecting your 

computer to a network. A unique IP address is assigned specifi cally to your computer 

so that other computers and services on a network can fi nd and communicate with 

your computer. There are several aspects of the IP confi guration that must be set in 

order to connect a computer to a network or the Internet.

 Click Start  and select 

Control Panel.

 Click Network and 

Internet. Under Network 

and Sharing Center, 

click View network 

status and tasks.

 Your screen 

should look similar to 

Figure 6.19.

 Under the network heading, 

to the right of Connection, 

click View Status.

 In the Connection Status 

dialog box, click Details.

 Your dialog 

box should look similar to 

Figure 6.20. 

 Click Close .

 In the Connection 

Status dialog box, click  

Close .

 Close the Network and 

Sharing Center window.

Continue to the next exercise.

FIGURE 6.19 Network and Sharing Center

FIGURE 6.20 Network Connection Details dialog box

View status

Your IP 
address

An IP address consists of 
four groups of numbers 
separated by periods, 
such as 169.129.74.44.
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Step-By-Step EXERCISE 6-10
Ping a Computer to Ascertain 
Connectivity Status
One of the easiest ways to ensure that your computer is successfully connected to a 

network is to ping another computer. You ping a computer by opening your system’s 

command prompt and entering the command ping with the IP address of the 

computer you want to check.

 Click Start  and 

choose All Programs>

Accessories>Command 

Prompt.

 Your screen 

should look like Figure 6.21.

 In the Command Prompt 

window where the blinking 

cursor is after the >, key: 

ping [the address of a 

computer assigned by your 

teacher].

 Press .

 Your screen 

should look like Figure 6.22.

 Key: exit. Press .

Continue to the next exercise.

FIGURE 6.21 Command Prompt window

FIGURE 6.22 Successful ping to another computer

Command Prompt window

Command prompt

Successful replies 
from ping

Troubleshooting requires 
you to systematically 
review a system or prob-
lem. It is similar to the kind 
of systematic review you 
might give to a mathe-
matical calculation or 
formula. By testing all the 
parts of a formula, for 
example, you can pinpoint 
where it went off track and 
make corrections.

Vista 178Lesson 6: Exercise 6-10



Step-By-Step EXERCISE 6-11
Enable and Disable a Network Connection
When you establish, or make, a connection to a network, that connection usually stays 

active until you disconnect it. You do not want to lose the confi guration information 

when you disconnect, so in order to shut down the connection, you should disable it in 

the Network and Sharing Center.

 Click Start  and select 

Control Panel.

 Click Network and 

Internet.

 Your screen 

should look like Figure 6.23.

 Click Network and 

Sharing Center.

 Your screen 

should look like Figure 6.24.

 In the Network and 

Sharing Center, under 

Tasks, click Manage 

network connections.

Continued on the next page.

FIGURE 6.23 Network and Internet window

FIGURE 6.24 Network and Sharing Center

Manage network 
connections

A network connection is a 
connection that enables a 
computer to transmit and 
receive information with 
the Internet, a network, or 
another computer.
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Step-By-Step EXERCISE 6-11 (Continued)

Enable and Disable a Network Connection
Your screen 

should look like Figure 6.25.

 Under LAN or High-

Speed Internet, follow 

your teacher’s instructions 

for selecting a connection.

 On the Network 

Connections toolbar, click 

Disable this network 

device .

 In the User Account 

Control dialog box, click 

Continue.

 Your screen 

should look similar to  

Figure 6.26.

 Select the disabled network 

device. On the Network 

Connections toolbar, click 

Enable this network 

device.

 In the User Account 

Control dialog box, click 

Continue.

 In the Network 

Connections menu, 

choose File>Close.

 Close the Network and 

Sharing Center.

Continue to the next exercise.

FIGURE 6.25 Network Connections

FIGURE 6.26 Network Connections with device disabled

Enable selected connection
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Step-By-Step

 Double-click the Internet 

Explorer icon on your 

desktop to start the 

program.

 Your screen 

should look similar to 

Figure 6.27.

 Right-click in an open area 

of the Taskbar and select 

Task Manager.

 Click the Applications 

tab.

 Your screen 

should look similar to  

Figure 6.28.

 Under Task, select the 

Internet page that you 

opened in Step 1.

 Click End Task.

 In the Windows Task 

Manager menu, choose 

File>Exit Task Manager.

Continue to the next exercise.

EXERCISE 6-12
Identify and Terminate Unresponsive 
Programs
Sometimes a program that is running will become stuck or unresponsive. Vista will 

try to solve the problem, but if you do not want to wait you can stop the program 

using Task Manager. Once in Task Manager dialog box, identify, or discover which 

program is unresponsive, and stop it.

FIGURE 6.27 Internet Explorer 

FIGURE 6.28 Windows Task Manager

End Task

If you end the program 
yourself using  Task 
Manager, any unsaved 
changes will be lost.
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Step-By-Step EXERCISE 6-13
Repair a Software Installation
Vista utilities enable you to repair some software installations. Problems can occur 

when programs have not installed correctly. Programs can also become corrupted 

over time, perhaps because of the installation of other programs. You can use the 

Programs and Features tool to help install and uninstall programs and to repair 

installations. Do not repair a program without permission from your teacher. 

 Click Start  and select 

Control Panel.

 Click Programs.

 In the Programs window, 

click Programs and 

Features.

 Your screen 

should look similar to 

Figure 6.29.

 Select the name of the 

program assigned by your 

teacher.

 On the toolbar, click 

Repair  (see 

Figure 6.30).

 In the Windows Installer 

dialog box, click Browse 

and navigate to the location 

provided by your teacher, 

or insert the disc provided 

by your teacher. Click OK.

 Close the Programs and 

Features window.

Continue to the next exercise. 

FIGURE 6.29 Programs and Features window

FIGURE 6.30 Program with Repair button enabled

Program to be 
repaired

Do not make permanent 
changes to installed 
software without permis-
sion from your teacher.
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Step-By-Step EXERCISE 6-14
Check the Status of a Printer
When you are connected to a network, you might have several choices of printers to 

work with. It is a good idea to check the status of all the printers you are connected to 

and see if a printer is busy. You can also pause or delete a print job that you already have 

sent to the printer. You can control the print jobs that you have sent to a printer through 

the printer’s print queue.

 Click Start  and select 

Control Panel.

 Under Hardware and 

Sound, click Printer.

 Your screen 

should look similar to 

Figure 6.31.

 Select the printer assigned 

by your teacher.

 Double-click the printer 

icon to open the Print 

Queue.

 Your screen 

should look like Figure 6.32.

 In the queue’s menu, 

choose Printer>

Properties. 

 In the printer’s  Properties 

dialog box, click the 

General tab.

Continued on the next page.

FIGURE 6.31 Printers window

FIGURE 6.32 Print queue

Printer is Ready

If you are currently 
printing, you can open 
the print queue by 
clicking the printer icon in 
the  Notification area.
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Step-By-Step EXERCISE 6-14 (Continued)

Check the Status of a Printer
 Click Print Test Page. In 

the printer’s dialog box, 

click Close. In the printer’s 

Properties dialog box, 

click OK (see Figure 6.33).

 Your screen 

should look like Figure 6.34.

 Select the print job that is 

displayed in the print 

queue and choose 

Document>Pause.

 In the print queue, choose 

Document>Resume.

 Select the document in the 

print queue and choose 

Document>Cancel.

 Choose Printer>Close.

 Close the Printers folder.

 Close the Control Panel.

Continue to the next exercise.

FIGURE 6.33 Printer Properties

FIGURE 6.34 Print queue with printing document

Printer is Ready

Document in print queue

You can use the print queue 
to pause, resume, restart, 
or cancel a print job. 
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Step-By-Step EXERCISE 6-15
Use Advanced Startup Options
Sometimes a computer might encounter an error that corrupts the operating system so 

badly that it will no longer run. When this happens, you can start Vista in a different way 

in order to fi x the problem. These advanced startup options can help you get the system 

running smoothly again. Do not follow these steps without your teacher’s permission. 

Never change settings with which you are unfamiliar. 

 Click Start . Click the 

right-arrow at the bottom 

right side of the Start 

menu. Click Restart.

 After the Power On Self 

Test, but before Windows 

Vista starts, press and hold 

down .

Your screen 

should look similar to 

Figure 6.35.

 On the Advanced Boot 

Options screen, choose 

Safe Mode. Press . 

If necessary, log in.

 Your screen 

should look similar to 

Figure 6.36.

 Close Windows Help and 

Support.

 Restart the computer.

Continue to the next exercise.

FIGURE 6.35 Advanced Boot Options screen

FIGURE 6.36 Windows Vista in Safe Mode

Choose Safe 
Mode

Safe Mode starts Windows 
with the bare minimum of 
system drivers and opera-
tions and without network 
drivers. If Windows starts in 
Safe Mode, you can 
eliminate these aspects as 
the cause of any problems.
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Step-By-Step EXERCISE 6-16
Restore a Computer to a Previous Point
Vista allows you to create a system restore point, that will restore, or return, your 

computer’s operating system to a previous point. Returning to the previous settings 

will solve any system problem that occurred recently. This is not a backup, because 

system restore only restores the operating system, not your data fi les or programs.

 Click Start  and select 

Control Panel.

 Click System and 

Maintenance. Select 

Backup and Restore.

 Your screen 

should look like Figure 6.37.

 At the bottom of the screen, 

click Use System Restore 

to fix problems and undo 

changes to Windows.

 In the User Account 

Control dialog box, click 

Continue.

 In the System Restore 

dialog box, click Next.

 In the list of restore points, 

select the latest restore 

point (see Figure 6.38).

 Click Next. In the Confirm 

your restore point 

screen, double-check your 

restore point and click 

Finish.

 In the System Restore

confi rmation dialog box, 

click Yes.

 After the computer restarts, 

click Close in the System 

Restore completion  

dialog box.

Continue to the next exercise.

FIGURE 6.37 Backup and Restore Center

FIGURE 6.38 System Restore dialog box with restore point selected

Click to use restore points
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Step-By-Step EXERCISE 6-17
Repair the Windows Vista Installation
 If your operating system becomes so corrupted that it cannot be restored, you must 

repair it. Vista offers several tools for repairing a Vista installation.  They can all be 

reached through the Advanced Boot Options page. You should only follow the steps 

in this exercise with your teacher’s permission.

 Click Start  click the 

right-facing arrow at the 

bottom right of the Start 

menu. Click Restart.

 Press and hold  until 

you reach the Advanced 

Boot Options page (see 

Figure 6.39).

 Click Repair Your 

Computer. Press .

 In the System Recovery 

Options dialog box, click 

Next.

 Click the User name drop-

down arrow and select your 

name. Key your password 

into the Password box.

 Click OK.

 Your screen 

should look like Figure 6.40.

 Click Restart.

Continue to the next exercise. 

FIGURE 6.39 Advanced Boot Options screen

FIGURE 6.40 System Recovery Options dialog box

Repair Your Computer

Click to restart 
your computer

 A  boot disk, or startup disk, 
contains the fi les that your 
computer uses to start 
Windows Vista. The fi les 
are also stored on the 
computer, but if they 
become damaged, you can 
use the fi les on the boot 
disk to start Windows.
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Step-By-Step EXERCISE 6-18
Enable Windows Remote Assistance 
Invitations by Using Remote Settings
Vista allows you to request remote help to fi x your computer as well as respond to 

requests for such help. To allow someone to have remote access to your computer, or 

to remotely access someone else’s computer, you must change the settings to enable 

a Remote Assistance Invitation.

 Click Start  and select 

Control Panel.

 Click System and 

Maintenance.

 Your screen 

should look like Figure 6.41.

 Under System, click Allow 

remote access.

 In the User Account 

Control dialog box, click 

Continue.

 In the System Properties 

dialog box, click the 

Remote tab. Under 

Remote Assistance, 

check the Allow Remote 

Assistance connections 

to this computer box.

 Your screen 

should look like Figure 6.42.

 Click OK.

 Close the System and 

Maintenance window.

Continue to the next exercise.

FIGURE 6.41 System and Maintenance window

FIGURE 6.42 System Properties dialog box

Allow remote 
access

Allow remote Assistance 
connections to this computer
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Step-By-Step EXERCISE 6-19
Set Limits for Windows Remote Assistance
Because a Remote Assistance Invitation allows others to access your computer, you do 

not want the invitation to be left open so that an intruder can gain access to your 

computer without permission. You can set the amount of time an invitation is open so 

that after the invitation expires it will disable remote access.

 Click Start  and select 

Control Panel.

 Click System and 

Maintenance.

 Under System, click Allow 

remote access.

 In the User Account 

Control dialog box, click 

Continue.

 In the System Properties 

dialog box, click the 

Remote tab.

 Your screen 

should look like Figure 6.43.

 Under Remote 

Assistance, click 

Advanced.

 In the Remote 

Assistance Settings 

dialog box, under 

Invitations, select the 

number in the box and 

key: 1.

 Your screen 

should look like Figure 6.44. 

Click OK.

 In the System Properties 

dialog box, click OK. Close 

the System and 

Maintenance folder.

Continue to the next exercise.

FIGURE 6.43 System Properties dialog box

FIGURE 6.44 Remote Assistance Settings dialog box
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Step-By-Step EXERCISE 6-20
Request Remote Assistance through 
Windows Help and Support
In order for you to receive remote help, you must request assistance through an 

invitation. Because remote assistance is a form of operating system help, you can send 

a request for Remote Assistance through Windows Help and Support.

 Click Start  and select 

Help and Support.

 Your screen 

should look like Figure 6.45.

 In Windows Help and 

Support, under Ask 

someone, click Windows 

Remote Assistance.

 In the Windows Remote 

Assistance wizard, select 

Invite someone you 

trust to help you (see 

Figure 6.46).

 Click Use e-mail to send 

an invitation.

 In the Password box, key: 

helper1. Key the same 

password into the Retype 

the password box.

Continued on the next page.

FIGURE 6.45 Windows Help and Support

FIGURE 6.46 Windows Remote Assistance wizard

Click to allow Remote 
Assistance

If you are connected to 
the Internet,  Windows 
Remote Assistance is a 
convenient way to ask 
someone you trust to con-
nect to your computer and 
help you fi x a problem.
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Step-By-Step

 Click Next.

 Your screen 

should look like Figure 6.47.

 In the To box, key the 

e-mail address of a 

classmate assigned by 

your teacher.

 Click Send .

 Your screen 

should look like Figure 6.48.

Continue to the next exercise.

EXERCISE 6-20 (Continued)

Request Remote Assistance through 
Windows Help and Support

FIGURE 6.47 Invitation e-mail

FIGURE 6.48 Remote Assistance Invitation open

Click to Send

Key e-mail of assigned classmate here

You also can send requests 
directly through the 
Remote Assistance utility 
by choosing Start  >All 

Programs>Maintenance.

Remember, make sure you invite someone that you fi nd 
trustworthy, such as a friend, coworker, or technical support 
person. The person you invite will have access to your fi les and 
personal information.
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Step-By-Step EXERCISE 6-21
Disable Remote Assistance Invitations
You can disable a Remote Assistance Invitation at any time. Once you have disabled 

the invitation, your request for assistance can no longer be used by anyone to gain 

access to your computer.

 In the Windows Remote 

Assistance confi rmation 

box, click Yes (see 

Figure 6.49).

 Your screen 

should look like Figure 6.50.

 Click Disconnect .

 In the Windows Remote 

Assistance confi rmation 

box, click Yes.

 In the Windows Remote 

Assistance wizard, click 

Cancel.

 Close Windows Help and 

Support. 

FIGURE 6.49 Remote Assistance confirmation box

FIGURE 6.50 Remote Assistance in session

Remote helper can now see desktop

If at any time you want to 
immediately disconnect 
from Windows Remote 
Assistance, you can press 

 to end the session.
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Vocabulary

After You ReadLESSON

  Review Vocabulary

Complete the following statements on a separate piece of paper. Choose from the Vocabulary 

list on the left to complete the statements.

 1.   helps to increase your computer’s speed by temporarily 
storing files on a removable storage device. (p. 168)

 2.  The Task Manager can help you close programs that have become 
 . (p. 181)

 3. Print jobs that have been sent from your computer but are not yet printed are 
in the  . (p. 183)

 4. In order to have access to a network, you must first   a 
connection to the network. (p. 179)

 5. You can request help with your computer from specific individuals by sending 
a(n)  . (p. 188)

  Vocabulary Activity

 6. Three of the vocabulary words in this lesson are abbreviations. Open a Word 
document and key the abbreviations, the terms that they stand for, and the 
definition of the terms.

  Now find eight other vocabulary words for which you can make abbreviations. 
Write them out the same way as the original three, including their definitions.

  Review Key Concepts

Answer the following questions on a separate piece of paper.

 7. What utility would you use to request remote help? (p. 188)
A. Remote Control Settings
B. Remote User Assistance

C. Remote Assistance Invitation
D. Remote Desktop Connection

 8. Where would you terminate unresponsive programs? (p. 181)
A. User Account Control
B. Task Manager

C. Device Manager
D. Windows Explorer

 9. Where would you enter the command to ping a computer? (p. 178)
A. Network and Sharing Center
B. Command window

C. System and Maintenance
D. Command prompt

 10. How do you start Vista in Safe Mode? (p. 185)
A. Press F8 at startup
B.  Select Advanced Boot Options in 

Start menu

C. Restart in Task Manager
D.  Select Safe Mode in System 

window

Key Terms

Advanced Boot Options

command prompt

CPU

defragment

Internet Protocol (IP)

memory cache

optimize

page file memory

ping

print queue

processor

RAM

ReadyBoost

Remote Assistance 

 Invitation

statistics

system restore point

Task Manager

unresponsive

Windows Experience Index

Windows Help and Support

Academic Vocabulary

establish

identify

restore
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Step-By-Step

LESSON

 Click Start  and select 

Control Panel.

 Select System and 

Maintenance, then 

click Performance 

Information and Tools.

 In the left pane, click 

Advanced Tools.

 Your screen 

should look like Figure 6.51. 

 Click Open Task 

Manager.

 In the Windows Task 

Manager, click the 

Performance tab 

(see Figure 6.52).

 In the CPU Usage area, 

note the percentage 

displayed under the graph.

 In the System area, note 

the numbers to the right of 

Page File.

 In the Windows Task 

Manager menu, choose 

File>Exit Task Manager.

 Close the Advanced 

Tools.

 Exit  Vista.

FIGURE 6.51 Advanced Tools

FIGURE 6.52 Windows Task Manager

 1. Learn the CPU and Page File Use of a Computer

Follow the steps to complete the activity.

Practice It Activities
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Step-By-Step

Practice It ActivitiesLESSON

 2. Display the Amount of RAM and the Processor Speed

Follow the steps to complete the activity.

FIGURE 6.53 Start menu

FIGURE 6.54 System information

 Click Start .

 Right-click Computer 

and select Properties 

(see Figure 6.53).

 Your screen 

should look similar to  

Figure 6.54.

 Under System, note the 

information given for 

Processor.

 Under System, note the 

amount of Memory (RAM) 

given in megabytes (MB).

 Click Close .

 Exit  Vista.
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Step-By-Step

LESSON

 3.  Discover the Status of a Printer

Follow the steps to complete the activity.

FIGURE 6.55 Control Panel

FIGURE 6.56 Printers folder

 Click Start  and select 

Control Panel.

 Under Hardware and 

Sound, click Printer 

(see Figure 6.55).

 Your screen 

should look similar to 

Figure 6.56.

 Select the printer assigned 

by your teacher. Check to 

see that the status of this 

printer is Ready.

 Close the Printers 

window.

 Close the Control Panel.

 Exit  Vista.

Practice It Activities
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Step-By-Step

LESSON

 4. Enable and Disable a Network Connection

Your supervisor’s desktop computer has become disconnected from the network.  

She has asked you to reconnect it. You decide to try to reconnect to the network 

using the previously confi gured network connection.

FIGURE 6.57 Network Connections

FIGURE 6.58 Network Connections with device enabled

 Click Start  and select 

Control Panel.

 Click Network and 

Internet. Click Network 

and Sharing Center.

 In the Network and 

Sharing Center Tasks 

pane, click Manage 

network connections.

 Your screen 

should look like Figure 6.57. 

 Under LAN or High-Speed 

Internet, follow your 

teacher’s instructions for 

selecting a connection.

 On the Network 

Connections toolbar, click 

Enable this network 

device. In the User 

Account Control dialog 

box, click Continue.

 Your screen 

should look like Figure 6.58. 

 In the Network 

Connections folder menu, 

choose File>Close.

 Close the Network and 

Sharing Center. Exit 

Vista.

You Try It Activities

Network connection 
device enabled

Vista 197Lesson 6: You Try It Activities



Step-By-Step

LESSON

FIGURE 6.59 Command Prompt window

FIGURE 6.60 Successful ping to another computer

 Click Start  and 

choose All Programs>

Accessories>Command 

Prompt.

 Your screen 

should look similar to 

Figure 6.59.

 In the Command Prompt 

window, after the >, and 

key: ping [the IP address of 

a computer assigned by 

your teacher].

 Press . Key: exit.

 Your screen 

should look similar to 

Figure 6.60.

 Press .

 Exit  Vista.

 5.  Ping a Computer to Check Connectivity

You need to check the network connection to your supervisor’s desktop computer. 

You decide to ping another computer in the offi ce to make sure the computer is 

really connected.

You Try It Activities
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LESSON Critical Thinking Activities

 6. Beyond the Classroom Activity

Language Arts: Gather Information for Repairs With a classmate, 

take turns sending each other Remote Assistance Invitations. When you have 

control of your classmate’s computer, use the information you have learned in 

this lesson to gather the following statistics about their computer:

■ Processor speed

■ Amount of RAM

■ IP address

Key the statistics into a Word document with your name and the name of 

your assigned classmate. Under the statistics, include a paragraph that 

defi nes each of the bulleted items in this activity. With your teacher’s 

permission, use the Internet or your school library to gather additional 

information for the defi nitions. Save your fi le as: v6rev-[your fi rst initial 

and last name]6.

 7. Standards at Work Activity
 Microsoft Certified Application Specialist Correlation 

Vista 7.3 Locate System Information

Size Up Your System Use the skills you have learned concerning the 

Windows Experience Index to fi nd the system performance rating of your 

computer. Then, with your teacher’s permission, use Internet Explorer to 

search the Internet for software that meets the rating number. 

Open a Word document and list the titles of at least three compatible 

programs and their rating numbers. Save your fi le as: v6rev-[your fi rst initial 

and last name]7.

 8. 21st Century Skills Activity

Language Arts: Find Reliable Resources on the Internet A 

computer makes many resources available to you. Judging whether those 

resources are reliable is important to determining the quality and validity 

of the information. With your teacher’s permission, use the Internet to 

learn three tips or criteria for evaluating a Web page. For example, determine 

whether the information on the page is outdated, or whether the page lists 

the author or institution that published the page, as well as contact 

information. Open a Word document and key a list of criteria students can 

use to judge the reliability of a Web site. Save your paragraph as: v6rev-

[your fi rst initial and last name]8.
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LESSON

 9. Protect Company Resources

Language Arts: Use Safe Mode Your company’s main server has 

crashed and will not run when it is rebooted. The computer runs Windows 

Vista. Your supervisor has called you in to get the computer up and running, 

as the company is losing money every minute the server is offl ine. You fi nd 

that you cannot get Vista to boot properly.

■ Using the advanced startup options, start Vista in  Safe Mode with 
networking capabilities.

■ Ping another computer while in  Safe Mode to determine whether 
the server (your computer) is connecting or not. Then restart Vista 
normally.

Open a Word document and key a paragraph that describes why it is 

important to back up your system and fi les regularly. Save your fi le as:  

v6rev-[your fi rst initial and last name]9.

 10. Repair Your Computer 

Language Arts: Use Startup Repair You fi nd that there was nothing 

wrong while you were in Safe Mode, but the server still will not start. You 

determine that you will have to repair the Vista installation. Restart your 

computer using the advanced startup options and choose Repair Your 

Computer in the Advanced Boot Options. In the System Recovery 

Options box, select Command Prompt and ping another computer. Exit 

the command prompt and restart Vista normally.

Open a Word document and make a list of at least three hardware failures 

that Startup Repair cannot fi x. With your teacher’s permission, use the 

Internet or  Windows Vista Help and Support to help you gather the 

information. Save your fi le as: v6rev-[your fi rst initial and last name]10.

 11. Recover Information 

Language Arts: Use System Restore None of the fi xes you have 

employed to this point have fi xed the problem entirely, so you decide to 

restore the computer to a previous point. Use the most recent system restore 

point to return the computer to the previous stable state.

Open a Word document and list at least three types of fi les that  System 

Restore does not affect when using restore points to return your system to 

an earlier point in time. Explain why it is important to back up these types 

of fi les. Save your fi le as: v6rev-[your fi rst initial and last name]11.

Challenge Yourself Projects

Recovery A computer 
crash in the workplace can 
cost a company huge 
amounts of money and time. 
While backups can restore 
the system to a point, 
everything done since the 
last backup will be lost. 
These projects demonstrate 
how you can use the skills 
you have learned to repair a 
malfunctioning system.

Reflect Once you complete 
the projects, open a Word 
document and answer the 
following questions:

1. How often do you think 
a typical business should 
perform backups?

2. How often do you think 
such a business should 
set system restore 
points?
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